
!/^(tom|dick|harry)@/a

/^(tom|dick|harry)@/a    Tells Turnpike to check the From: line to see 
whether the message/article was from tom, dick or harry
! Tells Turnpike to record a match when this isn't the case



/@anycompany\.com$/a
/ Starts the pattern
@anycompany\.com Tells Turnpike to look for @anycompany.com within the section it is 

searching (\. is written in place of . because . on its own has special 
meaning)

$ Tells Turnpike that the section it's searching should end after the m of
.com

/ Marks the end of the pattern
a Tells Turnpike to only search the author's address, as extracted from 

the From line



/^Newsgroups:.*,/h

/ Starts the pattern
^Newsgroups: Tells Turnpike to look for a line starting Newsgroups:
.*, Tells Turnpike to then look for an unspecified number of characters (the . 

stands for any character, the * stands for any number of these) followed 
by a comma (the character used to separate the names of the 
newsgroups to which an article is posted)

/ Marks the end of the pattern
h Tells Turnpike to search every line of the header

To kill cross-posted articles to n newsgroups, repeat the pattern        *,.        n-1 times. e.g. 
/^Newsgroups:.*,.*,.*,/h will kill articles cross-posted to four or more newsgroups.Be aware that if 
an article is cross-posted to newsgroups to which you subscribe, the rule will only be effective if it 
is has been set in all of the newsgroups concerned.



/^Date:\s*Fri,/h

/ Starts the pattern
^Date: Tells Turnpike to look for a line starting Date:
\s* Tells Turnpike that this may be followed by any number of spaces or tabs
Fri, Tells Turnpike to then look for Fri,
/ Marks the end of the pattern
h Tells Turnpike to search every line of the header



/^Lines:\s*[0-5]?\d$/h

/ Starts the pattern
^Lines: Tells Turnpike to look for a line starting Lines:
\s* Tells Turnpike that this may be followed by any number of spaces (or tabs)
[0-5]?\d Tells Turnpike to then look for either a single digit number in the range 0 to 9 

(signified by \d) or a two digit number in the range 00 to 59 ([0-5}\d or [0-5][0-
9] would mean a digit in the range 0 to 5 followed by a digit in the 
range 0 to 9 ie. 00 to 59; the ? after the [0-5] says that the first digit doesn't 
have to be there)

$ Tells Turnpike that there should be nothing after the 'second' digit
/ Marks the end of the pattern
h Tells Turnpike to search every line of the header



    
/^References:\s*<[^<]*@anycompany\.com>/h

/^References: (for a match) the line should start References:
\s*< References: should be followed by an unspecified 

number of either spaces or tabs.
< [^<]*@anycompany\.com> < should be followed an unspecified number of 

characters other than <
@anycompany.com>/h Search the whole of the header for this line



/[A-Z][A-Z]/c

/ Starts the pattern
[A-Z][A-Z] Tells Turnpike to look for any character in the range Capital A to Capital Z 

(ie. any capital letter),followed immediately by another capital letter - on 
the assumption that finding two capitals together probably means that 
everything is in capitals.

/ Marks the end of the pattern
c Tells Turnpike that the case of the letters matters

 Because c is the only modifier in the rule, Turnpike assumes 's' and so only 
searches the Subject line (after any Re:)



/^Sender[ \t]*:[ \t]*local.part@domain/h
/ Starts the pattern
^Sender Tells Turnpike to look for a line which starts Sender

[ \t]*:[ \t]* Tells Turnpike that the word Sender may be followed by a number of 
either spaces (indicated by the space in the square brackets) or tabs 
(indicated by the \t) then a :, then possibly some more spaces or tabs 
(the * means 'any number of the preceding characters')

local.part@domain Tells Turnpike that this should be followed by local.part@domain
/ Marks the end of the pattern
h Tells Turnpike to search every line of the header



/^X-Mailer:/h

/ Starts the pattern
^X-Mailer: Tells Turnpike to look for a line starting X-Mailer:
/ Marks the end of the pattern
h Tells Turnpike to search every line of the header



    
/^X-Newsreader:/h

/ Starts the pattern
^X-Newsreader: Tells Turnpike to look for a line starting X-Newsreader:
/ Marks the end of the pattern
h Tells Turnpike to search every line of the header



/@anycompany\.com$/a & !/urgent/s

/@anycompany\.com$/a Tells Turnpike to check the From: line to 
see whether the message was written by 
anyone at anycompany.com.

!/urgent/s Tells Turnpike to check that the Subject: line doesn't 
contain the word urgent (! stands for 'Not')

& Tells Turnpike to only record a match when both of the 
above are true



/@anycompany\.com$/a & !/widget/s

/@anycompany\.com$/a      Tells Turnpike to check the From: line to see 
whether the article was written by anyone at anycompany.com

!/widget/s      Tells Turnpike to check that the Subject: line doesn't contain
the word widget (! stands for 'Not')

&    Tells Turnpike to only record a match when both of the above are true



/^fred$/
/ Starts the pattern
^ Tells Turnpike that the match needs to be at the start 

of the section it searches
fred Tells Turnpike to look for fred
$ Tells Turnpike that the section should end 

immediately after the d of fred
/ Marks the end of the pattern

In the absence of any modifier, Turnpike assumes u and just 
searches the username given in the 
Forwards Path taken from the SMTP envelope RCPT TO: line
(or equivalent).



/^fred@anycompany\.com$/a
/ Starts the pattern
^ Tells Turnpike that the match needs to start from the beginning of the section it 

searches fred@anycompany\.com
Tells Turnpike to look for fred@anycompany.com (\. is written in place of . 
because . on its own has special meaning)

$ Tells Turnpike that the section it's searching should end after the m of .com
/ Marks the end of the pattern
a Tells Turnpike to only search the author's address, as extracted from the From line



/[<:]local.part@domain>$/f    

/ Starts the pattern
[<:] Tells Turnpike to start by looking for a < or a :
local.part@domain> Tells Turnpike that the < or : should be followed by 

local.part@domain>
$ Tells Turnpike that the section it's searching should end after the >
/ Marks the end of the pattern
f Tells Turnpike to only search the SMTP envelope MAIL FROM:



/^(tom|dick|harry)@/a

/ Starts the pattern
^ Tells Turnpike that the match needs to be at the start of the section it searches
(tom|dick|harry)  Tells Turnpike to look for tom or dick or harry 
@ Tells Turnpike that the tom, dick or harry it finds should be immediately followed by an @ 
/ Marks the end of the pattern 
a Tells Turnpike to only search the author's address, as extracted from the From line



/urgent/s
/ Starts the pattern
urgent Tells Turnpike to look for the urgent within the section it is searching
/ Marks the end of the pattern
s Tells Turnpike to only search the Subject line, starting after any Re:



/widget/s
/ Starts the pattern
widget Tells Turnpike to look for widget within the section it is searching
/ Marks the end of the pattern
s Tells Turnpike to only search the Subject line, starting after any Re:



Abbreviations

The following abbreviations are frequently used in mail messages and news articles:

(see also Smileys and Conventions)

AFAICS As far as I can see
AFAIK As far as I know
AFAIR As far as I recall
AIUI As I understand it
BTW By the way
FAQ (list of) Frequently asked questions
FWIW For what it's worth
FYI For your information
HAND Have a nice day
HTH Hope that helps
IANAL I am not a lawyer
IIRC If I remember correctly
IMHO In my humble opinion
ISTR I seem to remember
LOL Laughs out loud
NG Newsgroup
OTOH On the other hand
PITA Pain in the rear (i.e. a nuisance)
ROFL Roll on floor laughing
RSN Real soon now
RTFM Read the manual
SMOP Small matter of programming (i.e. a trivial task)
TIA Thanks in anticipation
TTFN Ta-ta for now
UCE Unrequested commercial email
WRT With respect to
YMMV Your mileage may vary (i.e. your experience may differ)



Access to mail

When a message first arrives in your In tray, it is automatically treated as private to you. When you file it, 
you may want the message to remain private or to become available to all your colleagues. Another 
option is for the message to be available to a specific range of people.

Who will have access to a message when it is filed is shown on the Status bar below the message. 
Access can be public, private (to the owner) or restricted (accessed by tags). 

When access is restricted access is determined by the tags set. There are three types of Tags.

· Private. Usually only the person who created the tag can read the message
· Group Email messages    accessed by members of a specified workgroup
· Public. Anyone can access this mail

You may want to give one of your colleagues access to the private mail you receive on a certain topic. To 
meet this requirement the Edit Tag dialog includes an Access option.

The access details associated with your tags are only applied when the access rule 
shown on the status bar below the message is Restricted.

In mail lists access to a message is with  for messages that you can't read; 
 for messages that only you can read; and 
 marking messages that only you and some others can read. If a message doesn't have 

any of these markers, it's public and can be read by anyone.

Related Topics
Tagging Messages with their topic
Mail list wizard - tags
Mail Message Status bar



Adding, Editing and Removing email names

To add alternative email names you must have Email name permission, 

You can give yourself whatever additional names you like. Each name must not include any 
spaces or commas and must be unique. 

· To call up the Email names dialog.
1. From the Turnpike menu click File
2. Select Configure
3. Select Email names - the Email names dialog appears,

· To add an alternative email name for yourself - or change one you 
currently use.
4. In the Email names dialog box, click the Create button .. the Usage of Email 

names dialog appears.
5. Enter the new name in the Name box. 
6. Click the OK button (the rest of this dialog is not applicable when adding names)
7. Click the Close button to clear the Email names dialog box.

· To edit one of your alternative email names
4. In the Email names dialog box, select a name
5. Click the Edit button..the Usage of Email names dialog appears.
6. Edit the name in the Name box. 
7. Click the OK button (the rest of this dialog is not applicable when adding names)
8. Click the Close button to clear the Email names dialog box.

· To remove one of your alternative email names
4. In the Email names dialog box, select a name
5. click the Remove button
6. Click the Close button to clear the Email names dialog box.

Related Topics 
Alternative Email Names



Adding new users

This copy of Turnpike supports up to 99 users signing on at different times. Before anyone can use the 
system, their name must be entered as a user of the system, they must be given a sign-on name and 
their own personal seat on the system.

You are only able to add new users if you have Alter_Users permission.

· To Add New Users
1. Click File in the Turnpike menu
2. Select the Configure option
3. Now select Users. The Configure users    sign on names dialog appears.

The Configure user sign on names dialog lists the sign-on names of current users 
of your Turnpike system, together with the seat that has been allocated and the date 
last used. From here you are able to Create, Edit or Remove entries.

 
If only your own details are given, you do not have Alter_Users permission.

4. Click the Create button - an empty the Edit sign-on details dialog appears.
5. Enter details of the new user.

Related Topics
Edit details of a current user
Enable the Edit sign-on details dialog
The Edit sign-on details dialog
Remove users from a shared system



Adding newsgroups to a newsstand

You are only able to add newsgroups when you have News Admin permission,

Open the Newstand 
1. Double-Click on the Newstand icon

Or Click Window in the menu and select the Newstand 

At the bottom of the Newstand Window are a number of buttons
2. Click the Add button 

3. In the Newsgroup Addition dialog, select Subscribed to list the newsgroups to which 
your site is currently subscribed or All groups to display all the newsgroups available 
from your Access provider 

4. Select a newsgroup you want to include in the newsstand

5. Click the Add button or double-click on the newsgroup name. The Newsgroup name will 
appear in the lower box 

6. Click the OK button to confirm the addition and return to the newsstand. 

When you select any newsgroups to which your site is not currently subscribed, you will 
be asked to confirm that you wish to subscribe. The selected newsgroups will be set to 
be downloaded in full and available for all to see. Downloaded articles will be set to 
expire after three days. With News Admin permission you are able to change these 
subscription details.if you wish.

The newsgroups you have selected are added to the newsstand in the order in which you 
select them. 
To change the order. Use the Move Up and Move Down buttons to move newsgroups 
into the new position or drag. them to the new position.

To change the selection of newsgroups in a newsstand
1. Go back to the top level of the newsstand (the level at which you can see all the 

newsgroups). 
2. Use the buttons along the bottom of the newsstand to 

· Add new newsgroups, 
· Remove  ' newsgroups   you no longer require, 
· Move newsgroups up and down the list 
· Alter      various aspects of the newsstand as you require.

For help creating a newsstand refer to Setting up newsstands.

New newsgroups appear and old newsgroups disappear almost daily. Whenever 
Turnpike downloads news it also picks up amendments to the list of newsgroups it offers. 
Asking Turnpike to collect a new news list
New newsgroups appear and old newsgroups disappear almost daily. Whenever Turnpike downloads 
news it also picks up amendments to the list of newsgroups it offers. With Connect Admin permission you 
can ask Turnpike to select a complete new list through the Configure Usenet News dialog.



Not all servers carry the same newsgroups. If you change News server for example if you change 
your Access provider you should ask Turnpike to download a new list.
For help creating a newsstand refer to Setting up newsstands.

The Configure Usenet News dialog is displayed by selecting News collection from the Configure 
menu in Turnpike Connect.

Related Topics 
Newsstand
Newsgroup addition dialog
Converting a mailing list into a newsgroup
Setting Up Newstands
change these subscription details.



Adding / Changing entries in your Address book

First open the Address Book. Double-click its icon, click the Address book button on the toolbar or select 
Address Book in the Window menu.

· To add a new person
Click the New person..
An empty Address book entry dialog is displayed.
Complete the dialog then click the Ok button.

· To change an entry
1. Select the entry , in the address list.
2. Click the View/Alter button 
3. A completed Address book entry dialog is displayed.
4. Amend or add to entries then click the Ok button. 

· To delete an entry 
1. Select the entry , in the address list.
2. Click the Remove entry button 
3. Use the dialog that is displayed to specify whether you want to remove the entire entry or just the 

index entry under which you've selected this record. 

Related Topics
Address book - Overview 



Address Book External Format: Formal definition

The external form of the address book is a comma separated value (CSV) datafile. The first part is made 
up of 'name records' giving the details of personal entries within the address book. The second part is 
made up of distribution records containing the details of any distribution lists.

At least one blank line separates these two parts and also separates the distribution lists.

Each name record has 11 fields and is written on a single line; except where carriage returns within the 
data introduce new lines. To keep the number of fields within a name-record fixed, the lists of index-
strings and file-addresses are represented as single values with their own internal structure. This is 
achieved by quoting the comma separated lists, thus reducing the list to a single value.

A distribution record consists of the list's name (plus other information) on one line, followed by the 
individual entries that make up the list arranged on separate lines.

The full syntax is as follows (defined using BSI Syntactic Metalanguage):

external-address-book = {name-record}, {CRLF, [distribution-record]}.

name-record =
[name-string], ",", ["auto"],
",", [label-string], ",", ["auto"],
",", [fax-number],
",", [phone-number],
",", [land-address],
",", [email-address], ",", ["hasMIME" | "useMIME"],
",", [index-list],
",", [file-list],
CRLF.

distribution-record =
[name-string],
",", [label-string],
",", ["useMIME"],
",", [index-list],
CRLF,
{email-address, [",", ["hasMIME" | "useMIME"], [",", ["cc" | "bcc"]]], CRLF}.

where:
index-list = ' " ', index-string, {",", index-string}, ' " ' | index-string.
file-list = ' " ', file-as, {",", file-as}, ' " '.
file-as = file-address, ",", ["hasMIME" | "useMIME"], ",", [recID].

name-string = value.
label-string = value.
fax-number = value.
phone-number = value.
land-address = value.
email-address  = RFC822-address. ; defined in RFC822
RFC822-address = value.
file-address = RFC822-addr-spec.; defined in RFC822
RFC822-addr-spec = inner-value.
recID = inner-value.



index-string = inner-value.

value = quoted-string | unquoted-string.

quoted-string = ' " ', {qtext | ' " " '}, ' " '.
qtext = <any CHAR excepting    ' " '>.

unquoted-string = {utext}.
utext = <any CHAR excepting ' " ', "," & CR>.

inner-value = {itext |    ' " " ' | quoted-pair}.
itext = <any CHAR excepting    ' " ', ",", "\">.
quoted-pair = "\", ("," | "\").

CHAR = <BYTE in the range 1..255>.

Within each comma separated field, leading and trailing white space (space and tab) is ignored but 
embedded white space is significant.

There is no convention in CSV files of how to handle quotes within quotes, so the convention that '  " ' 
means " has been adopted.    Similarly, the \ convention is used to escape commas in index-string and 
file-address lists.

Trailing commas may be suppressed in which case their fields are assumed to be empty.

Related Topics
Address book - Overview 
Address book External Format



Address book - Overview

Turnpike has an on-screen Address book for all the email addresses you might use - together with other 
information about the persons concerned. Turnpike enables you to put an email address from the Address
book into the email message you are preparing.

Turnpike automatically makes an entry in the Address book for anyone you send email to or anyone who 
sends email to you.
You are able to turn this feature off for individual mailboxes, see the Name page of the Mailbox dialog). 

The Address book entries are automatically indexed, typically under the person's first name, their 
surname and their domain. This gives you a choice of 'headings' under which to find any record you wish 
to select. 

You are able to add and remove entries, add personal information and make other amendments, see 
Making changes to your address book).

When you want to send email to somebody listed in your address book, 
either click the Start new email button from within your mailbox and then Select an address from your 
Address book 
or select the person in your Address book and then click on the 'Start new email: To' button. Use which 
ever is more convenient at the time. For more information, see Sending mail.

Each entry in the Address book refers to a single email address. If someone uses more than one email 
address, they will have more than one entry in your Address book. 
To distinguish between these entries give each entry a 'label' in the the Person dialog. These labels will
then be shown in the third column of the list on the main Address Book display and can also be used as
index entries. If no label has been set, the third column will show the person's domain name.

The Address book display 
Select an entry in the Address book

Add, Alter or delete entries in the Address book
Address book details - Person dialog. 
Address book details - Distribution list dialog

Send mail to someone in the Address book
Distribution list

See the messages you've exchanged with someone

Import or export addresses

The 'external' format  of the address book
External format - person entry example
External format - Distribution list example
External format - Formal definition

Rebuild the Address book





Address book display

When you call up the Address book the Address book diaog is displayed.

Selection box    This holds a record of you most recently used addresses. Either start typing a name 
under which the entry is indexed, or select a name from the drop-down list .

A List of all your address book entries shown in Index entry order. The first column shows the Index 
entry; the second column shows the name of the Address book entry, the third column shows the label 
given to the entry. Each entry in the Address book typically appears two or three times in this list - once 
for each index entry that is recorded for it.

A Goto box    Click on a letter in this box to go to the section with Index entries starting with the select 
letter.

Toolbar Buttons
Select the address book entry and then use the buttons as described below 

Start new email. Opens a new email message form with the selected name in the To field.

Messages Displays a    list.of the messages you have exchanged with the selected name.

View / Alter Displays the details of the currently selected entry and enables you to edit the 
entries.

New Person Presents a blank Address book entry form, in which you to enter details of a    new 
person.

New List Presents a blank Address book entry form in which you enter details of a new list.

Remove entry Removes the currently selected entry from your Address book 

Start new email Opens a new email message independently of the entry currently selected in the 
Address book.

Related Topics
Mail lists.
Making changes to your Address book.
Address book - Overview 



Address book: List dialog

This dialog records the details of a particular distribution list. This is the addres essto which messages are
sent. This dialog is called by selecting an existing list entry in the Address book and clicking the 
View/Alter button or by clicking the Address book's New List button

List name Enter the name by which the list of addresses will be identified. 
Label Enter an additional label for this entry. You can use this in the index as a mail entry 

when you have more than one distribution list eg for the same company.
Use MIME check this box if the messages sent to the addresses in this is distribution list can be 

MIME messages    ie.all the people listed are able to read MIME messages.
To Enter the email address of a main recipient(s) of any mail messages sent to this list. 

Use the [+] button to open a fresh slot for each additional main recipient you wish to 
record.

cc Enter the email addresse(s) of any recipients you want to receive a Carbon copies of 
the message.

bcc Enter the email addresse(s) of any recipients you want to receive Blind carbon copies 
of the message.

Index by The keywords this distribution list will be listed under in the main Address book display.
This is set as the List name and any Label you set but you can use different keywords 
if you want. Type these on separate lines.

Mail To button Click this button to prepare a message to send to the people on this distribution list.

Related Topics
Address book - Overview 
Distribution list. 



Address book: Person dialog

This dialog is used to set up and display the entry for someone in the Address book. It is called up either 
by selecting an existing person entry in the Address book and clicking View/Alter button or by clicking the
Address book's New person button

Person Enter the person's name. 
Label Enter an additional label for this entry. You can use this in the index as a mail 

entry when you have more than one distribution list eg for the same company.

Has MIME; Use MIME Check this option to record whether the messages you send can be MIME 
messages ie. if the person concerned will be able to read MIME messages.

Email The person's name followed by their email address.

File as The email address(es) under which mail from this person is filed. Note These 
addresses are used to select the messages listed when you click the Messages 
button. When someone uses more than one email address list all their 
addresses here. This will enable you to get a complete list of the messages 
you've exchanged. Use the [+] button shown alongside this entry to open a 
fresh slot for each additional address you wish to record.

Phone, Fax, Address Enter further 'address book' information as available.

Index by The names under which this entry is listed on the main Address book display. 
This is set for you from the person's name and any Label you add. You are able 
to use different keywords if you want. Type these on separate lines.

Messages button When you click this button a mail list will appear. This will list all of the 
messages you've exchanged with the person selected 

Mail To button Click this button to prepare an email message to send to the person selected.

Related Topics
Address book - Overview 



Address book: External format

The 'external' form of the address book is a Comma Separated Value(CSV) datafile, divided into two 
parts:

The first part is made up of personal entries, with the data for each entry arranged on a separate line.
The second part is made up of distribution lists, each spread over a number of lines.

There needs to be at least one blank line between these two parts and also between the individual 
distribution lists.

The layout of the data is described below - or you can click here for a formal definition of the syntax of this
file.

Part 1: The personal entries
Personal entries are arranged one to a line, with the different pieces of information given in the following 
order and separated by commas. The order of the information is:

* Name as given in the Person: slot of the address book entry
* Whether this name was automatically generated (written as auto) or not (left blank)
* Label as given in the Label: slot
* Whether this label was automatically generated (written as auto) or not (left blank)
* Fax number as given in the Fax: slot 
* Phone number as given in the Phone: slot 
* Land address as given in the Address: slot 
* Email address as given in the Email: slot 
* Use mime/has mime useMIME if MIME should be used; hasMIME if MIME is available but shouldn't in

general be used; or blank if no MIME 
* Index list as listed in the Index by: box 
* File as list the addresses under which messages are filed - as entered in the File as: slot

Automatically-generated Name and Label entries don't appear in the individual address book entries. 
They only appear in the second and third columns of the list on the main Address book display.

The Name, Label, Fax & Phone numbers and the Email address are generally written exactly as in the 
corresponding address book entry. You can write these between double quotes if you prefer. A space 
before or after any entry is ignored. Any entries that include commas, carriage returns or double quotes - 
such as the Land address - MUST be written between double quotes, and with any double quote marks 
within the entry written as double double quotes (" ").

List the Index entries between double quotes as follows "entry1,entry2,..." . Double quotes are 
optional where there's just one index entry.

Give the File as addresses as "entry1,entry2,..." . In this case divide each entry into three sections, 
separated by commas viz. email address; useMIME or hasMIME or blank and either a record number
(if Turnpike has generated the external file) or a blank. The double quotes are always included in this 
case.

Where any of these items is blank, the comma that separates it from the next piece of information 
must still appear so that the remaining pieces of information are associated with the correct parts of 
the address book entry. But if the remaining entries are themselves all blank, the record can simply be
finished with a carriage return: Turnpike will then automatically make the remaining items of the record



blank.

Click here for person entry   example  .

Part 2: The distribution lists

Distribution lists comprise:
* a blank line. Used to separate the list either from the list of personal entries or from a preceding 
distribution list
* a line of general information about the list
* details of the different people on the distribution list, each on a separate line

The line of general information contains the following information in the following order, separated by 
commas:
* Name as given in the List name: slot of the address book entry
* Label as given in the Label: slot
* Use mime/has mime useMIME if MIME is to be used, otherwise blank
* The Index entries as listed in the Index by: box 

The Name and the Label can be written exactly as the address book entry.You can write these between 
double quotes if you prefer. 

Give the Index entries as "entry1,entry2,..." . The double quotes can be omitted if there's just one index 
entry.

The lines of details about the individual people on the distribution list give the following information, 
separated by commas:
* Email address
* useMIME if MIME should be used; hasMIME if MIME is available but shouldn't in general be used; or 
blank if no MIME 
* cc if listed in the cc slot, bcc if listed in the bcc slot or blank if listed in the To slot

These lines can be finished after the email address or after the useMIME/hasMIME entry if the remainder
of the line is blank.

Click here for an example distribution list 

Related Topics
Address book - Overview 
Address book - External format definition



'Administer Workgroups' dialog

This dialog is called from Turnpike menu File, Configure, Workgroups    - see Setting up workgroups

· To Create a new workgroup
1. In the Administer Workgroups dialog click the Create button    - the  Edit 

workgroup details     dialog appears.
2. Enter a Name for the new Workgroup.
3. Double-click on names in the All users list to add them to the new workgroup

If a name you want to use isn't listed, they are not currently a user of the system, see 
Adding new users

· To Edit details of a current workgroup
1. In the Administer Workgroups dialog, select the workgroup from the list
2. Click the Edit button - the Edit workgroup details dialog appears.
3. Double click on names in the All users list to add them to the group
4. Click on names in the Current members list and click the Del button to delete them 

from the group
If a name you want isn't listed see Note above.

· The ALL Workgroup
The list of workgroups shown in the Administer Workgroups dialog automatically 
includes an ALL workgroup. This group includes all the users on the Turnpike system 
and is used when you want to give everybody general permissions and newsgroup 
ratings. When the ALL workgroup is being edited, the dialog includes a Ratings button. If
you have Ratings Admin permission, you can click on the Ratings button to see the 
default ratings. These ratings control which newsgroups users of your system will be able
to see.

· Permissions
At the bottom of the Edit workgroup details dialog are 16 option boxes. Check as 
locally specified to give this user the necessary administrative permissions.

These Permissions are set for each user in this Workgroup. These permissions may be overridden by 
permissions set for an individual user -    see Edit sign on details dialog. 

Related Topics. 
Workgroups
Setting up workgroups
Edit workgroup details 
Edit sign on details 
Adding new users



Advice for new users

If you are new to the Internet, we recommend that you:

· Scan the Turnpike Mail & News book 
This will give you an idea of the screens and menus that Turnpike offers and how 
different actions are carried out in Turnpike. For further details look in this Help file.

· Before you post a news article to any newsgroup.
Practise posting news articles by sending practice articles to one of the 'test' 
newsgroups, such as demon.test. No-one will object if you break any conventions in an 
article that you post to one of the test newsgroups. If you get these things wrong in a 
posting to one of the 'real' newsgroups, you may be 'flamed'.

Study both the articles that other people post to a newsgroup and the FAQs included in 
that newsgroup. If you post an article that is inappropriate to that newsgroup or wast 
other people's time, disk space etc. or you ask a question or make a comment that has 
been asked many times before, again you may be 'flamed'.

Related Topics
Using Turnpike     Help  
Welcome to Turnpike



Allocating another user to a seat 

When someone else is taking over the role of someone who has left, you may want the new 
person to occupy the same seat as their predecessor and become a member of the same 
workgroups and be able to see any relevant mail. 

The System Administrator should re-allocate the seat as follows,      

· Configure the system for a new user
1. Click on File in the Turnpike menu
2. Select Configure
3. Select  Users, 
4. Select the entry for the old user, make a note of the number of the seat they 

occupied.
5. Click the Edit button - the Edit Sign-On details dialog appears.    
6. Enter details for the new person.

· Log on as the new person and tidy up
1. Export and then delete any personal mail from the mailbase
2. Delete personal email tags, and any mailboxes/newsstands no longer required.
3. Update the User Info page of the others.

· Select the old users entry in the Address book 
1. Click the View/Alter button to display this entry in full. 
2. Change each entry in the dialog that’s displayed to show the new persons details
3. For the File as entry, click the [+] button and add the new persons email address to 

the details that are already recorded: 
don’t delete the old details. This will ensure that when the new person clicks the 
Messages button they will see the messages sent to their predecessor alongside their own 
messages

· Delete Unused Files
1. Go into the userxxx directory corresponding to the old users seat. 
2. Use a suitable text editor to inspect / edit the .sig signature files (these are simply 

text files). Delete all the files except for the TURNPIKE.INI file and any signature files 
that you want to retain.

Related Topics. 
Email Routeing Seats 



Alt groups
Among the newsgroups on offer are many 'Alternative' groups - with 'Alt' as the first part of their name. 
These groups usually developed out of newsgroups that were originally circulated among people working 
at the same site and they tend to be less formal (and their contributions more eccentric) than the 
newsgroups within the main newsgroup categories.



Alter Mailbox dialog Colours

The Alter Mailbox dialog is called by selecting Alter mailbox from the File menu.

The Colours page of the Alter Mailbox dialog enables you to select the colours used to 
display the articles in the Mailbox you are currently working on and the colours used to 
display the different types of text that can appear in those articles.
You are able to set the colour you want to use for Read Message, Write Message and the
Mailbox.

· To set a colour
1. Click the Alter button to display the Colour Selection dialog
2. Click the down arrow to display a list of the text and background colours you can 

change
3. Select a colour and then click OK 

Repeat this procedure for each item you want to change 

Click the Default button to returns all the colours to their originally installed setting

Related Topics 
The alter Mailbox dialog 



Alter Mailbox dialog: Name page

The Alter Mailbox dialog is called by selecting Alter mailbox from the File menu.

The Name page of the Alter mailbox dialog enables you to set the following,

Mailbox Name
While the name you enter in the Mailbox dialog, is entirely up to you, it is useful if the 
name describes the type of mail you want to use the mailbox for. Each of your mailbox 
names must be different.

Flash When.
Select the option for the mailbox icon to flash when there's mail in its In tray, when there 
are just    unread messages in the In tray or not to flash at all.

Address Book
Select an option as to whether the email addresses from the messages inserted into the 
mailbox should be automatically inserted into your Address book or not. Initially, you will 
probably set Turnpike to add any email addresses it finds. If you are setting up a mailbox 
such as Sales enquiries or for dead letter mail you may prefer not to add these addresses 
to your personal Address book.

Destroy button
Click if you want to remove the mailbox altogether. 

 You must empty a mailbox before you will be able to destroy it.

Accept dead letter mail
For alternative mailboxes only there is also a check box for dead letter mail. If you want this mailbox to 
accept deadletter mail check this box.

If this box is checked for more than one alternative mailbox dead letter mail will appear in al of them all 
(and the default mailbox). As soon as the mail is read it is filed in that mailbox only. 

Related Topics 
Alter Mailbox dialog
Setting up mailboxes
Mailbox dialog 
Mailbox flashing



Alter Mailbox dialog: Rules page

This dialog is called by selecting the Rules tab on the Alter Mailbox dialog. The Alter Mailbox dialog is 
called by selecting Alter mailbox from the File menu.

The Rules page of the Alter Mailbox dialog enables you to set the 'Rules' that you want 
Turnpike to apply to the mail in alternative mailboxes.

You are only able to set rules to pass mail to alternative mailboxes. You are not able to set 
rules in the default mailbox. The default mailbox will accept everything for which rules do 
not apply including dead letter mail. 

· Features of rules page:
· Mail acceptance rules.  A list of the current rules listed in the order they are 

applied
· Add, Alter buttons. Click to display the Distributing Mail to Mailboxes dialog. This 

dialog enabes you to set up new rules or change existing rules
· Remove button. Click to remove a selected rule 
· Move Up and Move Down buttons. Select each rule in turn and then use these 

button to move the rule to the order you want it applied. The first rule in a list takes 
precedence over the second and so on down the list. Turnpike acts on the first rule 
that either accepts or rejects each mail message.

If you are the sole user of this Turnpike system or you have been nominated to receive dead 
letter mail, the dialog will also include a Accept dead letter mail check box. Tick this box if
you want dead letter mail to be put into this mailbox.

Mail from a POP3 mailbox may appear as dead letter mail to Turnpike. If you want to route 
mail from a POP3 mailbox to one of your alternative mailboxes check the Accept dead 
letter mail option.

    If the Accept dead letter mail option.box is not shown on the rules page, either 
you have select the default mailbox or the mailbox you have selected is not set up to recieve
dead letter mail. The routeing for Dead letter mail is set up on the Dead letters page of the 
Email Routeing to Seats & News dialog

Related Topics 
The alter Mailbox dialog 
Distributing Mail to Mailboxes 



Alter Mailbox dialog: Tags page

The Alter Mailbox dialog is called by selecting Alter mailbox from the File menu.

Use the tags page of the Alter mailbox dialog, to set the default access details and tags that you want 
applied to the messages in this mailbox. You will then generally get the right result even if you forget to 
check the access settings before filing the message.

The tags you select will be applied to each item of mail that is put into this mailbox and sent from this 
mailbox. 

The Default owner part of the dialog is only applicable to a shared system. Either select a 
specific owner for the mail - either yourself or a workgroup you belong to - or opt for the 
ownership to depend on how the message was addressed 

The Default Access when filed options enable you to set mail in this mailbox to be 
public, private, or retricted 

· Default owner of the mail 
· Recipient email name; ownership will depend on how the message was 

addressed, for example you if the message was sent specifically to you but if the 
message was sent to a workgroup, it should be owned by the workgroup.

· Explicit owner; yourself or a workgroup you belong to. Check the Explicit owner 
option and then click the down arrow in the text box and select a name from the 
drop down list. The name can be you - your sign-on name or one of the workgroups 
you belong to.

· Default access when filed
The access you want applied to the majority of messages in this mailbox. If most 
messages will be private check the private option otherwise check the public or 
restricted option. 

· To Add/Remove tags
The tags available are listed in the upper window of the Tag selection dialog

The tags currently set for this mailbox are listed in the Tags Applied window of the 
dialog.

· To apply tags to this mailbox 
1. Click the Edit button to call up the Tag Selection dialog, 
2. Select the tag in the upper window and click the Add button.
3. Repeat this for each tag you want applied to this mailbox.

If the tag you want isn't listed, click the New button on the Tag selection dialog.

 
When the same tags apply to more than one mailbox, the mail is given the tags of the 
mailbox in which it is opened. It isn't given the tags of the other mailboxes in which the tags 
apply. 



If you don't have any specific tags you want to apply to the mail in this mailbox, you might use this facility 
to add a 'No tag' tag to each item. You will then be able to call up a mail list of those messages you 
haven't yet tagged with their subject.

Related Topics 
Tag Selection dialog, 
The Alter Mailbox dialog
Tagging Messages,
Setting access through the mailbox.
Access to Mail



Alter Mailbox: User Info page

The Alter Mailbox dialog is called by selecting Alter mailbox from the File menu.

The User Info page of the Alter Mailbox dialog enables you to set your personal details for all mail in this
mailbox.. 

The items listed in this dialog are the way you appear to the recipient of one of your messages. This 
dialog enables you to present yourself differently for different types of message, 

The following details will be used in all messages from the mailbox you are altering or setting up.

· Email name: Click the down arrow and select the email name to use
· Name: Your full name
· Domain name: The site address
· Organisation: The organisation you are representing
· Reply-To: The Reply-To address specified in email messages
· Signature: Which of the various signatures to use. Use the Browse button to select a

different signature file if required.

Related Topics 
Setting up mailboxes
Mailbox dialog 
Alter Mailbox dialog
Email name
Domain



Alter Mailbox: Standard text page

The Alter Mailbox dialog is called by selecting Alter mailbox from the File menu.

The Standard text  page of the Alter Mailbox dialog enables you to set a standard format
for,

· Attribution: The phrase you want to be put at the start of all replies that you send 
from this mailbox, ie quotations from the message to which you are replying 

· Forwarding: Messages that you forward to someone else i.e. the phrase to be put at 
the start of messages that you forward.

Turnpike automatically sets suitable forms for each type of text, but if you want a different 
style of introduction you are also able to set this here. You are able to include information 
from the message itself in these phrases, such as the date it was posted or the person who 
wrote it. 

Use the % placeholder followed by a letter to determine where details are to be inserted. 

 If you want to include a % in your message, you will need to write this as %%.

Related Topics 
Attribution & Forwarding text.
The Alter Mailbox dialog



Alter Mailbox dialog:Fonts page

The Alter Mailbox dialog is called by selecting Alter mailbox from the File menu.

The Fonts page of the Alter Mailbox dialog called by selecting the Fonts tab on the Alter Mailbox 
dialog. 

This dialog enables you to set both the font used to display your mail on the screen and the
font you use when you print an article from this newsstand.

· To set a font 
1. Click the Alter button for screen or print
2. Select the font you want used
3. Click OK

Clicking the Default button to returns the fonts used to that set when Turnpike was 
installed.

If you choose a proportionally-spaced (PS) font for the screen, this may result in lines of 
more than 80 characters. If you are not sure if your reader will be able to display text using a
similar font use a fixed-pitch font. This will result in approx. 72 characters per line which will 
be within the default margins set by Turnpike.

Related Topics 
The alter Mailbox dialog



Alter Newsstand dialog

Use this dialog to set or alter the characteristics of a Newsstand    or to destroy the Newsstaand

· To alter the details of the default Newstand or an alternative Newstand
1. On the menu bar click Window
2. Select the newsstand you want to change 
3. On the menu bar click File 
4. Select the Alter Newsstand option 

or right-click a mailbox and then select Properties 

In either case the Alter Newsstand dialog is displayed with the following tabs.By 
default the dialog opens on the Name page

Click on a tab for further help.

Related Topics 
Setting up Newsstands



Alter Newsstand dialog: Colours page

This page of the Newsstand dialog enables you to select both the colours used to display the
articles in the newsstand you are currently working on and the colours used to display the 
different types of text that can appear in those articles.
You are able to set the colour you want to use for Read Article, Write Article and the 
Newstand.

· To set a colour
1. Click the Alter button to display the Colour Selection dialog
2. Click the down arrow to display a list of the text and background colours you can 

change
3. Select a colour and then click OK 

Repeat this procedure for each item you want to change 

Click the Default button to return all the colours to their originally installed setting

Related Topics 
Setting up newsstands
Alter Newsstand dialog 



Alter Newsstand dialog: Fonts page

This page of the Newsstand dialog enables you set both the font used to display your 
articles on the screen and one used when you print an article from this newsstand.

· To set a font 
1. Click the Alter button for screen or print
2. Select the font you want used
3. Click OK

Clicking the Default button to returns the fonts used to that set when Turnpike was 
installed.

If you choose a proportionally-spaced (PS) font for the screen, this may result in lines of 
more than 80 characters. If you are not sure if your reader will be able to display text using a
similar font use a fixed-pitch font. This will result in approx. 72 characters per line which will 
be within the default margins set by Turnpike.

Related Topics 
Setting up newsstands
Alter Newsstand dialog 



Alter Newsstand dialog: Name page

Newstand Name
While the name you enter in the Newsstand dialog, is entirely up to you, it is useful if the 
name describes the type of news you want to use the newsstand for. Each of your newstand 
names must be different.

Destroy button
Click if you want to remove the mailbox altogether. 

 You must empty a newsstand before you will be able to destroy it.

Related Topics 
Setting up newsstands
Alter Newsstand dialog 



Alter Newsstand dialog: User info

This page of the Alter Newstand dialog enables you to set your personal details. These details will be 
used in articles from the Newsstand you are altering or setting up. 

· Email name: Click the down arrow and select the email name to use
· Name: Your full name
· Domain name: The site address
· Organisation: The organisation you are representing
· Reply-To: The Reply-To address specified in email messages
· Signature: Which of the various signatures to use. Use the Browse button to select a

different signature file if required.

Related Topics 
Setting up Newsstands
Alter Newsstand dialog 
Email name
Domain



Alter Newsstand dialog:Standard text page

This page of the Newsstand dialog enables you to set a standard format for,

· Attribution: The phrase you want to be put at the start of all follow-up articles that 
you send from this newsstand, ie quotations from the message or article to which you 
are replying 

· Forwarding: Articles that you forward to someone else i.e. the phrase to be put at the
start of articles that you forward.

Turnpike automatically sets suitable forms for each type of text, but if you want a different 
style of introduction you are also able to set this here. You are able to include information 
from the message itself in these phrases, such as the date it was posted or the person who 
wrote it. 

Use the % placeholder followed by a letter to determine where details are to be inserted.

 If you want to include a % in your message, you will need to write this as %%.

Related Topics 
Attribution and Forwarding text
Setting up Newsstands
Alter Newsstand dialog 



'Alter Usage' dialog

This topic applies only to multi-user systems

This dialog is used both

· to record which users or workgroups can call up messages marked with a particular tag.- 
see Making access to mail dependent on topic.

· and to specify which users / workgroups can read the articles downloaded from a paticular 
newsgroup - see Restricting access to newsgroups.

The dialog features two lists - the one on the left can be switched to show either all the users of the 
system or all the workgroups that have been defined; the one on the right is shows the users and 
workgroups that will have access to messages marked with the tag that is currently being set up or edited.
The right-hand list is built up by 'adding' names from the left-hand list (using the Add and Del buttons 
between the two lists).



Alter Mailbox dialog

This dialog is called by 

Selecting the mailbox concerned and then clicking Alter Mailbox in the the File menu.
Or right-click on the mailbox and select Properties.

The Alter Mailbox dialog is used to set or alter the characteristics of a mailbox - or to destroy the mailbox

· To alter the details of the default mailbox or an alternative mailbox
1. On the menu bar click Window
2. Select the mailbox you want to change 
3. On the menu bar click File 
4. Select the Alter mailbox option 

or right-click a mailbox and then select Properties 

In either case the Alter Mailbox dialog is displayed with the following tabs.By default 
the dialog opens on the Name page

Click on a tab for further help.

Related Topics 
Setting up mailboxes
Removing a mailbox
User Information



Alternative email names

When you first use Turnpike, you will have a single email name .. this is usually your sign-
on name. 
It may be useful to have a range of alternative email names that can be used. Alternative 
names may help someone to use a name that the system will recognise as meaning 'you'. 
On a shared (multi-user) system, names used may reflect the job you do. It is also useful for 
someone to be given the email names 'postmaster' and 'root' because certain types of mail 
are routinely sent to these email names.
You are also able to associate specific email names with different mailboxes. This will enable 
you to file your different types of email for example under, personal, business, technical, etc.

If you have Email name permission, you can give yourself whatever additional names you 
like - provided no one else is already using these names. On a shared system you may need 
to discuss the names you want with your system administrator.

If your system is shared with other users and you have broader name permission, you can 
also set up email names for 'group mail'.

Related Topics 
Adding email names 
email names
Sorting your mail
Group mail



    
Alternative forms of enclosure
Wherever possible, this is shown as a horizontal bar with the 
different forms of the enclosure offered as buttons.

Otherwise, you are offered a Select button with the number of 
alternatives shown alongside. Clicking this button calls up a 
dialog listing the alternatives, from which you can select the 
version you require.



Alternative keystrokes

Turnpike enables you to use the Windows range of point, click and drag techniques. Many actions can be 
also be carried out using keystrokes instead. Here are some useful keystrokes.

Ctrl F6, Shift Ctrl F6 or Ctrl Shift  to items on the on the Turnpike desktop.
The Tab or Arrow keys to move between Edit boxes in a dialog.
Ctrl F4 to close a window 

Context menus and dialogs. Point to the item you are interested in, then click the right mouse button.  

To select a menu item. Hold down the Alt key and press the character underlined in the menu. This 
applies to the main menu and to drop down menus.

Space bar use to step a window-full at a time through unread mail messages and news articles.
Ctrl G use to step from item to item in a digest.

With a message or article selected;    
Ctrl F will invoke the Find dialog, 
Ctrl P will launch the Print dialog.
Ctrl Z to Undo
Ctrl A to Redo.



Archiving messages/articles

If you want to keep older mail messages, it is better to archive them rather than leaving them in you 
mailbase.

Articles are automatically deleted from you newsbase after a pre-set time 3 days.

· To archive messages/articles 
1. Calling up a Mail list containing the messages you want to export
2. Select the message(s) you want to export 
3. Select the Export option from the File menu. 

Turnpike then displays a File Selector through which you set where you want the exported messages 
to be stored.

When you have save you files you are then able to delete these messages from your mailbase. You 
will be able to re-import into Turnpike if necessary.

Similar steps can be used to archive old news articles.

Exporting individual mail messages, or the whole of your mailbase, saves these messages in a text file 
in Berkeley Unix Mailbox format. 

For Soup users, this is equivalent to 'm' format of .MSG file but with CRLF line endings rather than LF 
line endings. This means you'll be able to work with the files from Soup after replacing all the CRLF line
endings by LFs.

In this form, the messages can be read using a standard text editor or word processor. They may also 
be able to be read by other Mail reader programs, or re-imported into Turnpike if required. 

Exporting messages does not automatically delete them from the mailbase.

Related Topics
Deleting messages



Article menu

To select a newstand,
· double-click on the newstand icon
· or click Window in the menu bar and select the newstand.

A window opens with a list of newsgroups. The Article menu item will be available.

When you click on Article a sub menu enables selection of the following,
Open newsgroup
Start news thread
Start new email

When a newsgroup is open this menu enables you to,
Close newsgroup Open article
Followup article Reply by email
Forward article Cancel article
Break Thread Rejoin Thread

        Expand Tree  Collapse Tree
Expand all Trees Collapse all Trees

You are also able to open a newgroup by double-clicking the selection
Open newgroup and Next Unread buttons are available on the toolbar

The Article menu item will change to Message if you select a mailbox or the mailroom

Related Topics 
Reading news articles



Article menu: Break thread
Lets you break off a section of a discussion thread so that you 
can hide away the section of this thread that you are not 
interested in. The effect is purely local to your own system. See
also: Rejoin thread.

For more information see Breaking threads.



Article menu/Newsstand button: Close 
newsgroup

Takes you out of the current newsgroup and back to the list of 
newsgroups. For more information see Opening/Closing 
newsgroups. 



Article menu: Collapse Tree
Closes up the current discussion thread so that all
you see is the title of the discussion thread and 
the number of articles in that thread. For more 
information, see Expanding/Collapsing trees.



    
Article menu: Collapse all Trees
Returns the display of the current newsgroup to a 
list of discussion threads. For more information, 
see Expanding/Collapsing trees.



Article menu: Expand tree
Expands the discussion thread you've selected, allowing you to
see the individual articles that have been contributed to the 
discussion and how these follow on from each other. See also: 
Expand all Trees and Collapse Tree. For more information, see
Expanding/Collapsing trees.



Article menu: Expand all Trees
Expands all the discussion threads in the 
newsgroup you are looking at. For more 
information, see Expanding/Collapsing 
trees.



Article menu: Followup article
Lets you prepare and post a 'Follow-up' to the current article. 
See also: Reply by email and Start news thread.

For further information, see Responding to news articles.



Article menu/Newsstand button: Open 
newsgroup

Takes you into the newsgroup you've selected and shows you 
a list of the discussions currently taking place in that 
newsgroup. 

For more information see Opening/Closing newsgroups.



Article menu: Rejoin thread
Re-unites a divided-off section of a discussion 
thread with its 'parent'. For more information, see 
Breaking threads.



Article menu: Start news thread
Lets you prepare and post an article which will start a 
new discussion within the current newsgroup. 

See also: Followup article.and    Starting a news thread.



Article/Message menu: Cancel article
Sends a message cancelling the article you have 
selected.

For further information, see Cancelling news articles.



Message menu: Forward "as is"
Opens a new email containing the message 
you've selected for forwarding to someone else.

You cannot add any text of your own to the email 
with this option.

For further information, Click here.



Article/Message menu: Forward 
article/message

Opens a new email message containing a copy of the 
message/article you've selected ready to forward on to 
someone else.

For further information, see Forwarding mail and 
Forwarding a news article 



    
Article/Message menu: Open 

article/message
Opens the message/article you've selected so that you 
can read it.

For further information, see Reading your mail or 
Reading news articles 



Message menu: Reject message
Attempts to return the selected message to its 
sender with a notice that delivery
to you failed. Also gives you the opportunity to 
delete the message. Normally used 
to reject unwanted 'junk' mail.

For further information, Click here.



Article/Message menu / Mailbox button: Reply option
Lets you prepare and post an email message in reply to the message/article
that you currently have either selected or open on the screen. See also: 
Followup article (News).

For further information, see either Sending mail or Responding to news 
articles as appropriate.



Article/Message menu / Mailbox button: Start 
new email

Lets you prepare and post an email message to anyone you wish.

For further information, see Sending mail.



Attachments: an overview

Email can only handle simple text messages that use alphabetic characters, numbers and a few related 
symbols. 

However you are able to include files with pictures, sound files, word-processed documents, and even a 
small programs, as attachments.

There are several (incompatible) schemes for encoding attachments; the best solution is to use MIME. 
Turnpike can recognise if you are replying to someone who uses MIME compatible software and will 
automatically check the Send MIME message option in your message header for you. If this option is not 
checked, the attachment will, when posted, be encoded by an older method known as UUencode. 

Both methods require your recipient to have appropriate software for decoding the file upon receipt. Such 
a decoder may be built into their mailer (as it is with Turnpike) or it may require that the attachment is 
saved to disk and then run it through a separate decoding program before making use of the data in the 
attachement.

The encoding process will increase the size of the file being sent. If the message is larger than 60K 
Turnpike will suggest that it should be split into parts. This is because some mail gateways e.g. to a 
company's private network, will not pass large items. You can generally ignore this suggestion if you are 
sending a message to an address directly connected to the Internet, such as to a customer of an Internet 
access provider. 

Be aware that the process of splitting a message into parts can cause problems. Not all email software 
can    handle the reassembly of parts into a single message in the way that Turnpike can. 

Before sending a large attachment you should discuss these points with your recipient. Unexpected large 
emails are often unwelcome and, some Access providers limit the size of messages that people can 
receive, so the email may not arrive at its destination. 

Your recipient will need to have the right software, e.g. a picture viewer, media player, to use the 
file you send.

Related Topics 
Inserting Files, Attachments/enclosures.
Mail Message menu
Preparing News / Mail messages.

Extracting files from messages.



Attribution & Forwarding text

Attribution text is the text used to introduce quotations from a message or article that you are replying 
to.

Forwarding text is the text used to introduce messages that you forward to someone else.

Turnpike automatically sets suitable forms of text for each of these, incorporating such things as the 
author of the original message, their email address and the Message ID. If you would prefer a different 
style of introduction for either of these, you can record the form of introductory text you want on the 
Standard text page of the Alter Mailbox / Alter Newsstand dialog.    called up when you either set up or 
alter the mailbox or newsstand you want to affect.

Items such as the author's name and their email address are included in these texts by putting special 
markers where you want these to appear. The following markers are used for the;

%a email address
%d date when the message was posted
%f a mailto:url of the authors address. For example mailto:paul@turnpike.com
%g newsgroup in which the article is being read (left blank where you are replying to or forwarding

a mail message)
%l number of lines (news articles only: left blank where you are replying to or forwarding a mail 

message)
%m message ID
%n can be used to start a new line
%o person's organization (news articles only: left blank where you are replying to or forwarding a 

mail message)
%p person's name
%s subject of the message
%t time it was posted

If you want to include a % in your text, write this as %%.

Related Topics
Alter Mailbox dialog
Alter Newsstand dialog



Backing up your Turnpike files

As in any program, it is a good idea for the person who has the role of system administrator to keep back-
up copies of important files. In Turnpike, the files to back up are:

From the Turnpike directory: TURNPIKE.USR
CALLS.TPK
The .INI files
Any .ACC file that has been modified
Any .MDM file that has been modified
Any .CST file that has been modified

From the Mail directory: MSPOOL
MAILBASE
ADDRBOOK

From the News directory: NSPOOL
NEWSBASE

plus the whole of each user's directory (which have names of the form USERxxx).

Other files don't need to be backed-up because they can, if necessary, be recovered either by re-installing
Turnpike or, in the case of the additional files in the News directory, by re-building the Newsbase.

Related Topics 
Moving the Mail and News Directories
Moving Turnpike to another machine
Upgrading to the latest version of Turnpike
Re-building the Newsbase.



Binaries

A number of 'Alternative' newsgroups have names including the word 'Binary' or 'Binaries'. This indicates 
that the 'articles' in that newsgroup include binary data - particularly graphics. Indeed, the articles 
themselves are usually referred to as 'Binaries'. There are two points to note about such articles.

They take up a lot of disk space. Indeed, your System Administrator may well ban you from 
subscribing to these groups for this reason alone (though they may also ban particular groups on the 
grounds of the type of material that is contributed to those groups!).

You can't simply open a binary and see its contents. They need to be decoded first. Similarly, if you 
want to contribute a graphic (or other such file) to one of these newsgroups, you will need to encode it
first: see Posting a picture.

The reason for this special handling is simply that Usenet News was originally set up to handle 7-bit text.

Related Topics
'Reading' binaries.



Blind carbon copy
This is a copy ot the message to all name(s) entered in 
the bcc line of a message header.
The recipients in the To and cc lines and any other 
recipients in the bcc line of the header will not be able to
see who has been given copies if the message.



Breaking threads

With some of the more complex discussion threads, you may find that you are interested in one branch of 
this discussion but not in another. To help you ignore the part you aren't interested in, Turnpike lets you 
break discussion threads into two or more parts which can then be treated as separate threads and 
classed as Interesting or Not interesting as you require.

NB    The effect of breaking a thread is purely local to your own system.

To break a thread, select the article at which you want to make the break, then take the Break thread 
option in the Classify menu. (The piece you break off is then marked  to show that it is a 'User-defined' 
thread.)

To join the parts together again, select the 'user-defined' part of the thread, then take Rejoin thread 
from the Classify menu.

After a thread has been rejoined, it will be marked Interesting if either of the parts was classed Interesting,
or Not interesting if one part was classed as Not interesting and the other was neutral. You may want to 
adjust this classification.

Related Topics 
Article Menu



Browsing a Newsgroup
To browse a newsgroup is to download just the header of each article. This saves a considerable amount 
of disk space while still allowing you to see whether there is anything of interest to you. If you spot an 
article you do want to read, you can request it to be downloaded the next time you go on-line to the 
Internet (see Requesting missing articles).

Also, you can set kill rules to accept certain types of articles in full, even though only the headers of other
messages are downloaded.

If you would like a particular newsgroup to be browsed, then assuming you have News Admin permission,
you can arrange this by selecting Configure from the File menu, taking the Newsgroups option - then 
setting the Type of this newsgroup to Browse in the Newsgroup Subscriptions dialog that's displayed.



Call costs

Turnpike automatically records the time, duration, destination and cost of calls made by each user of 
Connect, and provides a variety of tools for working with the log that is produced.

For further information call up Help from the Connect program and search for Call costs or read the 
section on Call costs in the Connect manual.



    
Calling up the Address book

To call up your Address book, either 

Double-click its icon
Click the Address book button on the toolbar
Or, select Address book from the Window menu.

If you are writing a message, click the Look up Address 
button on the tool bar



Cancelling news articles

If you change your mind about posting an article or you want to make a change to it, the best thing to do 
is to pull it out of your Out tray before it is sent (if you are already on line when you post it, note that 
Turnpike deliberately leaves items in the Out Tray for at least a minute).

If you the article has already been sent, you have the option of following it up with a message containing 
the instruction to Cancel the article. If the article has already appeared in the newsgroup, then you can 
send this message by selecting the article and then taking the Cancel article option from the Article 
menu. If it hasn't yet appeared in the newsgroup, call up the Mailroom view of everything that's gone in or 
out, select the article in this list (the newsgroup to which you sent the article will be listed as the recipient),
then select Cancel article from the Message menu.

In either case, Turnpike will then open a special message for you to post, to which (by convention) you 
need to add the reason why you want the article cancelled. This explanation is needed because not all 
news servers process such messages automatically: in some cases, real people get to decide whether 
your article is cancelled or not.

But note: there's no guarantee that your Cancel message will be processed and in any case your original 
article may be read before the Cancel message takes effect. All the Cancel message can do is minimise 
the number of people who do read your article. In the light of that, it may be better to simply take 
responsibility for the article you've posted and follow it up with a correction or an apology if appropriate - 
though you may then get flamed for making too much noise.

You can, of course, only cancel your own articles (posted from the site at which you are currently 
working), though on a multi-user system someone with suitable administrative powers can cancel articles 
by any user working at their site.

Email cannot be cancelled.

Related Topics 
Article Menu



Cancelling your subscription to a newsgroup

To cancel the subscription to a particular newsgroup and stop articles being downloaded from that group, 
it needs to be removed from the list of subscribed newsgroups that Turnpike keeps. The newsgroup also 
needs to be removed from any newsstands in which it is selected.

To remove the newsgroup from the list of subscribed newsgroups, someone with News Admin permission 
needs to take the Configure option from the File menu, then select Newsgroups from the sub-menu that 
appears to display the Newsgroups Subscriptions dialog. You then need just need to select the 
newsgroup in the list of subscribed groups and click the Unsubscribe button.

However, in general all anyone need do when they decide they no longer want to follow a newsgroup is 
remove it from their newsstand (using the Remove button at the bottom of the window in which the list of 
newsgroups in the newsstand is displayed). If this means that no-one is now following this newsgroup, 
then the next time someone with News Admin permission logs on, Turnpike will display a message asking
if it should unsubscribe from this newsgroup: clicking the Yes button will remove it from the list of 
subscribed newsgroups. (If you say No to this offer, the message will continue to appear each time 
someone with News Admin permission appears until such time as someone either opts to unsubscribe it 
or adds it to a newsstand.)

A similar thing happens when a newsgroup is removed from the list of subscribed newsgroups but not 
from the newsstands in which it appears. When anybody with News Admin permission who has this 
newsgroup in their newsstand logs on, they will see a message advising them that their newsstand 
includes a newsgroup which is not in the list of subscribed newsgroups and offering to add it to the list. If 
you 'say' No, the newsgroup will be automatically deleted from the newsstand. (If you don't have News 
Admin permission, the newsgroup is simply removed anyway.)

If you want to retain any articles you've downloaded from the newsgroup, export them first - including 
ones you have marked to be kept. Otherwise, these articles will disappear the next time News is expired.



Carbon copies
This is simply a copy of an email message 
specified through a CC: line in its header. 
Every recipient will see who else has been 
sent copies.



Changing newsgroup subscription details

When a newsgroup is first added to the list of newsgroups subscribed to at your site, it is set to be 
downloaded in full and for the articles to stay on your disk for three days before being automatically 
expired. It is also made available for anyone who uses your system to read.

If you have News Admin permission, you can change all these settings. To do this, you need to take the 
Configure option from the File menu, then select Newsgroups from the sub-menu that appears to 
display the Newsgroup Subscriptions dialog.

To stop the newsgroup being downloaded in full
select the newsgroup in the top part of the dialog, then switch the Type setting to browsed in the 
lower part of the dialog.

To change the length of time the articles will stay on your disk
select the newsgroup in the top part of the dialog, then set the Expiry time you require in the lower 
part of the dialog.

To restrict who can access the newsgroup
select the newsgroup in the top part of the dialog, then click the Access button and select the people 
who are to have access to this newsgroup in the dialog that's displayed.

IMPORTANT After changing either the Type or the Expiry time (or any of the other settings recorded in 
the lower part of the Newsgroup Subscriptions dialog), be sure to click the Apply button. Otherwise the 
settings you've made will be lost if you then either leave the dialog or move on to a different newsgroup.

See also Newsgroup Subscriptions dialog or press F1 to call up Help when you have this dialog on the 
screen.



Changing the header on a message

When you are preparing a message, all that is initially displayed in the header is the To and Subject 
slots.

For other details the message uses the information from the 'User Info page' of the mailbox or newsstand 
in which the message is being prepared. 

If you want to give a special reply-to address or add to the list of addresses to which the message is to be
sent, click the Edit header button above the message. 

This displays the Header dialog. This has with slots for each of the common header lines that you might 
want to set.

This dialog includes an 'Other' area in which you can type any additional header lines you require. Type 
any such lines as simple text.

Related Topics
Preparing News / Mail messages.
Mail Header dialog 
News Header dialog.



Classify menu

For both email and news:
Mark as Read
Mark as Unread

For news only:
Class as Interesting
Class Uninteresting
Declassify

Kill article
Keep article
Cancel Keep
Request article
Cancel request



Classify menu: Cancel Keep
Cancels an earlier request to keep the selected news 
article. The article will then be expired in the usual way.

See also Keep article



Classify menu: Cancel Request
Cancels an earlier request to download the 
selected article.



Classify menu / Newsstand button: Class 
Uninteresting

Marks the discussion thread you've selected as 'Not Interesting'. The 
thread is then marked .

When the newsgroup is next re-threaded, this thread will be listed at 
the bottom of the newsgroup alongside other threads you've marked 
as not interesting.

For further information, see Picking out interesting articles.



    
Classify menu / Newsstand button: Class as 

Interesting
Classifies the discussion thread you've selected as 'Interesting'. The 
thread is then marked .
When the newsgroup is next re-threaded, this thread will be listed at 
the top of the newsgroup alongside other threads you've marked as 
interesting (assuming there are further articles to read on this topic: 
see Picking out interesting articles).



Classify menu: Declassify
Puts a discussion thread back to its default status of 
'neutral' - ie. neither Interesting nor Not interesting.

When the newsgroup is next re-threaded, this thread will
be listed below any Interesting threads but above any 
threads you've marked as 'Not Interesting'.



Classify menu: Keep article
Tells Turnpike to keep the selected article past its alloted expiry
date. The article is then marked  to show that it isn't to be 
deleted.

Greyed out if you haven't been given Keep article permission.

See also Keeping articles past their expiry date. and Cancel 
Keep



Classify menu: Kill
Calls up a dialog through which you can opt either simply to 
'kill' the current article or to also use it as a model for articles 
that you don't want to download in future.

Greyed out if you haven't been given Kill article permission.
See Killing articles



Classify menu: Mark as Read
Marks the messages/articles you've selected as read 
even though you haven't read them.

For more information, see Switching between Read and 
Unread.



    
Classify menu: Mark as Unread
Marks a message/article you've read as 'Unread' so that 
it will continue to be drawn to your attention.

For more information, see Switching between Read and 
Unread.



Classify menu / Newsstand button: Request 
article

Asks for an article which is either not available or of which only 
the header is available to be downloaded in full the next time 
that you go on-line. The article is marked  to show that 
you are waiting for it.

For more information, see Requesting missing articles.



Clearing out unwanted articles

Where a newsgroup contains discussions that you feel are just cluttering up the display, it is 
usually sufficient to mark these threads as 'Uninteresting'. Threads that you mark as 
Uninteresting remain on your disk but are moved out of sight to the bottom of the list when 
the newsgroup is next re-threaded.

If you need the disk space before the articles naturally expire, you are able to kill these 
articles. Killing an article removes it from the Newsbase. The header is kept until the time 
when the article was originally marked to expire. To recover the space either re-build the 
Newsbase or simply leave the space for articles that are downloaded the next time you go 
on-line.

Related Topics

News article - Kill rules
Killing news articles.
Kill rules dialog
Kill rule dialog

News article - Custom Kill rules
Custom Kill rules -examples

Defining Custom Rules.
Custom rules: Formal syntax.

Re-building the Newsbase
Marking threads as interesting



'Colour Selection' dialog

This dialog lets you select the colour used either for text or as a background. (The type of text or 
background for which the colour is to be used is itself part of the dialog.)

It is called up either by taking the Alter option from the Colours page of the Mailbox or Newsstand dialog 
(for making permanent changes) or by taking the Colour option from the Options menu (for making 
temporary changes that will be lost when the current window is closed).

The dialog offers both a 'palette' of 'Basic' colours from which to pick and, on the right, a complete colour 
spectrum from which to select a 'custom' colour if you wish. If you want, you can add the colours you pick 
out from the colour spectrum to an additional palette of 'Custom' colours.

To use a colour from a palette, you simply need to click on the colour in the palette.

To pick a custom colour from the spectrum, you click on the colour you want in the spectrum, then set 
its 'luminosity' (the amount of white/black you want in the colour) by clicking on the sample bar to the 
right of the spectrum.

You can then add this custom colour to the Custom palette by clicking the Add to Custom Colors 
button.

(If you want the new colour to replace an existing colour in the Custom palette, select the entry in the 
Custom palette before setting up the new colour. The 'old' colour will be replaced by the new one 
when you click the Add to Custom Colors button.)

IMPORTANT      Text is only ever displayed using the 'Solid' part of the colour you select. So when setting 
the colour for text, be sure to check the 'Solid' part of the sample shown in the dialog because this is 
what will be used.



Compuserve addresses
People who use Compuserve have addresses of the form 12345,678      

The equivalent Internet address is 12345.678@compuserve.com



Configure User Sign-on Names dialog 

This dialog is called by selecting Configure from the File menu and then selecting Users

The Configure user sign on names dialog enables you to,
· Add new users to the system
· To remove users who no longer use the system, and
· To allow a user who has forgotten their password back into the system by giving them a 

new password.

The Configure user sign on names dialog lists users that currently have 'seats' on your 
Turnpike system, together with the number of their seat and details of when they last signed
on. Buttons enable you to Create, Edit and Remove users.

This dialog is available only to the person who acts as system administrator and to
anyone with 'Alter Users' permission:

Related Topics
The Edit sign-on details dialog
Remove users from a shared system
Adding new users



Configuring the connection to the Internet

All aspects of the connection that Turnpike makes with the Internet are set from Turnpike 
Connect, not from the main Turnpike program. 

Connect enables you to set,
· The Access provider used
· The number you dial in on
· The modem used and the speed at which it runs
· Which port on the PC it is connected to

For more information, either consult the Turnpike Connect book or load Connect and 
call up its own Help file.



Configuring Turnpike: Introduction

There are many aspects of Connect that your are able to configure to suit your needs. Some
features are set from the main Turnpike program. Some only apply when several people 
share the same system

· Configuration features set from the main Turnpike program
· Set Permissions
· Add new users and the sign-on names they use.
· Set up workgroups
· Set the Email Routeing
· Set where news and mail are stored
· Allocating disk space and moving Turnpike

You will only be able to configure the above facilities if you have Connect Admin 
permission

· Features set from the Turnpike Connect program:
· The details of the actual connection itself - such as which access provider you use and which 

number you use to dial them up and the type of modem you have. 
· Where mail and news are sent to and received from on the Internet.
· What time zone you work i

Related Topics
Adding new users
Enable the Edit sign-on details dialog
The Edit sign-on details dialog
Remove users from a shared system
Edit details of a current user



Context menus
Turnpike lets you call up Windows 95-style 'Context' menus and dialogs by pointing to the item you are 
interested in and clicking the right mouse button. You may well find that these offer a quicker and easier 
route to several of the actions you wish to carry out.



Controlling access on an individual basis

This topic applies only to multi-user systems

Each newsgroup (or mailing list treated as a newsgroup) that is subscribed to at a site is normally 
available to any user at that site - but in some cases, you may wish to restrict access to a particular 
newsgroup to a named list of users.

The way this is done is through the 'news tag' that is associated with each newsgroup that is subscribed 
to. This tag is automatically applied both to the newsgroup itself and to any item that is either contributed 
to the newsgroup or sent in response to an article that appears in the newsgroup.

Like the tags that you can apply to mail messages, each news tag can either be made Public - allowing 
any user to follow the newsgroup and see any contributions that are made to the discussion - or it can be 
made Private to a list of named users or workgroups .

Initially each newsgroup that is subscribed to is automatically marked Public, making it available to any 
user. But if it's necessary to restrict access to a particular newsgroup, someone with News Admin 
permission can do this through the Newsgroup Subscriptions dialog (called up by taking the Configure | 
Newsgroups option from the File menu) Just select the newsgroup in the list of subscribed newsgroups 
shown at the top of this dialog then click the Access button shown alongside.

In the Usage dialog that's then displayed, select (ie. check) Limit newsgroup access at the top of the 
dialog, then set up the list of users / workgroups that you want to be able to see the newsgroup (including 
yourself if so required) by selecting these in the left-hand list in the lower part of the display and adding 
them to the list on the right.

Access to newsgroups specifically allowed through the news tags takes precedence over access 
controlled from lists of newsgroup ratings. It's therefore possible to use these news tags to allow someone
to follow a particular newsgroup that would otherwise be hidden on the basis of its rating - by ensuring 
that they are on the list of people that have access to the newsgroup. However, you will then need to 
ensure that every-one else that wants access to this newsgroup is also on the list, because otherwise 
they will be barred - regardless of the personal ratings levels.



Controlling access through ratings

Concern over the propagation of dubious and possibly even illegal material through the Usenet 
newsgroups has led to the introduction of services for rating newsgroups on the basis of the amount of 
bad language, nudity and other potentially offensive material they contain.

Each of these rating services identifies categories of items which might be offensive and grades the 
different levels to which these categories may appear 0, 1, 2, ... between innocuous and highly offensive. 
These gradings and any other associated service information are recorded in a '.RAT' file on your 
machine (that is, a file with the filetype extension .RAT).

Meanwhile, at the news server, each newsgroup is given a 'rating' under each of the various rating 
services supported by that news server by an independent third party such as the recently-announced 
Safety Net organisation. These ratings are then downloaded alongside the list of newsgroups - and can 
be inspected through the Newsgroup Subscriptions dialog (or associated Newsgroup Subscription dialog) 
and the Newsgroup Addition dialog

To use these ratings to filter the newsgroups seen within Turnpike, you simply need to:

Establish which ratings services are supported by your news server, then select the general details 
that are to apply ie. which ratings service or services you are going to use and what the default 
ratings levels should be for users of your system.

Then set any special maximum levels that are needed for particular users.

The result of this is then that each user - including ones with News Admin permission - will only be able 
see newsgroups that have been rated less than or equal to the maximum levels recorded for that user.

For detailed instructions, follow the links above.



Converting a mailing list into a newsgroup

One of the options Turnpike offers is to have a mailing list handled like a newsgroup, allowing
the mail from this list to be threaded and expired in the same way as the articles contributed
to a newsgroup. This is automatically arranged when you follow the standard procedure for 
subscribing to a new mailing list

If you already subscribe to one or more mailing lists you can arrange for them to be handled 
as newsgroups. 

     You are only able to set Mailing List rules if have List Subscribe or Email Admin 
permission.

To convert a mailing list to a newsgroup

Follow the procedure to add a Mailing List but DO NOT click the Send email button to send 
a subscription message to the list's administrator:

Add the mailing list to one of your newsstands.

If you want mail you've already received from this mailing list to appear in
the mailing list 'newsgroup':

1. Export the mail
2. Delete it from your mailbox and empty the Waste basket
3. Go into your Mailbox and import it as mail.

When the mail messages are re-imported, Turnpike will put the messages in the mailing list 
newsgroup. 

Mailing lists treated as newsgroups are identified by an exclamation mark before 
their name in the subscribed newsgroups list.

Related Topics 
Mailing Lists - Overview
Subscribing to a Mailing list
Adding newsgroups to a newsstand



Copies the selected email into a new message ready 
for you to send on to someone else.



Cross-posted articles
This type of article is one which has been set to appear in two or more newsgroups (as distinct from an 
article which has been separately posted to a number of different newsgroups). The names of the 
newsgroups in which the article appears are listed one after another on the Newsgroups line of the article 
header, separated by commas.

With a cross-posted article, there is only one copy of the article; once it has been read in one newsgroup 
it is automatically marked as read in the other newsgroups in which it appears. Where an article has been
posted separately to a number of different newsgroups, you get multiple copies of the same article and 
there is no way of telling that you have already read the article until you open it. Such multiple posting is 
known as spamming and is very much frowned upon.



News article - Custom Kill rules

Before setting a Custom Kill rule confirm that it is not possible to filter the items you want by
the data entered in the other fields of the News article kill rule dialog 

When you do require a Custom rule, first see if one of the examples can be used as a 
template.

A Custom Kill rule enables Turnpike to identify a particular class of article you want to kill. 
This is done    by giving it a 'pattern' to match against the headers of articles posted to the 
newsgroup. 

· Custom rules generally take the form:    / pattern    / modifier

Generally, the modifier specifies the part of the header that should be searched. If you can 
tell Turnpike which part of the header it needs to match the pattern against, the search will 
be quicker than if you ask it to match the pattern against the whole header of each message

Modifiers
h search every header line
s search the Subject: header line after "Re:" etc.
a search the author's address as extracted from the From: header line (starting after 

any angle brackets)
c the case of the characters (upper or lower) matters in matching the pattern 

If no modifier is given or only c, then s is assumed, i.e. just the Subject line is searched. 

Any header lines that have been 'wrapped' or 'folded' onto 2 or more physical lines are 
automatically 'unfolded' before they are searched You don't have to allow for this 
wrapping/folding in your rule.

The pattern that you want Turnpike to look for, is expressed in the form of a regular 
expression written using (fairly) standard UNIX syntax. As these are sometimes difficult to
specify, it can help to study the examples, and select the one that most closely mirrors 
the type of rule you want to specify.

Related Topics 
Killing articles
News article kill rule dialog
Defining Custom Rules..
Custom Kill rules -examples

Kill rules dialog

Custom rules: Formal syntax.



Custom Kill rules: Examples

To kill any article from 
fred@anycompany.com /^fred@anycompany\.com$/a

dick and harry /^(tom|dick|harry)@/a

people who shout /[A-Z][A-Z]/c

anybody at anycompany.com /@anycompany\.com$/a

a thread started by anybody at anycompany.com /^References:\
s*<[^<]*@anycompany\.com>/h

anybody at anycompany.com unless these have "widget" in the subject
/@anycompany\.com$/a & !/widget/s

To kill any article with
 "widget" in the subject /widget/s

an X-Newsreader header /^X-Newsreader:/h
This rule won't have any effect where Group access and a News Overview database are used.

To kill articles 
from tom, dick and harry /^(tom|dick|harry)@/a
except those from tom, dick and harry !/^(tom|dick|harry)@/a
that were posted on a Friday /^Date:\s*Fri,/h

To kill crossposted articles /^Newsgroups:.*,/h

To kill articles under 60 lines long (ie. between 1 and 59 lines long) /^Lines:\s*[0-5]?\d$/h

If you want to kill articles over a certain length, set the maximum length you want in the 'Longer than' slot
in the News Article Kill Rule dialog.

Related Topics
Defining Custom Rules
Custom Kill Rules
Custom rules: Formal syntax.



Custom Mail rules

The criteria for mail to be selected for a particular mailbox or directed to a particular seat 
are set in the Addressed to, Sent from and Subject fields of the Distributing Mail to Mailboxes
dialog. and the Distributing mail to seats dialog 

If you want mail to be selected by some other criterion you will need to set up a 'custom 
rule' in the dialog. 

The rules set on the five pages of this dialog are generally to enable you to avoid SPAM, 
UCE, UBE etc 

The first two pages of the    Email routeing to seats & news dialog  enables you to set up 
rules for the acceptance or rejection of mail by examining the message envelope, or the 
message as a whole. The next page enables you to set up mailing lists as a newsgroups and 
to set routeing rules.The remaining two pages of this dialog enable you to set seat routeing 
rules and whom should receive dead letter mail. 

Custom Mail rules enable Turnpike to select mail messages for a particular mailbox. Rules 
form a pattern that is matched against the headers and SMTP envelope of the mail 
messages you receive.

· Custom rules generally take the form:       / pattern    / modifier
The modifier generally specifies the part of the header that should be searched. If you 
can tell Turnpike which part of the header it needs to match the pattern against, the 
process of allocating mail to different mailboxes/seats will be quicker than if you ask it to 
match the pattern against the whole header of each message. 

Modifiers:
a search the author's address, as extracted from the From: header line, starting after any angle 

brackets
c observe the case of the characters in the header    
f search the 'Reverse Path' as taken from SMTP envelope MAIL FROM; or equivalent 

information taken from the header
h search every header line
s search just the Subject: header line after "Re:" etc.
t search the 'Forward Path' as taken from SMTP envelope RCPT TO:, or equivalent information 

taken from the header.
u search the username that results from taking the 'local part' of the Forward Path given by the 

SMTP envelope RCPT TO: and stripping it of any !host or %host parts

Using only c or no modifier at all u is assumed. This will result in a search for just 
the username (extracted from the SMTP envelope). 
The f modfier is generally used for sorting mail from a mailing list. 
The f and t modifiers enable you to search the MAIL FROM and RCPT TO information 
given in the SMTP envelope of mail delivered by SMTP. 

If the message was collected from a POP mailbox, Turnpike will use equivalent details 
constructed from information in the message header.
Any header lines that have been 'wrapped' or 'folded' onto 2 or more physical lines are 
automatically 'unfolded' before they are searched. 



Example Mail Rules
As stated above custom Mail rules are only required when it isn't possible to specify the messages you 
want to select or reject on the basis of their subject, author or who they are addressed to. If you do 
need a Custom rule, first see if one of the examples can be used as a template.

Search patterns need to be expressed as regular expression. Regular expressions can be difficult to 
define. Study the following examples, and pick out the one that most closely mirrors the type of rule you 
want to specify you can then modify the rule to suit your purpose. Click on any example for a more a 
detailed explanation,    

All mail addressed to fred /^fred$/
All mail from fred@anycompany.com /^fred@anycompany\.com$/a
All mail from anybody at anycompany.com /@anycompany\.com$/a
All mail with "urgent" in the subject /urgent/s

All mail from anycompany.com unless 
it has "urgent" in the subject /@anycompany\.com$/a & !/urgent/s

All mail from Tom, Dick or Harry /^(tom|dick|harry)@/a
All mail, except that from Tom, Dick or Harry !/^(tom|dick|harry)@/a
All mail with an X-Mailer header /^X-Mailer:/h

For further examples see Custom mailing list rules

Related Topics
File Menu - Configure email routeing

Defining Custom Rules.
Custom mailing list rules
Custom rules: Formal syntax.
Regular expression 

News Article Kill Rule dialog
Clearing out unwanted articles



Custom Mailing list rules

Custom Mailing lists rules are required when you find that mail from a mailing list is incorrectly routted by 
the default rule generated by Turnpike. Mailing list rules are set on the Email routeing to Seats & News 
dialog - Mailing list page.

A custom mailing list rule enables you to set a pattern to enable Turnpike to match against the header and
SMTP envelope. Custom rules take the form    /pattern/modifier. where the modifier. specifies the part of 
the header to search. 

There are no standards governing the form of mailing list headers.This can make it difficult to detect mail 
from a mailing list. Turnpike generates a default rule which looks for any occurrence of the mailing list 
submission address in any of the following header fields: 

To:, Cc:, Bcc:, Resent-To:, Resent-Cc:, Resent-Bcc:.If these headers are not removed or 
replaced by the mailing list manager when the message is distributed to the list's 
subscribers the rules will work.

· The default rule can fail
· If messages you receive from the mailing list are not sent out from the same address 

as the submission address.
· Or if the mailing list manager removes the original To: fields etc. when redistributing 

the message.

If the default rule fails, use one of the following to identify the messages:

· Return Path
Look at the header of a sample message from the mailing list and see if it contains a 
Return-Path: line of the form

Return-Path: <local.part@domain>
or

Return-Path: <@something:local.part@domain>

where the local.part will be similar to the list name, eg. owner-list, list-errors or list-
request.

There will always be a Return-Path line in mail received by SMTP. This is because it is 
automatically created from the SMTP envelope MAIL FROM. It won't necessarily be present in
mail received by POP because this doesn't have an SMTP envelope. A suitable Return-Path 
line may have been added by the SMTP server that delivered the message to your POP 
mailbox.

If you find a suitable Return-Path line, use the custom rule        
/[<:]  local  .  part  @  domain  >$/f      

where the local.part and the domain are those given in the Return-Path line. 

Precede any dots '.' in the local.part or the domain by \ . ‘.’ on its own has a special 
meaning.



· If the mailing list manager adds its own Sender: line to the header
Use the following rule,      /^Sender[ \t]*:[ \t]*local.part@domain/h    where local.part 
and domain are the ones given in the mailing list manager's Sender line.

Precede any dots '.' in the local.part or the domain by \ . ‘.’ on its own has a special 
meaning.

· If other methods fail.
1. Cancel your current subscription and setup a special email name for yourself. You will 

require.permission
2. re-subscribe using the special    name
3. Use this name in the 'Addressed to' fields of the Mailing List Routeing Rule dialog.

Ensure that your special email name is used in both the 'From' line and the 'Reply-to' 
lines of your subscription message you send.    Click the 'Edit mail header' button shown 
above the message before you post it to ensure that the From and Reply-To line are set 
as you want.

If this method does not work it will be because the mailing list managers takes the 
address on the 'Sender' line (which you can't change) as the address to which the mailing 
list mail should be sent.

Related Topics
Defining Custom Rules. 
Custom rules: Formal syntax.



Custom Rules: Formal syntax

A custom rule specifies one or more regular expressions to match against the relevant part 
of a message header. These matches are combined by the logical connectives and (&), or (|),
not (!) and parentheses.

The format of each rule is as follows (expressed in BSI syntactic metalanguage):

rule = term, ["|", rule].
term = factor, ["&", term].
factor = "!", factor |

"(", rule, ")" |
"/", regular expression, "/" {modifier}.

modifier = "h" | "s" | "a" | "f" | "t" | "u" | "c".

The regular expressions are expressed using the (fairly) standard UNIX syntax and enclosed 
in "/" characters. To put "/" into the regular expression, escape it with "\/".

Modifiers restrict how and where the regular expression is applied as follows:
a search the author's address, as extracted from the From line, starting after any angle 

brackets.
c the case of the characters (upper or lower) matters in matching the pattern 
h search every header line. Any 'folded' lines are automatically 'unfolded' before they 

are searched.
s search just the Subject: line after "Re:" etc.

The following modifiers apply to mail messages only
f search the 'Reverse Path' as taken from SMTP envelope MAIL FROM. or equivalent 

information taken from the header. 
t search the 'Forward Path' as taken from SMTP envelope RCPT TO: or equivalent 

information taken from the header.
u search the username that results from taking the 'local part' of the Forward Path 

given by the SMTP envelope RCPT TO: and stripping it of any !host or %host parts. 

Individual regular expressions plus modifiers may be further combined into patterns using & 
(and), | (or), ! (not) and parentheses.

White space - spaces and tabs - may occur anywhere except within the Regular expression  
where spaces and tabs stand for themselves.

Related Topics 
Custom Mail rules
Regular expression 



Customizing your mailbox
It is easy to set colours, fonts, signatures and many other properties of your mailbox - and if you have 
several mailboxes, you can set different properties for each one. To do this, go to the Alter Mailbox 
dialog. To get there:

either right-click a mailbox and choosing Properties
or left-click a mailbox and then go to the File menu and select Alter Mailbox

This displays seven tabs - click on each tab in the picture below to discover more.

When you are entering information on the pages revealed by these various tabs, remember that you can 
always click the Help button that is displayed (or you can press the F1 key) to get specific help on the 
settings required.

On the User info page you can change the email name used by the mailbox to any other email name you
have created. If you want to use an entirely new email name, you must create it first. Click here for 
details.

Note that Turnpike also offers a facility to set Font and Colour in the Options menu. This is for making 
temporary changes to the current window. To make permanent changes, use the method described 
above.

Before going on, explore the tips on Fonts if you haven't done so yet.
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Cut and Paste editing
'Cut and Paste' describes the technique used to copy or move a section of text from one place to another 
within your messages.

To copy a section of text, mark out this text then either take the Copy option from the Edit menu or 
press Ctrl + C. Then place the cursor where you want insert the copy and either take the Paste option
from the Edit menu or press Ctrl + V.

To move a section of text, mark out this text then either take the Cut option from the Edit menu or 
press Ctrl + X. Then place the cursor where you now want insert this text and either take the Paste 
option from the Edit menu or press Ctrl + V.

To delete a section of text, mark out this text then either take the Cut option or use one of the 
Delete keys.

Copy, Cut and Paste are also available for editing text slots within dialogs - but you need to use Shift + 
Ctrl + C, X, V to select these actions (in some instances Ctrl + C, X, V will work as well).



Cut lines
Lines starting with two or more dashes 
which are conventionally used to mark 
divisions between sections of messages - 
for example, between the main text and the 
signature.



Date Format

When you open a mailbox or a    mail list the date and time each message was sent is shown. If you 
extend the first divider, the date and time the messages arrived can also be shown..

By default the the Display order for messages which have been sent and received are Date, Day, Time. 
The Date order is Day, Month, Year.

You are able to change this format if you wish.

1. Open the mailbox or mail list
2. Click Options from the menu
3. Choose Date Format

The Mailbox time and date format dialog is appears. This dialog has two pages, one to set the 
Sent options and one to set the Arrived options.

4. Select the option for the Display order you want to use
5. Select the option for the Date order you want to use

6. Select further options to Show time, Months as text, Show day, show time as 24 hour clock

An example of the style you have selected is shown in each dialog.

7. When you are satisfied with your settings click the OK button to save.



Decoding encoded text

If part (or all) of an email message or a news article looks like gobbledygook, it is likely to have been 
encoded.

If only a few words seem to be affected, it is likely that ROT13 encoding has been applied. This is 
sometimes used to conceal the answer to a riddle or a potentially offensive word.

In such cases, select the affected text and take the ROT-13 option from the Edit menu. This simply 
advances each letter 13 places through the alphabet (changing a to n, b to o etc.). If this is not the 
answer, just apply ROT-13 again to advance another 13 places, and thus get back to the original 
display.

If most of a message consists of strange characters, it is likely to contain a file which has been 
UUEncoded in order to allow it to be sent as text (though not using one of the standard formats that 
Turnpike automatically recognises and presents as a file). In this case, the encoded section will be 
introduced by a note giving the filename and the encoder that has been used:

[ Section: 1/1 File: sample.xyz UUencoded by: Turnpike Version 3.04 ]

begin 644 sample.xyz
M0DVF8HP!0##0#@QPX___9F[GY?

Where something within a message or article has been uuencoded, go to the File menu and select 
the Decode option.

Large uuencoded files are often split over a number of messages (marked eg. [1/12], [2/12] etc.). 
Where this has happened, close the current message, select all the messages in the sequence, then 
take the Decode option.

See also Encoding messages to find out about encoding parts of your own messages.



Default mailbox
Turnpike initially sets up a default mailbox for you. Any mail, 
which isn’t directed to one of your alternative mailboxes, is 
automatically put in this default mailbox. The default mailbox is 
used as a template for all alternative mailboxes, this means that 
the properties such as colour and font used will be the same in all 
your mailboxes unless you set them otherwise in the properties of 
each alternative mailbox. 

You will save you time if set all common properties in your default 
mailbox, 
before you add any alternative mailboxes. 



Defining Custom Rules

Custom rules are used by Turnpike to specify which messages or articles you want Turnpike 
to select. 

Before using a custom rule, confirm that you are unable to select the messages or articles 
you want using the standard options offered in the either of the following dialogs.
 
· Email routeing to seats & news dialog
· Distributing Mail to Mailboxes dialog.
· Mailing List Routeing Rule dialog..
· News Article Kill Rule dialog

When you are sure you need a custom rule look for a rule similar to that which you want to 
apply in the examples given in Custom Mail rules, Custom Mailing List rules. or News Article 
Custom Kill rules.  Use the example as a template for your requirements. 

If you cannot find a similar rule, study the text which follows. If you simply wish to see the 
formal syntax for Custom rules, click here.

The basic form of a Custom rule is:        / regular-expression / modifier

The regular-expression gives the pattern that Turnpike needs to look for, the modifier defines
how the pattern should be applied, typically in terms of the part of the message header that 
should be searched. For details of the modifiers see 'Custom Mail rules.

The pattern is compared against individual header lines, taken one by one from the headers 
of the messages being filtered. In general, the comparison is made against the whole of the 
header line. 

If the modifier specifies that just the author's address be searched, the pattern you give is 
only compared with the From: header line after any angle bracket. Similarly, if just the 
Subject line is searched, the pattern is only compared with the section after any Re: that 
may be included in this line.

· Regular Expression

The required regular expression is constructed by defining the sequence of characters, tabs, 
spaces etc. that you want Turnpike to look for.

Letters, digits and spaces Where you want Turnpike to look for a letters, a digits or a 
spaces, put these characters as written in your regular expression. 

Punctuation marks or other symbols,.The following characters have special 
meanings./    |    ^    $    *    +    ?    .    \    -    (    )    [    ]
Each occurrence of any of the above must be preceded with \ . An example is where you 
want Turnpike to look for a particular email address such as anybody@turnpike.com. 
This must be written as anybody@turnpike\.com.

Tabs. these need to written as \t. 

Carriage return, line feed and form feed. It is unnecessary to enter characters for 
these. Turnpike will automatically unfold 2 or more wrapped or folded lines..



Match any character. Enter a dot ‘.’

Match certain characters. List the possible characters within a pair of square brackets.
For example, [ab] means accept either an a or a b.

A range of characters. Enter the range within square bracket, For example any letter 
between m and t, enter as [m-t], any digit between 2 and 8, enter as [2-8]. 
Use \w for any character, equivalent to specifying [a-zA-Z0-9_].  
Use \W    for 'not a word character'.
Use \d for any digit, the equivalent of [0-9].. Use    \D for 'not a digit'.

When you want to specify what a character must not be, precede the list of characters 
with a ^ as in [^ab], [^m-t] or [^2-8]. 

One or more of a particular character. follow the character with    +, * or ? as follows:
+ One or more of the preceding character
* Zero or more of the preceding character
? Either zero or one of the preceding character

For example; to specify one or more spaces or tabs, you write [ \t]+

Two or more' and similar expressions. Use characters marked with the above symbols in
combination with further copies of the same character. For example to specify a one- or 
two-digit number, use \d\d? . The ? specifiesthat there should be either one or none of 
the character that precedes it.

A number of alternatives. For example, either tom or dick or harry@turnpike.com. 
Write the patterns for the different options one after another with | characters between 
them. Then put them in parentheses to group them. The example would be expressed as 
(tom|dick|harry)@turnpike\.com.

Repeated alternatives. Where you want to repeat alternatives in a expression use \n 
where n is the number of the grouping. For example, if (tom|dick|harry) was the second
grouping in a regular expression, you could specify that you wanted the same one of 
tom, dick or harry later in the pattern by putting \2 at the relevant point in the regular 
expression.

Matched section at the start or the end of the header line For a match from the 
beginning the section, start your regular expression with a ^. If the section that's being 
searched needs to finish after the last character picked out by the pattern, finish your 
regular expression with a $. For example, ^Lines    will pick out a header line that starts 
Lines, while \.com$ will pick out a header line that finishes .com. 

· Combined rules.
rule1 AND rule2 must be true. /expression1/modifier1 & /expression2/modifier2
rule1 OR rule2 must be true, /expression1/modifier1 | /expression2/modifier2
Not this rule',  !/expression/modifier

Use &, | and parentheses for grouping, to set up criteria such as:    
/expression1/modifier1 & !/expression2/modifer2 
ie. rule1 but not rule2

Related Topics 
Email routeing to seats & news dialog



Distributing Mail to Mailboxes dialog.
Mailing List Routeing Rule dialog..
News Article Kill Rule dialog

Custom Mail rules
Custom Mailing List rules.

News Article Custom Kill rules 
Clearing out unwanted articles

Custom rules: Formal syntax.



Deleting sections of text

To delete a section of text from the message you are preparing, highlight this text then either

Press Del to delete it, or
Simply type whatever you want to replace it by, or
Select Cut from the Edit menu (or press Ctrl + X) to move it to the Windows clipboard.

The advantage of the last method is that you can readily recover the text or move it to some other part of 
your message, up to such time as you use the Copy and Cut options to copy or move other text to this 
clipboard.



Deleting unwanted mail

Most people prefer to file or archive the mail they want to keep so that it can be retrieved in the future if 
needed.

However, if your mail includes any items that you really don't want to keep, you can throw these away 

either by selecting them, then clicking the Delete Message button on the toolbar
or by dragging them to your Waste basket.

Items you delete are only actually removed when you leave Turnpike or if Empty the Waste basket. 
Any items in the Waste basket that are 'mirrored' from a POP mailbox are only deleted when you next 
pick up mail from this mailbox. 
Up to that point, you can recover any items you have thrown away by accident by displaying the contents 
of the Waste basket and then dragging the item to the appropriate mailbox.

Related Topics
Archiving mail



    
Digests
A news article or an item from a mailing list can be made up of a series of 'Digest messages'. 

This format is most frequently used for FAQs and other such articles which cover a number of 
separate points.

When you open such an article, Turnpike presents the Digest messages as separate sections, 
each with its own toolbar. These toolbars include 'Next' and 'Previous' buttons to give you a 
quick route from enclosure to enclosure. You can also use Ctrl G to step to the next section.. 

Hide and View buttons enable you to open and close Digest messages as you require.

    There's currently no automatic facility for generating digests within Turnpike.



Discussion threads

Many of the articles that appear in a newsgroup have been contributed in response to articles that were 
previously contributed to that newsgroup. These articles themselves generate responses from other 
readers and so on.

Taken together, the original article plus all the different 'Follow-up' articles posted in response represent a 
discussion on the topic of the original article.

There's a convention whereby any 'Follow-up' article includes the details of the article to which it is a reply
in a 'References' line in its header - plus, where appropriate, the details of the article to which that was a 
reply and so on. Where this convention has been correctly followed (and this is something that Turnpike 
automatically ensures when you tell it you want to post a Follow-up article), it is possible to follow the 
'thread' of the discussion from the one that started the discussion through all the different replies.

Following a thread in this way enables you to make sense of all the different contributions that have been 
made on the topic. So before you go into a newsgroup, Turnpike automatically looks at the headers of all 
the articles that have been contributed to that newsgroup and works out all the different discussion 
threads they represent so that you can follow any discussion thread that you wish. It also provides special
'Next' and 'Previous' options by which you can work either up or down through the different articles that 
have been contributed.

As you might imagine, very few discussions comprise a simple sequence of one article replied to by 
another which is in turn replied to the next. Usually a number of people reply to any individual article and 
their articles are themselves replied to by one or more people. As a result, the overall discussion becomes
more like a tree, with each branch of the tree follows one thread of the overall discussion. This is reflected
both in the way Turnpike shows the sequence of articles and in the options you select when you want to 
see the articles that make up the different discussions listed for any group - Expand tree and Expand all 
trees (with corresponding Collapse tree and Collapse all trees options when you no longer want to see 
the discussions in such detail).

In general the links in the tree are shown as solid lines, but where there wasn't a specific References line,
the connection to the previous article is more tentative and so is shown as a broken line.

Related Topics
Break Thread.



Displaying the header

At the top of each message or article you receive is a message header. The header includes 
the message's ID number, the route the message took, whom the message is from and when
it was sent.

Turnpike normally just shows the author, the subject and the date. Turnpike also shows if the 
message / article has been copied to other people or cross-posted to other newsgroups or if 
there are special reply-to / follow-up instructions.

To display the full header at the start of a message 

Click Options in the menu, then click the Display Header option.

Click the Display Header option again to turn off the display.

If you opt to display the header on one message and then step on to another message using
either 'Next unread', 'Next/Previous in group' or the 'Search' procedure, then the header of 
the new message will also be shown. 

If you close the current message then open another, the display will revert to the standard 
'header-free' form.



'Distributing mail to mailboxes' dialog

This dialog is displayed when you click on the Add or Alter option buttons on the Rules 
page of the Mailbox dialog. 

The dialog enables you to set up the rules that determine the type of mail to be sent to a 
mailbox 

Each use of this dialog sets one rule.

· To set up mailbox sort properties

In the top part of the dialog select if you want the mailbox Either to Accept or Reject 
mail by the following properties.

Mail with the property
· Addressed to enter the    email name to who the mail was addressed
· Sent from user enter email address of the person who sent the mail
· Subject line matching enter the subject of the mail for this mailbox
· Custom rule. see Defining custom rules.

For each entry you can use wildcards for partial matching.

Related Topics 
Alter mailbox dialog
Defining custom rules.



Distribution list 

A distribution list is a list of the email addresses of the people who should receive copies of particular mail
messages. Turnpike enables you to give each distribution list a name and to store this name in your 
Address book. When you select a list name all persons in your list will receive a copy of the message.

To add/alter a distribution list 
1. Select the entry , in the address list.
2. Click the View/Alter button or New List button
3. An empty Address book entry (List) dialog is displayed.
4. Enter a name for the list 
5. Complete the entries then click the Ok button. 

Click the down arrow to see a list of names in the To: cc: and bcc fields. Use the + and - buttons to add 
and remove additional addresses 

For details of each entry see Address book entry - List dialog 

Related Topics
Address book - Overview 
Address book entry - List dialog 
Address book - External Format 



Domains and Hostnames

In the email address: Ron.D@hq.msfc.nasa.gov the hq.msfc.nasa.gov part is the 
hostname. 

Hostnames are based on Internet Protocol (IP) addresses. Each hostname identifies a 
particular machine (server) on the Internet. Each server connected to the Internet also has a
numerical IP address. The IP address comprises four sets of numbers connected with dots. 
For example the IP address for the mail server at the University of Alabama is 
130.160.4.100. 

Because names are easier to remember than numbers, the planners of the Internet's mail 
transport protocols (standards) created the hostname system. The part of an Internet 
address to the right of the @ is often referred to the domain for the address. Everything to 
the right of the @ is more properly referred to as the hostname. 

The hostname is paired with a specific IP address. The domain refers to an entire physical 
location, or site, where the connection, or (Point-of-Presence (POP), with the Internet occurs 
for example Turnpike.com. 

Some domains don't use registered hostnames; you have to address e-mail to them by 
their IP numbers. Fortunately, the use of hostname addressing predominates.

Domain types are typically, the organisation and the nation where the domain is located. 
Some examples are; 

.GOV US Government

.EDU Educational sites

.COM Commercial sites

.ORG Organisations that don't fit into other categories

.UK United Kingdom

Domain names are registered with the with the InterNIC 

Generally if the address does not end with a registered abbreviation such as those listed 
above, it is NOT an Internet e-mail address. However you may still be able to send mail to 
non-Internet addresses through an e-mail gateway service such a Compuserve.

Related Topics
Email names
Email Address



Download options for news

The volume of articles contributed to newsgroups is such that copying to your diske may take 
considerable time. The time taken will affect your phone bill, what you copy affects disk space. Much of 
what you download may include articles on topics that you may not be interested in.

To help you make best use of your disk space and minimise your phone bill, Turnpike offers the choice for
each newsgroup of:

Downloading the articles in full
Or just 'Browsing' the group - just copying the header of each article.

You are also able to set Turnpike set of Kill rules which will filter newsgroups as you wish. If an article 
is excluded by any of these Kill rules, just its header will be downloaded.

If you expect to find the majority of articles interesting, you should obviously download the newsgroup in 
full, but if the group discusses topics which are only of marginal interest, it is better to browse the group. 
Then Turnpike will just download the headers of articles contributed to the group. If you spot a subject tha 
seems interesting, you can request it to be downloaded the next time you go on-line to the Internet (see 
Requesting missing articles). Also, you can specify kill rules to accept automatically certain types of 
articles in full, even though only the headers of other messages are downloaded.

It is possible for articles to appear in full in newsgroups that you have set to browse and for just the 
headers of articles to appear in a newsgroup that you read in full. Click on the relevant topic for an 
explanation.



Downloaded email not found
Turnpike takes special care to ensure that email is filed safely after being downloaded. If you see an 
email message reported as downloaded by Connect, but you cannot find it in any of the mailboxes on 
your system, check the following points:

A long email (e.g. containing a picture) that has been sent to you in separate parts will, whenever 
possible, be reassembled into a single email by Turnpike once the final part has arrived. So, for 
example, 8 messages seen arriving in Connect could collapse into a single email in your In tray.

If a mailing list to which you are subscribed has been setup as a newsgroup, you will see messages 
arriving as email in Connect but being counted as news in Turnpike. If duplicate messages are sent to
you in person as well as to the mailing list, Turnpike may recognise the duplication and send the 
spare email to the Waste basket (where it can be inspected) rather than to a mailbox.



Dragging
Dragging is a standard Windows technique. To drag an item, move the mouse pointer to the object 
concerned, hold down the left mouse button and then move the pointer to the part of the screen to which 
you want to take the item.



Edit Email Tags dialog

This dialog is used to add to or modify the range of tags you can use on your system. It is 
called by selecting Configure from the File menu and then selecting Email tags. The main
part of the dialog lists the tags currently available.
· To add a tag to the list

1. Click the New tag button to display the Make New tag dialog
2. Enter the name of the tag

If you are the sole user of your system, you just need to set the name of the tag. On a
shared (multi-user) system, you also need to set the Type of Tag. 

3. Select either 
Private tags For personal use
Group tags For use by a workgroup
Public tags For general use

4. To enable you to allow other users or workgroups access to mail marked with a 
particular tag. Click the Access button to display the Alter usage dialog.

For further details refer to Access to mail .
· To edit a tag

1. Select the tag
2. Click the Edit button to display the Edit tag dialog
3. You are able to edit the name and change the Type required
4. Click the Access button if you want to change the usage

· To remove a tag you no longer require
1. Select the tag
2. Click the Remove button
3. Click Yes to confirm or No to return to the dialog

Related Topics
Tagging Messages
Tag Selection dialog
Access to mail  



Edit Menu    Extract URL
Enables you to see a list of all URLs in a message or news article, and to select a URL or part
of the message and then use Extract URL 

Related Topics 
Edit menu
Offline browsing 
Save URL    



'Edit Sign-on Details' dialog

The Configure users sign on details dialog is called by selecting Configure from the File menu, and 
then selecting Users.

The Edit sign on details dialog is called by clicking either the Create or the Edit button on the 
Configure users sign on details dialog. 

The Edit sign on details dialog enables you to set or change the details of any user 
currently allocated a seat on your system.

· Non-administrator Version

Sign on name. Any name e.g. Alice.
Full name. The users full name e.g. Alice Liddell.
Password. Any word. The current password (including no password) is shown as a 

sequence of asterisks. To enter a new password overtype the current 
one

Disable the sign-on dialog
When a user password is set a sign-on dialog will always appear when you run Turnpike 
or Connect. The dialog requires that you enter your sign-on name and your password 
before you will be allowed into the program.
This option should always be unchecked when more than one person uses the same 
system to ensure that users can sign as a named and hence see their own personal 
mailboxes and newsstands.
If you are a single user and do not use a password, check the Disable the sign-on 
dialog option to prevent the sign-on dialog from appearing.

Last use The date and time that this user last signed on.
Seat # The allocated number of the seat for this user. 

 Which seat someone occupies makes no difference to the actions they can take.

Use default ratings. Shows whether which newsgroups this user sees is governed by 
the default set of ratings or a special set.

Ratings Click this button to show the details of the ratings applied to this user - and, if 
you have Ratings Admin permission, to change these.

· Administrator Version.
For the user with Administrator permission the following additional text boxes are 
shown,

Also Email name. When selected, the user sign-on name is used as one of their 
email names.

Notes.    Any additional information about the user e.g. which department they
work in.

· Permissions
At the bottom of the Edit sign on details dialog are 16 option boxes. Check as locally 



specified to give this user the necessary administrative permissions.

The administrator has all permissions by default.For other users the above permissions set 
for each user, override any permissions which may be set in the Edit workgroup details 
dialog 

Related Topics
Remove users from a shared system
Adding new users
Edit details of a current user
Enable the Edit sign-on details dialog



'Edit Workgroup Details' dialog

This dialog enables you to set the name and the membership of a workgroup. 

It is called up by clicking either the Create button or the Edit button within the Administer 
workgroups dialog. 

Related Topics. 
Workgroups 



Edit menu

Undo
Redo

Cut
Copy
Paste
Select All
Delete
Find
Replace
ROT-13
Extract URL
For general information about editing messages, see Preparing News/Mail.



Edit menu: Copy
Copy simply copies the currently selected text to the Windows clipboard. It works with Cut and Paste to 
provide the actions needed for 'Cut & Paste' editing - that is, copying or moving sections of text either 
from one place to another within a message or between one message and another.

Quick keystroke: Ctrl + C

Related Topics 
Edit menu
'Cut & Paste' editing 



Edit menu: Cut
Cut deletes the currently selected text, leaving a copy of it on the Windows clipboard. It works with Copy 
and Paste to provide the actions needed for 'Cut & Paste' editing - that is, copying or moving sections of 
text either from one place to another within a message or between one message and another.

Quick keystroke: Ctrl + X

Related Topics 
Edit menu



Edit menu: Delete
Deletes the currently selected text.

Quick keystroke: Del

Related Topics 
Edit menu



Edit menu: Find
Lets you move directly to a specific word or phrase within the message you are working on. 

Quick keystroke: Ctrl + F

Related Topics 
Edit menu
Find and Replace.



Edit menu: Paste
Paste inserts the current contents of the Windows clipboard at the position of the cursor. It works with Cut
and Copy to provide the actions needed for 'Cut & Paste' editing - that is, copying or moving sections of 
text either from one place to another within your messages or between one message and another.

Quick keystroke: Ctrl + V

Related Topics 
Edit menu



Edit menu: ROT-13
Applies ROT-13 encoding to the selected text. This advances each letter by 13 (replacing a by n, b by o 
etc.).

A second application of ROT-13 encoding decodes encoded text.

Related Topics 
Edit menu
Encoding messages



Edit menu: Redo
Redoes the 'Undo' you've just made.

Repeated use of Redo will work backwards through any sequence of 'Undo's you've made.

Quick keystroke: Ctrl + A

Related Topics 
Edit menu



Edit menu: Replace
Enables you to replace instances of a particular word or phrase with another throughout the message you
are currently working on. 

Related Topics 
Edit menu



Edit menu: Select all
Selects the whole text of the message/article you are currently working on.

Related Topics 
Edit menu



Edit menu: Undo
Undoes your last editing action (typing, deleting etc.).

Repeated use of Undo will work backwards through all the different edits you've made.

Quick keystroke: Ctrl + Z

Related Topics 
Edit menu



Preparing News/Mail

Introduction

How to ... Start preparing a mail message

Start preparing a news article

Move sections of text around

Delete sections of text

Replace words and phrases

Undo/Redo changes

Show/Set margins and tabs

Use a different signature

Save your current signature

Make changes to the message header

Print the message you've prepared

Preview before printing

Include a file stored on disk

Include a copy of a message you've received

Encode your message

Buttons & menus: Buttons
File
Edit
Signature
Options
Window
Help



Editor toolbar

Look up address (Mail messages)
Lets you pull in any email addresses you need from your Address book. See Select an address    

Address book (News articles)
Calls up your Address book.

Post
Sends your message to the recipient(s) you have specified.

Abandon
Sends your message to the Waste basket. It will be lost when you exit Turnpike.

Insert file
Lets you insert a file into the mail message or news article that you are preparing. See Including files.

Change signature
Lets you replace the current signature by one of the other signatures you have stored on disk. See 
Signatures.

Start new email
Sets up a new email message for you to send. Click here for information on Sending mail.

Edit mail/news header
Displays a dialog through which you can set aspects of the Header of the message. See Mail Header 
dialog or News Header dialog, or press F1 to call up Help when you are using these dialogs.

Newsgroup selection (News articles)
(Disabled in this version)



Editor: Undo/Redo changes
To undo the last change you made to the message you are preparing, go to the Edit menu and take the 
Undo option (or press Ctrl + Z). To undo the change you made before that, just repeat this process - and 
so on through all the changes you've made.

To redo the undo you've just made, take the Redo option immediately below the Undo option (or press 
Ctrl + A). Taking this option many times will reverse a sequence of 'undo's.



Email Names dialog
The main part of the dialog is a list of the email names. currently being used. This will usually be a mixture
of sign-on names, workgroup names and any additional email names. The names are listed on the left; 
the 'origin' of each name is shown to the right.

· To display this dialog 
1. Click on File in the toolbar
2. Select Configure
3. Select Email names from the submenu..

With Email name permission, 
· The Create button enables you set up further Email names.
· The Edit button enables you to change the details of additional Email names that have 

already been set up. This will be either the name itself or, on a shared system, the 
range of people who can use this name.

· The Remove button enables you to remove additional Email names
When editing an existing email name and creating a new email name the Usage of email 
name dialog' will appear. 

To remove edit or remove a sign-on name or a workgroup name select Configure 
Users or Configure Workgroups from the file menu.

Related Topics
Adding, Editing and Removing email names
Usage of email name dialog'



Email Routeing - Dead letter mail 

This dialog is called by selecting the Dead Letters tab on the Email routeing to seats & news dialog. 

The Email routeing to seats & news dialog is called up by clicking on File in the menu, selecting 
Configure option, selecting Email routeing 

You are only able to set Dead Letter routeing if have Email Admin permission.

Dead letter mail is email that has been addressed to an email name that doesn't appear in the list of email
names used on your system. The email name may have been mis-typed or the person the mail is address
to may have left the company.

Where there's just one user of Turnpike, all such mail automatically goes to that user. Where there are 
several users, Turnpike requires that at least one person is nominated to receive this mail.

Initially all dead letter mail is passed to the person who installed Turnpike; generally the system 
administrator. Subsequently anyone with Email Admin permission can change the responsibility for dead 
letter mail to another user.

· To set up dead letter mail
1. Select to apply this to a Workgroup or an individual

The dialog lists available names in the left hand box and Dead letter recipients in the right hand 
box.

· Delete a dead letter recipient. 
2. Select a name and then click the Del button

· Add a dead letter recipient
3. Select a name in the left hand box and then click the Add button

The person(s) nominated to receive dead letter mail automatically get an extra 'dead letter' option 
on the Rules page of their mailboxes. This allows them to specify which mailbox (or mailboxes) 
they want this mail put in.

If more than one is mailbox is specified as a 'dead letter' mailbox, the dead letters will be sorted 
among these mailboxes following the mailboxes' rules. Any mail    that isn't accepted by any 
particular mailbox will initially appear in all the 'dead letter' mailboxes.

If only one (the default) mailbox is used, the dead letters will go to that mailbox together with other 
mail

If more than one person is nominated to receive Dead letter mail, any such mail will initially appear 
in each person's 'dead letter' mailbox. When anyone processes it, it will disappear from everybody 
else's mailbox, just as with any other form of group mail.

Related Topics 
Mailing Lists - Overview
Email routeing to seats & news dialog

File Menu - Configure email routeing





Email Routeing - Envelope Rejection 

This dialog is called by selecting the Envelope Rejection tab on the Email routeing to seats & news 
dialog. The rules currently applied to the envelope are listed. Adjacent buttons enable you to Remove and
Alter existing rules and to Add new rules. Each use of this dialog sets one rule.

The Email routeing to seats & news dialog is called up by clicking on File in the menu, 
selecting Configure from the drop down menu and then, selecting Email routeing 

You are only able to set Envelope Rejection rules if have Email Admin permission.

If mail arrives by SMTP the envelope will comprise the Forward Path and the Reverse 
Path. The rule listed will be applied before the message is downloaded and therefore no 
charge applies.

If the message is collected by POP3 there is no envelope, Turnpike will download the 
header and create a simulated envelope. Rules are first applied to the envelope. For any 
messages not rejected by these rules, the header is subject to the Mail Rejection Rules. 
Finally the message is subject to Mail Rejection Rules.

· Order in which rules are applied
Rules are applied in the order listed. Select a rule and then click the Up or Down button to change the
order 

· To remove a rule, 
Select the rule then click the Remove button

· Action for other mail not accepted or rejected by the rules above 
Select either to Accept it, Reject it, or Reject unrecognized email names. This will be applied to 
name in the forward path i.e. who the message is sent to.

· To Add and Alter Rules
1. Click the Add or Alter button to display the Mail rejection by examining the envelope dialog
2. Select either to Accept or Reject mail for the rules which follow.
3. In the Mail with property area select one of the following options 

Reverse path. The reverse path is called the return path in the header of the email message. 
Enter here the address that errors are sent to. This will usually be who the mail is from (except for 
SPAM). Wildcards. may be used.
Addressed to. Click the down arrow and select a name or enter a new name, this is the email 
name from the forward path.
Custom Rule. Enter the rule you want applied to the envelope. Use /t for forward path and /f for 
reverse path. 

4. Click Ok to apply the rule or Cancel

Related Topics 
Mailing Lists - Overview
Email routeing to seats & news dialog

File Menu - Configure email routeing
Defining Custom rules





Email Routeing - Mail Rejection

This dialog is called by selecting the Mail Rejection tab on the Email routeing to seats &
news dialog. This dialog lists the Mail rejection rules applied to the message header and/or 
body.    Adjacent buttons enable you to Remove and Alter existing rules and to Add new 
rules. Each use of this dialog sets one rule.

You are only able to set Mail Rejection rules if you have Email Admin permission.

If mail arrives by SMTP, the entire message will be downloaded before the rules listed are applied. Use 
the ‘envelope rule’ for maximum efficiency.

If the message is collected by POP3, the rules will be applied to the downloaded header. If necessary, the
entire message will then be downloaded and the rules applied again. 

The rules are not applied to messages that have already been rejected by the envelope rules, which are 
always applied first.

· Order in which rules are applied
Rules are applied in the order listed. Select a rule and then click the Up or Down button to change 
the order

· To remove a rule, 
Select the rule then click the Remove button

· To Add and Alter Rules
1. Click the Add or Alter button to display the Mail Rejection, after receiving message dialog, 
2. Select either to Accept or Reject mail for the rules which follow.
3. In the Mail with property area select one of the following options.

· Sent from user. The email address of the person who sent the mail. Wild cards may be used.
· Subject line matching.    Any text fragment included in the Subject line of the message. If the 

first character is not a wildcard, only the first word of the subject line will be used. 
· Body text matching Any text fragment included in the body of the message 

There is an implicit wild card at the beginning of the subject line. This will match a word or phrase 
anywhere in a subject line or the body text. The characters ? and * are interpreted as wildcards for partial 
matching - they cannot be used literally. See Wild cards for details and examples of partial matching.

· Larger than        Enter message size in bytes.
· Custom rule. Custom rules generally take the form:    / pattern    / modifier where the 

modifier (generally) specifies the part of the header that should be searched. 

Custom rules are powerful, but may be difficult to construct. You are advised to use a custom rule 
only when you are sure a simple rule will not meet your requirement

4.    Click Ok to apply the rule or Cancel

Related Topics 
Mailing Lists - Overview
Email routeing to seats & news dialog



File Menu - Configure email routeing
Defining Custom rules



Email Routeing - Mailing lists

This dialog is called by selecting the Mailing List tab on the Email routeing to seats & news dialog. The
rules currently applied to this Mailing List are listed. Adjacent buttons enable you to Remove and Alter 
existing rules and to Add mailing lists. 

The Email routeing to seats & news dialog is called up by clicking on File in the menu, 
selecting Configure from the drop down menu and then selecting Email routeing 

You are only able to set Mailing List rules if you have List Subscribe or Email 
Admin permission.
· To remove a Mailing List, 

Select the rule then click the Remove button

· To Add and Alter a Mailing List
1. Click the Add or Alter button, to display the Mail List Detail dialog. 
2. Enter details as follows

Listname The name of the list you want to the mailing list newsgroup to subscribe to
or to amend the current name

Type of List Select listserv if the word listserv in the control address

Select Majordomo if the word majordomo in the address.
Select other when neither of the above apply. 

List Control Address. When you have entered a listname and type of list an address
will appear. Confirm this is correct and make any changes required 

· Special Rules
You may need to set special rules to determine how messages from the mailing lists 
are identified.
a) Select the Special routeing rules option 
b) Click the Alter button to display the 'Mailing list routeing rule' dialog 
c) Enter the rules you want applied mailing list headers.

Turnpike automatically fills in the Custom slot with the most likely form of rule you'll 
need. If you find that this rule doesn't give the required results.

· If this is a new mailing list
3. Click the Send email button to send the relevant subscription message.
4. Click the Post button. The Mailing List details dialog will close.
5. Turnpike will generate the appropriate subscription message for you. The message 

will appear when you leave the email routeing to seats & news dialog 
6. Check that the message has the form required by the mailing list

The new list will now be listed on the Mailing List page of the 'email routeing to seats 
& news dialog. Mail from the mailing list will start to be added to the mailing list 
newsgroup from the next time that you collect mail. 

7. Click OK to apply.



If mail is put into one of your mailboxes instead of a newsgroup, check the details set in 
the Mailing list details dialog, Check any rules you have set in Custom Mailing List Rules.

If the mailing list sends a duplicate of a message already in your mailing list newsgroup,
the duplicate will be sent to the wastepaper basket.

If you have already received any mail from this mailing list, to add it to the mailing list 
newsgroup,    export it, then re-import it as mail. See Converting a mailing list to a 
newsgroup.

Mailing lists are identified with a ! at the start of its name otherwise it is treated just 
like any newsgroup. 

Messages will initially be set to be expired after 3 days. To change the expiry time see 
Newsgroup Subscriptions dialog.

· To read the messages that arrive from this mailing list, 
Add the mailing list newsgroup to one of your newsstands 

Related Topics 
Mailing Lists - Overview

File Menu - Configure email routeing
Defining Custom rules



Email Routeing - Seat Routeing

This dialog is called by selecting the Seat Routeing tab on the Email routeing to seats & news dialog. 
The special seat routeing rules currently applied will be listed. Adjacent buttons enable you to Remove 
and Alter existing rules and to Add further rules. 

The Email routeing to seats & news dialog is called up by clicking on File in the menu, 
selecting Configure option, selecting Email routeing 

You are only able to set Seating rules if you have Email Admin permission.

You cannot reject mail with these rules. Use Envelope or Mail Rejection Rules 
Mail addressed to particular users, workgroups or email names is routed 

automatically. Only use this dialog if you want to override this routeing.
· Order in which rules are applied

Rules are applied in the order listed. Select a rule and then click the Up or Down button to change 
the order 

· To remove a rule, 
Select the rule then click the Remove button

· To Add and Alter Rules
1. Click the Add or Alter button on the Seat Routeing dialog to display the 

Distributing mail to seats dialog.
2. Enter the Seats affected.
3. Select either to Accept  or Reject mail for the rules which follow.
4. In the Mail with property area select one of the following options.

· Addressed to The email name of the person to who the mail is addressed. 
· Sent from user.    The email address of the person who sent the mail. Wild cards may be 

used. 
· Subject line matching.    Any text fragment included in the Subject line of the message. If 

the first character is not a wildcard, only the first word of the subject line will be used. 

There is an implicit wild card at the beginning of the subject line. This will match a word or phrase 
anywhere in a subject line or the body text. The characters ? and * are interpreted as wildcards for partial 
matching - they cannot be used literally. See Wildcards. for details and examples of partial matching.

· Custom rule. Custom rules generally take the form:    / pattern    / modifier where the modifier
(generally) specifies the part of the header that should be searched. 

Custom rules are powerful, but may be difficult to construct. You are advised to use a custom rule only 
when you are sure a simple rule will not meet your requirement.

5.    Click Ok to apply the rule or Cancel

Related Topics 
Mailing Lists - Overview

File Menu - Configure email routeing
Defining Custom rules





Email address

Every Internet address has three parts: a user name, an @ sign and a hostname, for 
example;    name@biop.ox.ac.uk.

The user name is usually a recognisable word or persons name, but may be more complex 
if you use a service like MCIMail or Compuserve that have a gateway onto the Internet.

The Hostname will have two or more parts, separated by dots. 

Your main source of email addresses will be the messages sent to you. Turnpike maintains 
the Address Book for you. Another source of email addresses is by personal contacts such as
phone conversations, business cards and office stationery. There also are a number of email 
address directories on the Internet.

Ensure that you note their full email addresses not just the email address used on their 
local office network.

Take care when you copy and paste e-mail addresses into the To: line of a message. 
Ensure that there are no punctuation marks at the end of e-mail addresses. 

Use of the Address Book when you send mail will avoid errors particularly with long 
names.

Related Topics
Alternative Email Names
Adding Email Names.



Email deleted from the POP3 server
If you are collecting email by POP3 and choose the Mirror option, any email that you delete or file in 
Turnpike will be deleted from the server next time you connect to your Access provider. When you do this,
Connect may report a number of messages being deleted. This is not a cause for concern! The messages
are those you have dealt with (either by filing or by deleting on your own machine) and not new ones.

If you have Mailing Lists setup as newsgroups, you may be surprised to see a large number of messages 
being deleted from the server in this way. Such mail has never entered your Turnpike mailbox, so all 
these messages are being deleted from the server to ensure that it continues to be an accurate mirror of 
the contents of your Turnpike mailbox.



    

Email names
An email name is the word before the @ in an email address. The 
email name is used to identify the person or group of persons to 
whom the email message is being sent. Names can include digits 
and some punctuation marks but can't include spaces or commas. 
Names are usually written using only lower case letters - some 
systems require this.Each name on the system must be unique.

Some Internet Service Providers give users several email names 
and some, such as Demon, allow users to make up an unlimited 
number of names. For example, a Demon customer called Thomas
B Smith could use the names, tbsmith, tomsmith, tom, thomas 
etc.



Email routeing to seats & news dialog 

This dialog is called by clicking File in the menu, selecting Configure from the drop down menu, and then
selecting Email routeing.

The first two pages of the Email routeing to seats & news dialog enables you to set up 
rules for the acceptance or rejection of mail by examining the message envelope, or the 
message as a whole. The next page enables you to set up mailing lists as a newsgroups and 
to set routeing rules.The remaining two pages of this dialog enable you to set seat routeing 
rules and whom should recieve dead letter mail. 

The rules set on the five pages of this dialog are generally to enable you to avoid SPAM, 
UCE, UBE etc 

Do not use this facility to reject all mail from a mailing list you subscribe to. This is 
considered extremely bad manners. Use the unsubscribe facility instead. If you persistently 
reject mail from a mailing list, the list Administrator will remember you or your companies 
name and not allow you access in future. 

To set up a mailing list newgroup and set associated rules you will require List 
Subscribe permission. To see and apply rules to other pages of this dialog you will require 
Email Admin permission.

The Email routeing to seats & news dialog has five tabbed pages

The first two pages apply rules as follows

Envelope Rejection. If mail arrives by SMTP the envelope will comprise the Forward Path and the 
Reverse Path. Any rule listed will be applied before the message is downloaded and therefore no charge
will be applied. If the mail is rejected a message will be returned to the sender 

If the message is collected by POP3 there is no envelope, Turnpike will download the 
message and create a simulated envelope. Rules are first applied to the envelope. For any 
messages that not rejected by these rules the header will be subject to the Mail Rejection 
Rules. Finally the message will be subject to Mail Rejection Rules. If the mail is rejected 
no message will be returned to the sender.

Mail Rejection. Rules are applied to the complete message

The following three pages apply the following routeing functions

Mailings lists. the mailing lists currently treated as news .Mail routeing rules can be 
applied. An Add button enables you to add further mailing lists. Alter and Remove 
buttons enable you to change the details of a mailing list or to remove a mailing list.

Seat Routeing. Rules to set which seats are to receive the mail.

Dead Letters. Whom is to receive mail not addressed to anyone else

Related Topics 
Mailing Lists - Overview



File Menu - Configure email routeing
Defining Custom rules



Enabling the sign-on dialog

If you are the sole user of Turnpike, there is no doubt which set of mailboxes and 
newsstands need to be displayed and therefore there is no need for you to sign on. However 
you will need to enable this dialog if you want to set a password to protect your files against 
anyone else reading them.

When you log in to a shared system, you will need to be able to tell Turnpike who you are, so
that the correct set of mailboxes and newsstands are displayed.

To display the Edit sign-on details dialog it must be enabled for each user of the system. If
this dialog isn't enabled, anyone who runs Turnpike on your machine will sign-on as you 
and use your files 

· Enable the Sign-on dialog
1. From the Turnpike menu click File
2. Select Configure
3. Select Users - the Configure user sign on names dialog appears.

· You have Alter Users permission
1. Pick out your name from the list of users
2. Click the Edit button -    the Edit sign-on details dialog appears. 
3. In this dialog check the Enable sign-on option.

· You don’t have Alter Users permission
The Edit sign-on details dialog appears showing just your name. In this dialog check the 
Enable sign-on option.

· If you go to someone else’s system, and do not get an opportunity to 
sign on as yourself.
1. Call up the Edit sign-on dialog as described above 
2. Select the Enable sign-on option
3. Exit from Turnpike. 
4. Reload Turnpike - the sign-on dialog will appear allowing you to sign-on as yourself. 
5. If the current user has Alter Users permission, it wont be necessarily obvious which 

user you have signed on as. Refer to the Last use dates shown in the Configure 
Users dialog. Pick the user with the most recent Last use date.

Related Topics
The Edit sign-on details dialog
Remove users from a shared system
Adding new users
Edit details of a current user



Encoding messages

There are two main types of material that may be encoded for inclusion in messages sent over the 
Internet

Binary information that has to be encoded to enable it to be transmitted over the network.
Plain text that is encoded to hide it from prying eyes.

Turnpike takes care of the encoding needed for binary information by automatically encoding any non-text
files that you insert into a message: see Including files stored on disk.

If you want to hide your messages from prying eyes, you will normally need to acquire special software to 
do this. But if you're simply interested in hiding them from casual observers, you could use the ROT-13 
encoding provided within Turnpike. This is the encoding used in some of the more humorous newsgroups 
to hide material of dubious taste from people who might be offended by it. It simply advances each letter 
by 13 through the alphabet (a to n, b to o etc.) which is enough to convert a message into gobbledygook. 
It is also very simple to decode: all you have to do is apply the encoding again. This advances each letter 
another 13 (n to a, o to b etc.) which takes it back to its original position - thus decoding it.

To apply ROT-13 encoding to part or all of a message, simply select the text and then take the ROT-13 
option from the Edit menu.

See also help on Decoding messages in news articles and mail messages.



Envelope 
The Forward and Reverse path of an email 
message.



Expanding your Turnpike system
A key feature of Turnpike is its ability to expand as your own requirements and the needs of your family or
business grow.

To add an extra mailbox to use with an existing email name, go to the File menu and select New... 
Mailbox. The Wizard will guide you through the process, offering to route mail to the mailbox on the basis
of who it is from, its subject, or other criteria. Using this method, you could set up mailboxes to handle 
your mail from a relative, a business contact, a mailing list, or whatever else you choose. Each mailbox 
can be given its own signature, tags and other properties.

If you want to find out how to add extra email names click here. You could add extra email names for 
yourself to use for different purposes (joebloggs@widgets.com, jb@widgets.com, sale@widgets.com, 
etc.) or for members of your family or business. Once you have added the names you want you should 
set up one or more mailboxes for each new name.

However, if you have several people in your family or business who use Turnpike, you may find it better to
configure Turnpike for multiple users. Each can then log into the program separately (which in turn 
means that you can keep separate records of their call costs in the Connect program), and each can have
a totally separate Turnpike desktop. We shall take a closer look at this in the final part of the tutorial.
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Expanding/Collapsing trees

The discussions that are currently going on within a newsgroup can be shown in two ways:

As a list of subjects with columns for the number of articles in this discussion and the number of 
unread articles, or
As a list of individual articles presented in a tree-like structure that shows how the articles follow on 
from each other.

The first form of display makes it easy to pick out the discussions you are interested in; the second lets 
you see the details of the articles. So when you go into a newsgroup, you first see a list of discussion 
titles - the idea being that you then select the ones you want to see in more detail and 'Expand' these, 
then 'Collapse' them back down to just the discussion title when you've finished with them.

The options used to Expand and Collapse discussions are in the Article menu. These let you Expand 
and Collapse either individual discussions or all the discussions in the newsgroup. Alternatively you can 
switch between Expanded and Collapsed by double-clicking on the thread's 'Total articles' box (the one in 
the second column of the display).

Related Topics 
Article Menu



Expiring News

The process of 'Expiring News' deletes news articles that have been on your disk for longer than their 
prescribed 'Expiry time'.

News is expired from the Turnpike Connect program. This normally happens as soon as Connect is 
launched, though it is possible to expire News at other times if you prefer.

For further information, see either the Connect book or run Turnpike Connect and call up its own Help file.



Expiry

News articles are normally only kept for a limited time, after which they are erased from the newsbase. 
The date on which an article is due to be erased is known as its Expiry Date, while the process of erasing 
articles which have passed their Expiry Date is known as 'Expiring the News'.

The time articles stay on your disk is principally set as part of the newsgroup subscription details. The 
default is for articles to remain on your disk for three days, but you can set a different expiry time for any 
of the newsgroups you subscribe to in the Newsgroup Subscriptions dialog.

However there are two reasons why an article may remain on your disk longer than the expiry time set for
the newsgroup:

The first is that the article has been marked to be kept - either by taking the Keep article option from the 
Article menu or through the Auto Keep option being set among the newsgroup subscription details. (To 
see whether this latter option has been set, take the Configure... Newsgroups option from the File menu
(assuming you have the appropriate permission to do this), select the group in the list of subscribed 
newsgroups then look at the details shown for this newsgroup in the lower part of the dialog.)

To remove Keep markers, select the articles - either individually or in groups (using Shift-click and Ctrl-
click) - and take the Cancel keep option from the Article menu (again assuming you have the appropriate 
permission). Simply turning off the Auto Keep option doesn't remove the Keep marker from articles that 
have already been downloaded.

The other possibility is that the article has an explicit expiry time set in its header. (This option is intended 
for use in FAQs which are useful to keep on your disk, but it is occasionally used vexatiously.) The way to 
get rid of such an article is to kill it.

Related Topics
Newsgroup Subscriptions dialog
Expiring the News



Exporting mail messages

Exporting either individual mail messages or the whole of your mailbase saves these messages in a text 
file in Berkeley Unix Mailbox format. 

For Soup users, this is equivalent to 'm' format of .MSG file but with CRLF line endings rather than LF line
endings - ie. you'll be able to work with the files from Soup after replacing all the CRLF line endings by 
LFs.

In this form, the messages can be read using a standard text editor or word processor. They may also be 
able to be read by other Mail reader programs, or re-imported into Turnpike. It can therefore be used as a 
way of archiving 'old' messages outside of the Turnpike mailbase.

·  To export messages. 
1. Calling up a Mail list containing the messages you want to export
2. Select the messages you want to export
3. Select the Export option from the File menu. 
4. Set where you want the exported messages to be stored in the File Selector which is displayed. 

The messages you export remain in your mailbase. Separate action is needed to delete them

Related Topics 
Importing mail and news
Archiving 'old' messages
Deleting messages



Exporting news articles

Exporting either individual news articles or the whole of your newsbase saves these articles in a text file in
the 'Batch format' defined in RFC 1036. (For Soup users, this is equivalent to 'u' format of .MSG file but 
with CRLF line endings rather than LF line endings - ie. you'll be able to work with the files from Soup 
after replacing all the CRLF line endings by LFs.)

In this form, the articles can be read using a standard text editor or word processor. They may also be 
able to be read by other News reader programs, or re-imported into Turnpike if required. (It can therefore 
be used as a way of 'archiving' articles of particular interest.)

To export articles, you just need to go into the newsstand containing the article(s) you want to export, 
select these articles and take the Export option from the File menu. Turnpike then displays a File 
Selector through which you set where you want the exported articles to be stored.



Address Book External format - Distribution list example

List name Stamp collectors 
Label SE England
use/hasMIME blank
index list Stamps

List

Entry in 'To' slot
Email address Penny Black <penny@rainbow.co.uk>
useMIME blank
cc/bcc blank

Entry in 'cc' slot
Email address julieb@firstday.co.uk
useMIME blank
cc/bcc cc

Entry in 'bcc' slot
Email address "A.N.Other" <nowhere@to.be.seen>
useMIME useMIME
cc/bcc bcc

Record 

CRLF are actual carriage returns:

CRLF
Stamp collectors, SE England, , "Stamps, List"CRLF
Penny Black <penny@rainbow.co.uk>CRLF
julieb@firstday.co.uk, ,ccCRLF
" " "A.N.Other" " <nowhere@to.be.seen>, useMIME, bccCRLF

Related Topics
Address book - Overview 
Address book - External Format
Distribution list



    
External bodies
Messages you receive may include horizontal bars that, instead of 
representing a file , are described as representing a link to an 'External 
body'.

The methods employed here includes details of how a file may be fetched 
over the Internet, rather than the file itself.

The horizontal bar will usually include a Fetch button which will arrange for 
the file to be collected by some suitable method. Alternatively, the details 
shown in the bar should give you enough information about the file for you 
to collect it yourself.
(see Extracting files from mail messages)



Address Book External format - person entry example

Name Harry Worthington
auto? No - so blank
Label Home
auto? No - so blank
fax (blank)
phone 01234 123456
land address 27 Cedar View

Overdare
Nice
NI45 8TX

email address Harry Worthington <harry@angel.co.uk>
use/hasMIME useMIME
index list Harry

Worthington
Angel

file-as list harry@angel.co.uk

Record,

CRLF are actual carriage returns.

Harry Worthington, , Home, , , 01234 123456, "27 Cedar ViewCRLF
OverdareCRLF
NiceCRLF
NI45 8TX",Harry Worthington <harry@angel.co.uk>, useMIME, "Harry, Worthington, Angel", 
"harry@angel.co.uk, useMIME, ,"CRLF



Related Topics
Address book - Overview 
Address book - External Format



Extracting files from messages

When files are included in a message and are in one of the standard forms that Turnpike recognises, they
are represented as a horizontal bar with an icon and one or more buttons. Under the buttons is a brief 
description of the type of item that is represented; there may also be a brief note of the type of application 
that produced the file. 

Forwarded messages, digest messages and references to external bodies are shown within similar 
horizontal bars.

Inspect or View button. When you click this button the file will open using the approriate application on 
your system. If an application is not recognized you will be able to choose one.

View, Custom Viewer, Inspect With some types of file, clicking these buttons you to see what aplication 
will be used to view the file or will be given the option to use a different application.

If the above buttons are not available or you just want to save the, click the Save button to save a copy of 
the file in its original format The File Selector dialog displayed enable you to specify where to save the 
file. You will then be able to work with this file using whichever of your application programs is suggested.

When you have saved the file, click the Remove attachment button to remove it from the Turnpike files

· If the file isn't recognised by Turnpike 
The message will include a note about the file and the Encoder that has been used to encode it. This 
will be followed by a sequence of unintelligible characters. If the file is large, this sequence of 
characters may be split over a number of separate messages. To access this file you will need to 
extract it from the message and save it to disk. The file will then be stored on your disk in its original 
format. You    from where you can process it using whichever of your applications seems appropriate.

· If the file is contained within a single mail message.
Select the message or open it, then take Decode from the File menu.    and use the File Selector 
this displays to pick out where you want to store the file.

· If the file is split over a number of messages (marked for example [1/6], [2/6], 
[3/6] etc.)
Select all of these messages as a group (using Shift click and Ctrl click), then click the Decode 
button.

The Decode option can also be used to extract files in bulk from a number of mail messages or news 
articles. Just select all the messages/articles containing files that you would like to extract, then click 
Decode from the File menu. Any uuencoded and Base64 encoded files within the selected messages 
will then be extracted from these messages and saved as individual files on your disk.

If you want to see the 'uuencoded' form of a file that Turnpike has parcelled up into a horizontal bar, 
call up the Options menu and select Display 'raw' text.



· In-line enclosures 
A MIME message may include 'In-line enclosures'. Forwarded messages are often handled as in-line 
enclosures. The item is given its own section within the message - complete with its own toolbar 
containing an appropriate range of buttons. For a forwarded message, the toolbar has buttons which 
enable you to reply etc. to the message that has been forwarded rather than to the message as a 
whole. The other main example of In-line items are Digest messages, the toolbar then includes 
among others Next and Previous buttons enabling you to step from one digest message to the next.

Related Topics 
Forwarded messages.



FAQs
FAQs are articles which are regularly re-posted to a newsgroup in order to provide answers 
to a range of Frequently Asked Questions (hence the name).

You are strongly recommended to read any FAQs included in a newsgroup before you post 
any article to that newsgroup, so that you can avoid being flamed by other users for wasting 
other people's time, disk space etc. etc. by asking a question which is answered in the FAQ.

When you first subscribe to a newsgroup, you won't necessarily pick up all the FAQs that are 
posted to that group immediately - just the ones that have been posted (or re-posted) to the 
newsgroup in the last few days. But over a couple of weeks you should build up a full 
collection, though you should continue to keep an eye out for updates.

Demon customers should note that many of the FAQs related to Demon are posted to the 
demon.answers newsgroup.



File Menu/ Configure/ Browsing
When you select this menu option the Offline Browsing Options dialog is displayed.

Related Topics 
File menu    - Configure 



'File Paths' dialog

The File Paths dialog is displayed by clicking the Paths button within the Sign-on. dialog.

This dialog lists the location of:

· Your personal Turnpike files (the Server path)
· The Mail received and sent from your machine (the Email path)
· The Usenet News copied to your system (the News path)

If you find that any of the above items have been moved, click the adjacent Browse button. 
Use the File Selector to pick out the new location for these files.

Start by selecting the Server path; the other two paths will then automatically change to match.

Related Topics. 
Setting where news and mail is stored
Sign-on dialog.



File Save dialogs

Several actions within Turnpike involve saving a file on disk.

Where appropriate, Turnpike offers a standard Windows File Save dialog for you to pick out where the file
should be stored. This dialog will be automatically set up to show what is being saved in its title and, 
where appropriate, the required filetype extension.

Use the right-hand file selector to set the appropriate directory, then type the required filename in the File 
Name slot.



    
File or path selectors
Several actions within Turnpike require you to pick out a file or a directory to
work with.

In each case, Turnpike offers a standard Windows File Selector dialog for 
you to select a file or path that is required. 

This dialog will be automatically set up to show what is needed in its title 
and, where appropriate, to select files with the required filetype extension. 
You also have the option of setting the list of files to All files if required.

Use the right-hand file selector to set the directory, then the left-hand file 
selector to select the specific file or path that's required.



File menu
New newsstand
New mailbox
New mail list

Alter newsstand
Alter mailbox

Print
Print Preview
Print Setup

Insert file

Decode
Export
Import

Mouse

Configure
Exit



File menu: Alter mailbox
Enables you to,.
· Add or change the categories of mail that are included in a mailbox
· Change the mailbox's name
· Change the standard signature etc. used in messages prepared from the mailbox
· Set the fonts and colours used when working in this mailbox

Just select the mailbox you want to alter, take this Alter mailbox option and make the changes you 
require through the Mailbox dialog that appears.

Related Topics 
File menu
Mailbox dialog.



File menu: Alter newsstand
Enables you to,.

· Change the newsstand's name
· Change the standard signature etc. used in articles and mail messages prepared from 

this newsstand
· Set the fonts and colours used when working in this newsstand

Just select the newsstand you want to alter, take this Alter newsstand option and make the changes you
require through the Newsstand dialog that appears.

To change the range or order of newsgroups in a newsstand, use the buttons at the bottom of the 
newsstand itself. (See Adding newsgroups)

Related Topics 
File menu
Newsstand dialog.



File menu: Configure
Calls up a submenu containing the following Configuration options:

Users
Workgroups
Email names
Email routeing
Newsgroups
Email Tags
Browsing
File menu

The options available to you depend on the range of permissions you have been given.

Related Topics
Configuring Turnpike: Introduction



File menu: Configure Email names

Allows you to set up additional Email names either for yourself or, on a shared system, for mail that is to 
be made available to a group of users, such as the members of a particular workgroup - provided you 
have the appropriate permission.

Greyed out if you don't have Email Names or Alter Names permission.

Related Topics 
File menu    - Configure 
Alternative email names 
Adding email names dialog 



File menu: Configure Email routeing

Calls up the Email routeing to seats & news dialog which enables you to,

· Set Envelope Rejection rules
· Set Mail Rejection rules
· Add Alter Remove mailing lists set up as newsgroups
· Set Seat Routeing
· Set where dead letter mail is filed

You will only be able to apply all these options when you have Email Admin pemission.
With List Subscribe permission you are only able to set up mailing lists.

Access is greyed out when dont have pemission.

Related Topics 
File menu    - Configure 



File menu: Configure Email tags

Calls up a dialog through which you can change the name of any of your tags or, on a shared system, set 
which other users are allowed to access mail with these tags. 

Related Topics 
File menu    - Configure 
Email tag dialog 



File menu: Configure Newsgroups

Allows you to view (and amend) the list of newsgroups you subscribe to and to set (or change) such 
details as the Expiry time for articles in a particular group, whether these articles should be picked up in 
full or just browsed, and who can access each newsgroup - assuming you have the appropriate 
permission.    Greyed out if you don't have News Admin permission.

Related Topics 
File menu    - Configure 
Newsgoup subscriptions dialog 



File menu: Configure Users
Used to inspect and change sign-on details such as password etc. On a shared (multi-user) system, it is 
also used by the system administrator (or by someone with Alter Users permission ) to add new users.

Related Topics 
File menu    - Configure 
Edit sign on details dialog  



File menu: Configure Workgroups

This only applies to multi-user systems

Used by the system administrator - or by someone with the appropriate permission - to define 
'Workgroups' of users all able to see certain types of mail such as sales enquiries, customer support 
enquiries etc.Greyed out if you don't have Alter Workgroups permission.

Related Topics 
File menu    - Configure 
Workgroups dialog



File menu: Decode
Used to extract uuencoded and Base64 encoded files from either mail messages or news articles.

You can extract files in a single operation from a series of items by highlighting them and then selecting 
decode.

Related Topics 
File menu
Extracting files from messages.



File menu: Exit
Exits from Turnpike.

Related Topics 
File menu



File menu: Export
Enables you to save either
· individual mail messages / news articles or 
· the whole of your current mailbase / newsbase / address book

in a form that can be used by a range of other programs.

The files created are simple text files which can be viewed within any text editor or word processor.

Related Topics 
File menu
Exporting mail messages
Exporting news articles 
Importing or Exporting addresses.



File menu: Import
Lets you transfer to Turnpike news articles, mail messages and email addresses that have been built-up 
using other software.

Also allows you to re-import messages etc. that you have previously exported.

Related Topics 
File menu
Importing mail and news
Importing or exporting addresses



File menu: Insert file
Lets you insert a file into the mail message or news article that you are preparing.

Related Topics 
File menu
Including files.



File menu: Mouse

The Mouse options dialog enables you use either the Windows 3.1/95 scheme or the Windows 98 
scheme for the function of the mouse

Windows 3.1 and Windows 95 scheme.
Both option boxes clear. Single click the mouse to select an item and double click to open it.

Windows 98 scheme
Both option boxes checked. To select and item point at it (hover over it). To open the selected item 
single click the mouse. 

Related Topics 
File menu



File menu: New mail list
This starts the Mail List Setup Wizard to create a new mail list.

Related Topics 
File menu



File menu: New mailbox
This starts the Mailbox Setup Wizard to create a new mailbox.

You set up further mailboxes into which your mail can be sorted. By doing this, you can separate business
correspondence (for example) from personal mail, sales enquiries or club notices.

Related Topics 
Setting up further mailboxes.
Alter mailbox
File menu



File menu: New newsstand
This starts the Newsstand Setup Wizard to create a new newsstand.

You set up newsstands for newsgroups. By setting up more than one newsstand, you can separate out 
the newsgroups you take in support of your work (for example), from ones you take purely for recreation, 
ones about Internet issues, ones about computer systems etc.

Related Topics 
Setting up newsstands.
Alter newsstand
File menu



File menu: Print

Prints the currently selected mail message or news article using your current printer set-up.

When you take this option, a dialog appears through which you can set the number of copies and the 
range of pages. This dialog also includes a Print setup button through which you can change the printer 
and type of paper that's used - or you can set these things up in advance by taking the Print setup option
from the File menu.

Quick keystroke: Ctrl + P

Related Topics 
File menu
Print
Print Preview
Print Setup



File menu: Print Preview
Shows on screen (as closely as possible) how the current message would look if printed on your current 
printer setup.

Within the Preview display, you can show different pages and zoom in on parts of the message you are 
interested in.

For more information, see 'Previewing before you print'.

Related Topics 
File menu
Print
Print Setup



File menu: Print Setup
Lets you set the printer and paper that will be used if you choose to print or preview any mail messages or
news articles.

When you take this option, a version of the standard Windows Print Setup dialog is displayed, through 
which you can set the printer and the type of paper that's to be used.

Related Topics 
File menu
Print
Print Setup
Print Preview



Filing mail

When you have finished with a message in a mailbox, you can 'file' it either by clicking the File message 
button or by dragging it to a suitable mail list.

The difference between these two methods is in the tags that the message is stored under. When you 
click the File message button, the message is simply stored under the tags that have so far been applied 
to it. But when you drag a message to a mail list, it is also stored under the tag(s) associated with this 
mail list, allowing you to categorise and file messages in one easy movement.

Suppose, for example, that you want to categorise messages as Project X, Project Y or Project Z. 
First set these up as tags, then call up a mail list for each tag and minimise the lists so they appear as
icons. Then simply drag the messages to the appropriate icon for filing.

The message is stored in your mailbase, along with the messages you've sent and any news articles 
you've posted (in fact, it's been there all along ! ) - filed not only under the tags that have been applied but
also under the email addresses it was sent from and to. So when you want to see the message again, 
you can either

Go into the Address book, select the sender or the receiver of the message and click the Messages 
button. The message will then appear in a list of all the messages sent to or received from this person
(arranged in date order, with the newest at the top).

Open up the Mailroom view (by double-clicking on its 'filing cabinet' icon or by selecting it from the 
Window menu). This shows you a list of everything that has been sent or received (arranged in similar
date order).

Or if you have tagged the message with its topic, you can find it by taking the New mail list option 
from the File menu, and use the Mail     List     Setup     Wizard   to produce a list of all the messages that have
been marked with this tag, again in the same date order.

See also help on Tagging Messages and Using Mail Lists.



Finding and Replacing text

Find & Replace lets you locate particular words or phrases within the message you are working on and, if 
appropriate, replace them by another.

To find a particular word or phrase, go to the Edit menu and take the Find option. When the dialog 
appears, type in the word or phrase you want to find, select Whole word/Case matching if 
appropriate, set the direction of the search from the current cursor position, then click the Find next 
button.

To replace a particular word or phrase by another, position the cursor above the point at which you 
want the first change to be made, then go to the Edit menu and take the Replace option. When the 
dialog appears, type in the word or phrase you want to replace and the one you want to replace it by, 
select Whole word/Case matching if appropriate, then either click the Replace All button or click the 
Find next button to process each instance individually.



'Find' dialog

Taking the Find option from the Edit menu displays a standard Windows Find dialog through which to set 
the details of the word or phrase you want to look for.

Simply enter the required word or phrase in the Find What slot, set the Match options and the Direction 
in which you want Turnpike to search (Up or Down through the text) - then click the Find next button.



Finding entries in lists
Where a dialog includes a list and a Find slot, you can use the Find slot to pick out entries from the list:

Either by starting to type the name of the required entry in the Find slot. The list will then automatically
scroll to the appropriate part of the list.

Or by giving a pattern for the name you require in the Find slot and then using the Find first / Find 
next buttons to work through the possible matches until you find the one you want.

The usual form for this pattern is * followed by the group of characters you want Turnpike to search 
for. The * means 'match any characters' so *astrology (for example) means match any name 
including the text astrology.

You can use multiple * characters. For example, *aut*ant could be used to find a newsgroup called 
alt.autos.antique.



    
Flaming
To be 'flamed' is to be on the receiving end of extremely cutting and 
sometimes quite personal remarks either posted to a newsgroup or sent to 
you directly as email.

The usual ways in which you can bring this on yourself are by posting an 
article to an inappropriate newsgroup, posting an article requesting 
information that is given in the appropriate FAQ or posting the same article 
to several newsgroups, particularly where this article advertises your 
services.



Followup-to: poster
If the author of an article in a newsgroup wants replies by email rather than through the newsgroup, this is
conventionally signalled both through a note in the article and by adding the line Followup-to: poster to 
the header of the article.

To add this line to an article you are preparing in Turnpike, click the Edit News Header button above the 
article then simply type poster in the Followup-To slot of the dialog that is displayed.

If an article has Followup-to: poster but you start replying to the newsgroup, Turnpike will warn you and 
give the option to switch to replying by email instead.



Font dialog

This dialog enables you to select the combination of font, font size and font style used either when 
printing mail messages / articles or for displaying text on the screen.

To make temporary changes to the current window, go to the Options menu and selecting Font.

To make permanent changes:

         1. Select the mailbox or newsstand to change
          2. Right-click it and choose Properties (or go to the File menu and choose Alter Mailbox or 

Alter Newsstand)
          3. Select the Fonts page, where there are Alter buttons for screen and printer fonts

Simply select the Font, then the Style and Size of this font you require from the set of three lists in the 
dialog. The dialog includes a sample piece of text so that you can see the effect of the changes you 
make.

If you want to change fonts for all mailboxes/newsstands, start with your Default mailbox since fonts set 
there are used in all mailboxes and newsstands which don't have specific fonts specially set.

If you choose a proportionally-spaced (PS) font for the screen, there is a risk that you may sometimes 
type lines of more more than 80 characters. This is fine where you know that the person reading the 
message uses a similar font to display their messages, but if you don't know that, it is better to use a 
fixed-pitch font which will give you a consistent approx. 72 characters per line with the default margins 
Turnpike sets.



The font used to print

Each mailbox and newsstand has its own font settings. To change the font used for printing:

1. Right-click the mailbox or newsstand you want to change, then select Properties.
Or select Alter Mailbox or Alter Newsstand from the File menu.

2. Select the Fonts page, of the dialog displayed. Click the Alter buttons and select the font then the 
Style and Size of this font you want to use for screen and printer.

The dialog includes a sample piece of text so that you can see the effect of the changes you make.

If you want to change fonts for all mailboxes/newsstands, start with your Default mailbox    Fonts set there 
are used as a template for all alternative mailboxes and newsstands unless they are locally set otherwise.

for more information about the Fonts page of the Mailbox/Newsstand dialog or here for information about 
the Font dialog - or press F1 to call up Help when you have the dialog on the screen.

Related Topics 
Alter Newsstand dialog - Fonts page 



Fonts/colours not saved
The Font and Colour functions in the Options menu are intended only for temporary changes that will be 
lost when the current window is closed.

To make permanent changes, right-click the mailbox or newsstand concerned and select Properties (or 
left-click it and then take Alter Mailbox or Alter Newsstand from the File menu). Then choose the 
Colours or Fonts tab to set up the changes you would like.



Forward "as is"
This option in the Messages menu allows you to forward an email to one or 
more people without adding any extra text. The only change will be that 
Resent from: headers are added (which many other mailers ignore).

It is generally better to use the standard Forward message option, as you 
can then add some details to explain why the email was sent on. However, 
Forward "as is" can be useful when forwarding email to people who don't 
use Turnpike and who might have trouble with MIME enclosures.



    
Forward path
The address an email message is sent to, as
stated in the message header.



Forwarded messages

When you forward a message, the original message is either:

· Inserted into a MIME message as an in-line enclosure
· Inserted as plain text between a pair of matching Cut lines (if the MIME option is turned 

off)
· Merged into, or quoted in the new message

Alternatively you can use Forward "as is" from the Messages menu to send the message on without any 
additions or changes.

When you receive a message that has been forwarded to you as an in-line enclosure in a MIME 
message, Turnpike gives the original message its own section within the main message, complete with its
own toolbar. This toolbar gives brief details of the message and a range of buttons for forwarding, replying
etc. 
Equivalent buttons on the main toolbar are set up to forward the whole message, reply to the forwarder 
etc.

Turnpike will also set up a section wherever possible for non-MIME messages that contain forwarded 
messages. It can only do this where the message has been inserted between a matching pair of cut lines.

Related Topics 
Forwarding mail



Forwarding a news article

There are two ways of forwarding a copy of a news article to someone.

1. Select the article, then go to the Article menu and take the Forward article option. This creates a 
new mail message complete with a copy of the news article you've selected.

2. Alternatively, if you've already started preparing the message you want to send, then drag the news 
article from the newsgroup into your mail message. To do this,.you need to arrange that you can see 
both the newsgroup and your mail message on the screen together.

Whichever route you choose, the news article will be shown in the message as a horizontal bar on which 
there will be buttons offering further actions. These include a Merge into text button, which simply 
merges the article into your own message, and a Quote message button which will insert the article as a 
quotation (with the usual > symbol at the start of each line).

There's also a Treat as file option to take if you want to forward the article exactly (byte for byte) as it 
came to you - for example to your Access provider's technical support department. The standard form in 
which articles are forwarded keeps the text of the article intact (including the header if required) but may 
alter how it is encoded. The Treat as file option keeps the encoding as well.

The introductory line inserted for you at the top and the signature inserted for you at the bottom are just 
text which you can change simply by editing in the normal way. You can also arrange for your own style of
messages to be inserted: see Setting the format of the introductory text and Signatures.



Forwarding mail

To forward a mail message to someone else, 
1. Open the mail list
2. Select the message 
3. Click the Forward Message button on the Mailbox toolbar (or take the equivalent option

from the Message menu). 

A new message is set up, with the item to be forwarded shown as an icon within a horizontal
bar. There are    four options for how the message is forwarded.

· Send the message as an 'in-line enclosure' within a MIME message.
This is the default option. Use this option when the person that you are forwarding the 
message to uses Turnpike or some other MIME compliant mail reader. It makes it easy for
them to reply to the author of the original message (rather then to you) or to forward the
message on to someone else. 
If you are not sure if your recipient has MIME, clear the Send MIME message option at 
the top of your message. The forwarded message will then be marked out by a pair of 
matching cut lines. This allows the same forwarding and reply options as the MIME option
if the recipient does use Turnpike.

· Merge the message you're forwarding into the text of your own 
message.
Click the Merge into text button on the horizontal bar. 
This is useful if you want to annotate the message you are forwarding.

· Include the message as a quotation
Click the Quote message button on the horizontal bar. 
This will highlight the forwarded message with    > markers and a special colour. This is a 
useful aid to clarity, especially if you are forwarding several messages.

· Send the message as a file
Click the Treat as file button within the horizontal bar
Use this option when you want to forward the message exactly (byte for byte) as it came 
to you - for example, to your Access provider's technical support department. The other 
options keep the text of the message intact (including the header if required) but may 
alter how it is encoded. The Treat as file option keeps the encoding as well.

Whichever method you choose, the subject will be filled in on your message for you, and 
your signature will be added at the bottom. When you've chosen how the message is to be 
forwarded,
 
1. Insert a brief note at the beginning of the message
2. Fill in the email address or Select an address    
3. Click the Post button.

The introductory line inserted for you at the top and the signature inserted for you at the 
bottom are just text which you can change if you wish. 



Related Topics 
Forward "as is".
Forwarded messages.
Setting the format of the introductory text 
Signatures.



Forwarding messages completely unchanged

The standard procedures for forwarding mail messages inserts the message you received into a new 
message. The message is re-encoded, before being sent on.

However, if for example, you have a problem and want to forward an email message to your Access 
provider exactly as it came to you as evidence. you will want to retain the original encoding. 

To retail the original encoding. 
1 Open the mail list
2. Select the message 
3. Click the Forward Message button on the Mailbox toolbar (or take the equivalent option

from the Message menu). 
4. When the new message opens with the forwarded message shown as a horizontal bar, click the Treat

as file button on this bar. The message now be forwarded exactly as it came to you.

5. Add any explanation required, address the message and post it. 

The person receiving the message will be able to 'save' this file on disk in exactly the form it was sent to 
you.

If you wish to just forward the message without any additional text from yourself, you can use Forward "as
is" from the Message menu.

Related Topics 
Forwarding mail



    
Full Name dialog
This dialog may be displayed when you first run 
Turnpike. Simply fill in the name you want 
Turnpike to use    The Full name you enter will be 
included in messages.. This name can be 
changed later through the Edit sign-on dialog. 



Full articles in Browse groups

If a newsgroup that you've marked as "browse" contains articles that have been downloaded in full, there 
are four possibilities to consider.

1. Are you sure that the newsgroup is marked as "browse" ?

To record a newsgroup as a browse group, you not only need to select the newsgroup in the list of 
newsgroup subscriptions and select the Browse check box, but you also need to click the Apply 
button.

It's also possible that, if your newsbase was damaged at any stage, the fact that you've opted to 
browse the group may have been lost when the newsbase was re-built.

Before going any further, call up the list of newsgroup subscriptions again (eg. by taking Configure | 
Newsgroups from the File menu) and check that the Browse option is selected for this newsgroup 
(assuming you have News Admin permission).

2. Have you set a kill rule to accept certain articles ?

Any articles which meet the conditions of such a rule will be downloaded in full.

3. Have the full articles been cross-posted to newsgroups which aren't browsed ?

Such articles are fetched in their entirety.

4. Did you stop, switch the newsgroup to "browse", then restart the last news download ?

This doesn't stop the current set of articles being downloaded in full because Connect's list of things 
to fetch has already been set up. To avoid getting these articles in full, you need to rebuild the news 
database before you restart news collection (assuming you have Rebuild Files permission). This will 
keep any user-generated requests to fetch articles in full, but discard the automatically-generated 
ones.



Group Mail

This topic applies only to multi-user systems

'Group mail' is based on group email names.

These are simply email names with several users rather than just one. Within a company, you might well 
have names like 'Sales' and 'Support' set up as group email names with the members of your Sales team 
as users of the Sales email name and the members of your Support department as users of the Support 
email name.

All the people listed as using a group email name - either in their own right or through a workgroup they 
are members of - can write mail messages using the group email name. In addition, any item of mail that 
arrives addressed using this group email name initially appears in the mailbox of every member of the 
group, but disappears again from everyone else's mailbox the moment someone starts to read it so that 
there is no chance of two people answering the same message. (The message will, however, re-appear if 
it is marked Unread again.)

Assuming you have Alter Names permission, you can set up group email names by going to the File 
menu and selecting Configure... Email names in much the same way as you set up additional email 
names for yourself. The only difference is that when you display the 'Usage' dialog, you don't just type in 
the email name you wish to set up. You also use the Add and Del buttons to set up the list of users or 
workgroups that will be able to use this name in their messages.

See also Setting up group mail or press F1 to call up Help when you have the Usage of Email Names 
dialog on the screen.



Header-only articles

There are two main reasons why just the header of an article may be downloaded, rather than the 
complete article.

1. The article is in a newsgroup which Turnpike has been set to 'browse'.

A Browse group is, by definition, a 'header-only' group though full articles can be included    if, for 
example, the article has been cross-posted to a newsgroup that is downloaded in full.

2. Kill criteria are being applied to the group.

Using kill rules means that you should get the whole of most articles but only the header of those 
articles which are picked out by the kill criteria (so you can still see what the article was about in case 
you wish to request the full article).

To arrange this, Turnpike first fetches the headers of all articles, examines them to see which articles 
should be killed, and then fetches only the required bodies. So if you look at the newsgroup while the
articles are being collected, or if the news collection session does not complete for some 
reason, then some articles will contain headers but no bodies. In the fullness of time the bodies will 
be collected without further intervention by you.

The standard type of kill criteria are rules such as "nothing else by that person" or "nothing over 100 
lines". If you have Kill Article permission, you can check on the rules that are applied to the 
newsgroup you are working in by going to the Classify menu, taking the Kill option and then clicking 
the Review rules button.

Less obviously, killing a thread also sets up kill criteria - because it is not possible to determine 
whether an article belongs to a thread until the header has been fetched and the reference lines 
inspected.

Related Topics 
Defining Custom Rules. 



Help menu

Index
Using Help
Show Hints & Tips
About Turnpike



    
Help Menu Find. 
From this tab you are able to perform a 
full text search of the help files for any 
word or phrase.



Help menu: About Turnpike.
This display gives brief details about the 
version of the Turnpike program you are using, 
including the version number, the date of issue 
and whether your copy has been registered.



    
Help menu: Index
Lists key phrases in alphabetical order. To 
use select a phrase, then either double-click
on the phrase or click on the Display button 
to see associated Help text.



    
Help menu: Show Hints & Tips
Click this option to show a sequence of useful tips about 
using Turnpike. From the initial screen you can select to 
show the next tip in sequence. A check box enables you 
to select for the system to show the next tip each time 
you load Turnpike or to disable this facitity.



    
Help menu: Using Help
The Help Topics window opens with, Index, 
Contents and Find pages 



Here you can:

set various details about yourself, including which of your email names to use
change the email address you want shown to be used for replies
choose which of your signatures should be used in this mailbox

Show me the tips on Signatures



Here you choose a font for displaying messages and a font for printing messages. If you use more than 
one mailbox, you can set different fonts for each.

              Show me the tips on fonts



Working with news

How to ... Set up a newsstand

Read newsgroups

Sort out interesting articles

Contribute to newsgroups

Save and print articles

Work with the newsbase 

Working with email

How to ... Set up and customize mailboxes

Read and process email and attachments

Send messages

Use tags and lists for filed mail

Work with Mailing Lists

Make email accessible to colleagues

Work with the mailbase



How to ... Tag messages with their topic

Tag messages through the mailbox

View all the mail that has been sent or received

View mail exchanged on a particular topic

View mail exchanged with a particular correspondent      

View just the mail you've sent or received

Edit tags



How to ... Follow-up an article (Respond through the newsgroup)      

Send an email message to the author

Start a new discussion thread

Prepare the text of your article

Change the header on your article

Post a picture

Encode your article

Use a different signature

Stop the article being sent

Call up articles you have posted



How to handle different types of mail.

Set up mailboxes for particular types of mail

Set the email name,signature etc. used

Set the colours and fonts used

Change the details of a mailbox

Remove a mailbox

Set up additional email names



How to ... Set up Group mail

Make mail public/private

Make access dependent on topic

Set the access through the mailbox

                      Change the access to a tag  

Change the owner of a piece of mail      



How to Process the Messages you Recieve

How to ... Display the contents of a mailbox

Set the way dates are shown

 Reading mail -open a mail message

Read the next unread message

Search for a message

See the header of a message you've received      

Decode an encoded message

Extract a file from a mail message

File a message

Forward it

Print it

Throw away unwanted mail

Mark as Read/Unread

See messages you've filed



How to ... Select a newsstand

Open/close newsgroups

See the individual articles within a newsgroup

Read a news article that catches your eye

Work through the unread articles in a newsgroup      

Follow the thread of a discussion

Search for an article

Request missing articles

Decode encoded articles

Extract a file from a news article

'Read' binaries

See the header of an article

Mark as Read or Unread

Forward an article to a friend



How to ... Keep articles past their expiry date      

Export articles

Print articles



How to ... Save the current newsbase

Import news articles from another source      

Rebuild your newsbase

Expire the newsbase



How to ... Export messages from your current mailbase      

Import mail messages from another source

Rebuild your mailbase



How to ... Send a reply

Send a new message

Prepare the text of your message

Select an address    from your address book

Send multiple copies

Include files in your message

Send a message you've prepared using your word processor...

Send a MIME message

Change the header

Use a different signature

Stop a message being sent

See messages you've posted



How to ... Set up a newsstand

Select the newsgroups to subscribe to

Set the email name, signature etc. used

Set the colours and fonts

Change the details of a newsstand

Remove a newsstand

Set the Expiry time on a newsgroup

Restrict access to a newsgroup

Cancel the subscription to a newsgroup

Set up a new newsgroup



How to ... Mark threads as interesting

Break off the interesting part of a thread      

Clear out unwanted articles



How to ... Subscribe to a mailing list

Set up a mailing list as a newsgroup

Convert an existing mailing list to a newsgroup      

Run a mailing list



Importing mail and news

If you have a newsbase or, more importantly, a mailbase that you have built-up using other software, you 
can transfer this to Turnpike when it is stored in one of the following formats:

· Mail: 
Berkeley Unix Mailbox format or Soup 'm' format .MSG file. 

 
Turnpike can't import other formats of Soup .MSG files ( 'M', 'b' or 'B' ).

Outlook Express .mbx files, i.e. you are able to migrate you Outlook Express mail database into 
Turnpike. These files are found typically in the C:\windows\profiles\~yourname~ area, under ~\
Application Data\Microsoft\Outlook Express Mail.

 
To avoid importing deleted mail you should compact the files first. Import only fetches raw 
data and does not preserve information such as whether you have read the mail and when it
arrived.

· News:
Batch format (as defined by RFC 1036), 'Snews' database format or Soup 'u' format .MSG file

Individual news articles held as ASCII files can also be imported into your newsbase.

To import a mailbase or a newsbase that has been built up using Turnpike, whether your own or 
someone else's, it must first be exported as described in the sections on Exporting mail/news 
messages.

· To import mail
Open a mailbox, then go to the File menu and select Import. Choose the mail file to import.

1. Any 'Incoming' messages you import (ie. ones sent to you) will be placed in your mailbox(es) - 
distributed according to the rules that you've set up for your mailboxes, and marked with the 
default tag(s) of the mailbox into which they are inserted.

2. Any 'Outgoing' messages you import (ie. ones that you have sent) will be tagged with the 
default tag(s) of the mailbox from which you called up the Import option, then filed in your 
mailbase.

· To import news
Before you import any news articles, you must first set up one or more newsstands covering the 
newsgroups from which you will be importing news. When you have done this, open a newsstand, 
then go to the File menu and select Import. Choose the news file to import. Articles will be placed in 



their newsgroups and can be read by going into the newsstand that covers the appropriate 
newsgroup.

1. Kill rules are ignored when you import news.

2. If you forget to include a newsgroup in any newsstand, the articles from this group won't be 
imported. To put this right, just alter a newsstand to add the missing newsgroup(s) and then 
import the appropriate file again.

Related Topics 
Setting up newsstands
Exporting Mail messages
Exporting News articles



Importing or exporting addresses

You are able to produce a text version of your Turnpike Address book, in the form of a Comma Separated 
Value(CSV) datafile. 

You are also able to import the addresses from a previously exported Address book or a CSV datafile set 
up with the same format. 

To export your Address book
1. Call up the Address book 
2. Go to the File menu
3. Choose Export.

To import addresses
1.. Call up the Address book 
2. Go to the File menu
3 Choose Import

The CSV file produced starts with the individual 'Person' address book entries, arranged one per line. 
This is followed by the details of any distribution lists you've set up, separated from each other and from 
the list of 'Person' entries by single blank lines.

Related Topics
Address book - Overview 
The 'external' form  of the address book



Inserting Files, Attachments/Enclosures 

Position the cursor where you want the file or attachment to appear, then click the Insert file button, or 
select Insert file from the File menu. Alternatively you can drag the file from the Windows File 
Manager/Explorer either into the message you are preparing or to a mailbox. If you drag the file to a 
mailbox, Turnpike will create a new message outline and include the file for you.

The file/attachment you insert is represented by a horizontal bar containing a brief description of the file 
you have inserted. Where applicable the bar will also contain one or more control buttons.

If the file you are inserting contains ASCII text, there will typically be an Inspect button and a Merge into 
text button. The inspect button enables you to view an inserted file. If you click the Merge into text button
the the bar is replaced by the text of the file you inserted. This can be useful if you want to edit the file you
have inserted. 

With other types of file, including files containing compressed ASCII, the options you are offered depend 
on whether you will be sending a standard mail message/news article or a MIME message. 

A plain text message needs no decoding at the other end, and is therefore often preferable to 
sending, a formated word-processor file of the message.

To send someone a MIME message, check the send MIME message option in the header of the 
message you are preparing. When you are replying to a MIME message.this option will be automatically 
set for you. If the Send MIME message option is selected, the bar will include a Properties button 
through which you can specify the type of file that's being sent.

Turnpike normally sends the text of a MIME message 'Plain' ie. without any formatting. If you select the 
Enriched option the text is broken into lines at the receiver's end, where the font and margins that the 
person reading the message uses can be taken into account. If you are not sure if the person receiving 
the message can handle Enriched MIME select the Enriched & Plain option. Turnpike will then send two 
copies of the text, one enriched and one plain.

Enriched MIME also allows a certain amount of text styling to be transmitted, but few people use this 
facility. In practice, you will get very much better results by leaving the MIME option set to 'Plain' and 
using your word processor to set up a suitable text file which you then include as a MIME attachment 
as described above.

If the send MIME option isn't selected, the file is simply set to be 'uuencoded' for transmission 
over the Internet. Any characters in the text that are outside the ordinary mail character set will be 
replaced by a dummy character (after a warning).

Recording the type of file enables the correct viewing application to be chosen where the file is received. 
Generally Turnpike will identify the type of file for you, as an image, audio and the sub-type, JPEG, TIFF, 
GIF etc.

If Turnpike fails to identify the type of file or you know there's something better to specify, you can set the 
type etc. through the Properties dialog. This is called up automatically or by clicking the Properties button
shown alongside the file's icon. 



Related Topics 
Attachments- An overview
Sending a pre-prepared message
Extracting files from messages.
Forwarding mail



Inspecting newsgroup ratings

Ratings for all the different newsgroups are (or will be) set by independent third-parties and distributed 
alongside the list of newsgroups available from the news server you use.

If you would like to see how any particular newsgroup is rated, either make as if to add new newsgroups 
to one of your newsstands, then pick out the newsgroup in which you are interested in the Newsgroup 
Addition dialog and click the Ratings button.

Alternatively, if you have News Admin permission, you can find out by calling up the Newsgroup 
Subscriptions dialog, selecting the newsgroup in either that dialog or in the associated Newsgroup 
Subscription dialog and clicking the Ratings button offered there.

Whichever route you take, you will see a dialog showing the names of the newsgroup ratings services 
that are currently in use, together with details of the rating that the newsgroup has been given under each
of the different categories covered by each ratings service.

By the very nature of the ratings system (and of the additional access controls Turnpike offers), you can 
only see the ratings of newsgroups that you are allowed to see.



Keeping news articles past their expiry date

The articles you download are normally set to expire after a certain time to avoid filling up your disk with 
old articles. The length of time articles remain on your disk is specified for each newsgroup in the 
Newsgroup Subscriptions dialog.

If there's an article you want to keep past its expiry date and you have Keep articles permission, go to the 
Classify menu and select Keep article. The article will then be kept until you either cancel the instruction 
to keep the article (by taking Cancel Keep from the Classify menu) or stop subscribing to the newsgroup.

It is also possible to arrange that future contributions to a particular newsgroup will automatically be 
marked to be kept - by selecting the Auto Keep option for this newsgroup within the Newsgroup 
Subscriptions dialog. If there are any articles you don't want to keep after all, then you can clear the Keep 
marker against these articles using the Cancel Keep option described above. Clearing the Auto Keep 
option within the Newsgroup Subscriptions dialog only affects articles downloaded after you have made 
this setting.



Kill Rules dialog

This dialog is called is called up by clicking Classify in the menu, selecting Kill and then 
clicking the Review button in the Kill articles and threads dialog that is displayed.

The Kill rules dialog enables you to display any Kill rules applied to the newsgroup in which 
you are currently working and enables you make any changes to the rules that you require.

Click the Add or Alter button to display the  the News article kill rule dialog.

· The Add button enable you to enter a further rule
· The Alter button enables you to modify an existing rule.

To remove a rule, select the rule and then click the Remove button 

Use the Move Up and Move Down buttons to re-order the rules. Note that rules are applied
in the order listed.

Related Topics 
Killing articles
News article kill rule dialog
Kill rule dialog

News article - Custom Kill rules
Custom Kill rules -examples

Defining Custom Rules.
Custom rules: Formal syntax.



News article - Kill rules

Kill rules enable you to minimise the amount of disk space used up by articles in which you 
have no interest. If an article is identified as unwanted, by a kill rule, just its header is 
downloaded. This provides enough information for the article to be downloaded in full if you 
later decide you want to read it. The article is also marked  and isn't brought to your 
attention eg. by including it in counts of unread articles.

Kill articles permission is required to set up these rules because, on a shared system, 
any article that's killed by a Kill rule is killed for every other user of the system as well.

To set up kill rules; select the article, select Classify in the menu and then select Kill. The 
kill articles and threads dialog appears offering a range of Kill options from simply killing 
the current article to setting up a 'Custom' Kill rule to be applied to the newsgroup you are 
working in.

Each Kill rule is associated with a particular newsgroup. This will enable you set up separate 
sets of rules for each newsgroup, and to have newsgroups that aren't filtered at all. 

The kill articles and threads dialog also contains a Review option that you can use to see
and amend any rules currently set.

Order of rules. Most rules specify a type of article that is to be rejected but it is also 
possible to set up rules that specify that particular articles should be accepted. Where more 
than one rule applies Turnpike will act on the first rule that applicable to the article it is 
considering. Therefore, ensure that the rules appear in the order you want the rules applied.

Filtering a newsgroup using Kill rules may increase the time taken to download articles. This 
is because of the time required to inspect each article's header. You should therefore 
consider the number of groups that you want filtered in this way. 

Generally, it will not be necessary to set up kill rules for a newsgroup that is browsed. This is
because only the headers of the articles are downloaded anyway. You may want to set up a 
kill rule to accept certain types of articles in a browse group (e.g. those with the subject 
Announce). Articles meeting the conditions set will then be downloaded in full.

Related Topics 
Killing articles
Clearing out unwanted articles
Killing news articles
Defining Custom Rules



Killing news articles

        You are only able to kill articles when you have Kill Articles permission 

On a shared system articles will be killed for all users. It is recommended that only a 
limited number of users be given the permission to Kill articles. It is also recommend that a 
local procedure ensures that all users are advised before any article is killed.

· To kill an article
1. Select the article
2. Select Classify in the menu 
3. Select Kill. 

The kill articles and threads dialog appears. This dialog has seven buttons, click a 
button to initiate one of the following;

Kill article: remove the body of the selected article. The header will remain to 
permit optimal threading.

Remove article: the selected article is completely. Note that the Newsgroup threads
may then be incomplete.

Kill thread: remove the bodies of all the articles in the same thread, and set a kill 
rule. This stops any article that continues this thread from being downloaded. The 
headers are marked Uninteresting and moved to the bottom of the list the next time 
you open the newsgroup. The rule will be automatically dropped from the list when 
the thread finishes.

The next three options enable you to specify that you don't want any similar articles 
that appear in future to be downloaded to your disk. 

Kill Author. Sets a rule that articles from the same author as the current article are 
not to be accepted.

Kill Subject. Sets a rule that articles with the same subject as the current article are
not to be accepted 

Custom Rule. When you click this button, the News article kill rule dialog 
appears. This enables you to set a subtler rule.

 
Review rules. When you click this button to the Kill rules dialog appears. This 
dialog lists the rules that are currently applied for this newsgroup and enables you to 
make any amendments required.

Related Topics 
News article kill rule dialog 
Kill rules dialog
News article - Custom Kill rules
Custom Kill rules -examples

Defining Custom Rules.
Custom rules: Formal syntax.





MIME
Multipurpose Internet Mail Extensions extends the mail message format to allow graphics, video and 
voice messages to be sent with email messages as 'attachments' or 'enclosures'. MIME also allows a 
wider range of characters to be transmitted. With MIME you can transmit almost any character in the 
Windows character set.

Turnpike enables you to send and read and forward MIME messages.Other programs may be needed
to view pictures etc. included in these messages. 

There's only any point sending a MIME message if the person to whom you send it can handle MIME 
messages. A Send MIME message option is included in the Header details of messages. This option 
is automatically selected when you are replying to a MIME message but is otherwise left clear.You will
need to set this option if you are sending a MIME message. Turnpike records for each Address in 
your Address book if your correspondant has MIME. You will get an alert message when you are 
about to post a MIME message to someone who is not known to have MIME and be offered to send a
standard email message instead.

See also Sending a MIME message and Extracting files from messages.



Mail

Depending on the sort of information you are looking for, either pick from the following list of topics:
Mailboxes
Reading Mail
Sending Mail
Posting & Re-posting Mail
Sorting Mail
Filing Mail
Calling up past mail (sent or received)
Tagging messages
Mail message headers
Email addresses
Alternative email names
Distributing mail on a shared system
Dead letter mail
Mail from Mailing lists
Sending files as attachments
MIME
Group Mail
Allowing other people access to mail
The symbols used to mark items of mail
Buttons and menus

Or select from pop-up lists of 'How-to' instructions on the following actions:
Processing the messages you receive
Sending messages
Calling up mail eg.on a particular topic
Sorting mail into different mailboxes
Working with Mailing list mail
Making mail accessible to colleagues
Saving/Recovering the mail in your mailbase



Mail List Setup Wizard

You are able to move backwards or forwards through the wizard pages to check or 
change the details using the Back and Next buttons. If you make a mistake you can 
abandon creating the mail list by pressing Cancel on any page. When you press Finish on 
the last page the new mail list will be created and displayed. New mail lists cannot be 
edited.

· To start the Mail List Setup Wizard 
1. Click File on the menu 
2. Click New mail list. The first page of the wizard appears. 
3. Select one of the three options then click the Next button.

Select Mail tags to create either a list of 
· messages on a particular topic or topics
· articles contributed to a particular newsgroup

You are only able to create lists of this type for messages and articles which are 
already tagged 

Select correspondence with a particular person to create a list of all the 
messages,
· that you personally have sent or received
· exchanged with a particular person.

Each name must be in your address book

Select mailroom view to create a list of all the messages that have been sent or 
received at your site.

4. Click Next to go to the selected page of the Wizard

Related Topics 
Mail Lists
Mail Lists - Mail Room View
Mail List -Correspondence with a particular person
Mail List -tags
Tagging Messages



Mail list Wizard - Correspondence with a particular person 

When you select this option for a mail list the address list of you address book appears.The 
address you select will be used to create the New Mail list.

1. To go to the most recent addresses box you have accessed, click on the down arrow in 
the Jump to box and select the address you require. 

Otherwise click on a Goto A-Z letter and then use your arrow and page keys to find the 
address you require. 

If you are not sure that the entry you have selected is correct, click the View button to 
see the full list for the selected name in the address book entry. 

The list of the name you are creating will include all the addresses listed in the File 
as field. Ensure this entry is complete.

Amend details in the address     book     entry   here if you wish

If your address book does not contain an entry for the person required click the 
Cancel button. Add an appropriate address book entry.and then restart the wizard.

2. When you are satisfied with the name selected click OK or Cancel button to clear the 
Address book entry 

3. Click on the Next button. The last page of the wizard appears. 
4. If you are satisfied with your selections click the Finish button or click the Back button 

to check your entry.
5. Click the Finish button to create the New Mail list

You are also able to create a mail list by selecting a name in the Address book, see 
New Mail list.

Related Topics 
Mail Lists
Mail list Set up Wizard
Mail List: tags
Tagging Messages
New Mail list.



Mail list wizard: Tags 

On this page of the Mail List Setup Wizard you are able to select the tags which will be used 
to create a New Mail List. The mail list will include all mail messages or news articles that are
tagged with all of the tags you select here. 

On this page of the wizard either select one or more email tags to create a list of tagged 
mail, or select a news tag list to create a list of articles contributed to a particular 
newsgroup,

The tags that are currently applied are shown in the lower section of this wizard page. The 
tags available are shown in the upper section.

To limit the list of Tags available check the Private, Group, Public and or News box(s) 

If there many tags listed make an entry in the Find box to locate the tag(s) you require; use 
wildcard    matching if necessary.

· Create a Mail List for Tagged Mail/Articles
If there are any tags listed in the Tags applied box, that you do not want included, 
select the tags concerned and then click the Remove button. To remove several tags at 
once use the shift/click option. 

To add tags to the list of tags applied select each tag you want in turn, then click the Add 
button

· If there are no existing tags for the topic you are interested in.
1. Click the New tag button and the Make New Tag dialog appears.
2. Enter the new tag.
3. Click OK to return to the wizard
4. Click the Add button

Initially this will result in an empty mail list. Any messages that are subsequently 
tagged using this new tag will appear in this new mail list automatically. Further 
details are given in Tagging Messages.

When you are satisfied that the applied tag list is complete click the Next button or click 
the Back button to check your entry.

.
Click the Finish button to create the New Mail list.

Related Topics 
Mail Lists
Mail list Set up Wizard
Mail Lists: Correspondence with a particular person
Tagging     Messages  



Mail Lists

All the messages you send or receive and file and any news articles you post are all put into 
your mailbase 

The default mail list contains all the mail to and from all the users of your system and any 
mail that is currently in your Out tray, plus any news articles you have posted. Symbols next 
to each item in a list show 
· whether the message has been sent or received; 
· whether the message is currently in an In tray, a Pending tray or your Out tray,
· who has access to the message. 

To read the messages in your mailbase you can call up the default mail list    or create a New 
Mail List containing just the items you require, typically you are able to create lists which 
contain messages that, 

· have been sent or received at your site
· you personally have sent or received
· have been exchanged with a particular person
· have been exchanged on a particular topic (or combination of topics) ie tagged 

messages.
plus
· A list of all the articles  contributed to a particular newsgroup

When closed the default mail list is shown as a filing cabinet icon. Any New mail lists 
you create are shown as folder icons. Mail will continue to be added to your mailbase even 
when the mail list is closed

To open a mailing list click on its icon. Each list will open a separate window. 

Related Topics 
Mail Lists - Mail Room View
New Mail List
Mail Symbols
Mail Message Status bar



Mail Message Details

To read your mail, select a mailbox or the mailroom,
· double-click on the mailbox or mailroom icon
· or click Window in the menu and select the mailbox or mailroom.

A window opens with a list of messages in arrival or sent order. Details of each message 
include.
· The Subject of the message
· Who is it is from
· Who it was addressed to
· The general rules about access to this message
· Where the message is currently located
· What tags have been applied to it

Related Topics 
Mail Message menu
Reading mail



Mail Message Header dialog

For received mail the header shows From, Subject, Date and CC. To see the full header, 
select Display Header from the Options menu.
For new mail the only entries you have to make are the To address and the Subject. The 
Sender, From and Reply-to addresses are set the same and no cc (carbon copies) are set. 
If you want enter further details, click on the Edit Mail Header button above the message 
and complete the dialog as you require.

Enter any address simply by typing it or click the Look up address button and select the address you 
want from the Address book.
You can also 'cut and paste' addresses via the clipboard. Use Shift + Ctrl + V to paste them in.

If you want to record more than one To, CC or BCC address, click the [+] button next to the appropriate 
slot in the Header dialog. This creates the space for an additional entry. Each slot only shows one entry at
a time. Click the down arrow to produces a drop-down list of these entries.

To: The email address(es) of the person(s) the message is to be sent to.

Subject: A brief description of what the message is about.

Send as MIME Check this box if you are enclosing an attachement and your recipients can use    
MIME 

cc The email addresses of any people to whom Carbon Copies) are to be sent.

bcc The email addresses of any people to whom    Blind Carbon Copies are to be sent.

Sender The name of the 'Sender' of the message is automatically set by the User Information
for mailbox you are in.

From: Your email address.

Reply-To: The email address to be used for any reply.

Others Add any further Header lines you require in the this box 

Related Topics 
Mail Message menu
Sending a MIME message 



Mail Message Status bar

At the bottom of each mail message, is a Tags button and list boxes for Owner and  Access.

· Owner 
The ownership of a piece of mail defines who can change the tags or the access privileges on that piece 
of mail. The owner can either be a person or a workgroup. The current owner is displayed on the Status 
bar below the message.

If you do not have ownership the buttons on the status bar will be greyed out 

The initial owner of a piece of mail is set through the mailbox in which it is opened. This will have
made the owner either a particular person (specified through their sign-on name), a workgroup 
or by how the message was addressed, The Default owner of the mail is set in the Tags page 
of the Alter Mailbox     dialog, 

Subsequently, the particular person or a member of the workgroup that owns the message can 
change the ownership either to themselves or to a workgroup they are a member.

· To change the owner 
1. Display the message 
2. Click the Owner button to display the Select owner dialog
3 Click on the down arrow and select a new owner.
4. Click Ok to apply.

· Access 
When a message first arrives in your In tray, it is automatically treated as private to you. But when you file
it, you will probably want the message either to remain private or to become available to all your 
colleagues. The other option is for it to be available to a specific range of people.

Who will have access to a message when it is filed is shown on the Status bar displayed below the 
message. Access can be public, private (to the owner) or restricted (accessed by tags). 

The 'Default access when filed' is set on the Tags page of the Mailbox dialog. If you set the default access
to what you want to apply to the majority of messages in this mailbox, you will then only have to set these 
details in the messages that don't fit the general rule. If you forget to check the access settings before 
filing a message the default settings will be used.

 You are only able to change the access when you are the owner of the message or you 
are a member of the workgroup which owns the message. 
· To change the Access 

Click the Access button and select one of the following
· Private, for access only by the owner
· Public, for access by anyone on the system
· Restricted, for access dependent on the tags that are set. 

In mail lists access to a message is with  for messages that you can't read; 
 for messages that only you can read; and 



 marking messages that only you and some others can read. If a message doesn't 
have any of these markers, it's public and can be read by anyone.
· Tags 

Any tags applied to a message or 'not tags' are shown next to the Tags button.
You can also set tags to allow access to tagged mail to be Private, Public or Group.
Click the Tags button to display the Tag Selection dialog box.

Related Topics 
Tagging Messages
Reading Mail
Alter Mailbox dialog 
Access to Mail



Mail Message menu

To select a mailbox or the mailroom,
· double-click on the mailbox or mailroom icon
· or click Window in the menu and select the mailbox or mailroom.

A window opens with a list of messages in arrival or sent order. The Message menu item 
will be available. 

When you click on Message a sub menu enables selection of the following,
Open message 
Reply to message
Forward message

        Forward "as is"   

You can also open a message by double-clicking the selection
Reply and Forward message buttons on the toolbar

The Message menu item will change to Article if you select a newstand.

Related Topics 
Reading Mail 
Sending Mail.
Reject mail
Start new email



Mail buttons and menus

When you are working with a mailbox, you are offered a toolbar plus the following menus:

File
Edit
Search
Message
Classify
Options
Window
Help

For details, click on the appropriate entry.



Mail symbols

In a Mailbox:
Unread message
Message that also appears in another mailbox (see Mailboxes)
Item of Group mail
Message that has been read
Message that is mirrored from a POP mailbox

Message that's private to you

Message that only you plus a restricted list of other users can read

In a Message:

Element of message that is offered in a choice of Alternative forms. 

(on a horizontal bar) File enclosed in a message (see Extracting files from messages)

(on a horizontal bar) Forwarded message follows.

(on a horizontal bar) Forwarded article

(on a horizontal bar) Text file enclosed in a message (see Extracting files from messages)

(on a horizontal bar) Returned mail

(on a horizontal bar) Document that uses an unknown character set: may not be shown correctly

 or 

 (on a horizontal bar) Text 'signed' using author's PGP signature

(on a horizontal bar) External body

In a Mail List:
Message that has been received
Message that has been sent
An article posted to a newsgroup
Message currently in an In tray
Message currently in a Pending tray



Message currently in your Out tray

Message that is mirrored from a POP mailbox

Message that's private to you

Someone else's private message

Message that only you plus a restricted list of other users can read

In the Out tray:
Message waiting to be sent
Message with multiple recipients waiting to be sent (Number of recipients shown in the box; 

individual messages also shown as waiting to be sent)
Message that is being transmitted*
Message that has been sent*
Message that couldn't be sent*

* Seen only very rarely



Mailbox Setup Wizard

To start the Mailbox Setup Wizard select New mailbox.from the File menu. The wizard will guide you 
through the process of setting up a new mailbox. 

On the wizard pages you can specify:

· the rules governing the type of mail you want in the mailbox
· how the mailbox icon should flash and whether new email addresses should be 

automatically added to the address book
· whether any tags will be automatically applied to email messages
· who will be allowed to read the messages and information to identify yourself when you 

reply to messages
· the name of the mailbox

The Back and Next buttons enablr you to move backwards and forwards through the wizard pages, to 
check or change the any detail    You can abandon creating the mailbox by pressing Cancel on any page. 

When you click Finish on the last page the new mailbox will be created.

You can change any settings later by right-clicking the mailbox and selecting Properties.



Mailbox Wizard (accept)

This page of the Mailbox Setup Wizard is in two sections:

Incoming mail
Choose an email name for which this mailbox should accept incoming mail.

Only existing email names are available in the drop-down list. If you haven't yet setup the email name you
wish to use with this mailbox, you should Cancel the Mailbox setup wizard and go to File ... Configure ... 
Email names.

Outgoing mail
Here you supply information to identify yourself in any email messages or replies you write from this new 
mailbox.

The Email name and Name entries are used to construct the reply-to address shown in the dialog.

Using the Browse button you can select a different signature file if required.



Mailbox Wizard (access)

This page of the Mailbox Setup Wizard has three sections. The first two are only relevant on systems with
more than one user.

By default, once read, the mail will be:
You select one of: public, private or restricted to control who will be allowed to read the messages in 
this mailbox. Mail is always marked as private until it has been read, then the default access specified 
here will be applied. See Allowing access to mail for further information.

By default, mail will be owned by:
Usually select the person the mail is addressed to. Otherwise pick the person or group from the list. 
Only the owner of an email message is allowed to change its tags or read access. See Allowing access to
mail for further information.

Tags
Tagging is a useful facility for keeping track of different categories of mail messages. If you select Yes all 
mail handled by this mailbox will automatically be tagged. The next page will ask for details of which tags 
to apply. If you select No the mail will not be automatically tagged.



Mailbox Wizard (attributes)

This page of the Mailbox Setup Wizard. is in two sections:

Flash when
Select whether the mailbox icon will flash; there are three choices.

Address book
If you select add addresses then email addresses from any messages arriving in the mailbox will 
automatically be added to the address book. Otherwise the address book will not be changed.



Mailbox Wizard (custom)

This page of the Mailbox Setup Wizard is in two sections.

Incoming mail
This section is just to confirm the list of rules which will be applied to this mailbox. You supplied these on 
the previous page. If you need to change any of the rules go Back to the previous page.

Outgoing mail
Here you supply information to identify yourself in any email messages or replies you write from this new 
mailbox.

The Email name and Name entries are used to construct the reply-to address shown in the dialog.

Using the Browse button you can select a different signature file if required.



Mailbox Wizard (name)

This is the last page of the Mailbox Setup Wizard.

Here you can keep the suggested name for the new mailbox or type in another unique name.

You can move backwards and forwards through the wizard pages to check or change the details you 
have entered using the Back and Next buttons.

When you press Finish here the new mailbox will be created.

You can further customize or change the characteristics of the mailbox later if required by taking the 
Alter mailbox option in the File menu.



Mailbox Wizard (rules)

On this page of the Mailbox Setup Wizard you can set up one or more rules to control which mail 
messages will be accepted or rejected by this mailbox.

In the top section you choose whether mail which satisfies a given rule will be accepted or rejected 
by this mailbox. (Accept is the usual case.)

In the middle section you can either specify one of the three simple rule types below, or a custom 
rule. In any of these rules the characters ? and * are interpreted as wildcards for partial matching so 
they cannot be used literally.See partial matching with wildcards.

Addressed to
You can choose an email name from the drop-down list of email names on your system. Only mail 
addressed to exactly this email name will be accepted (or rejected) by this rule.

Sent from
You can pick an email address from your Address Book or type in a different address. Unless you 
use wildcards only mail sent from exactly this email address will be accepted (or rejected) by this rule.

Subject Line Matching
Text which you specify here without any wildcards will match any subject line beginning with that 
text. To match a particular word or phrase anywhere in a subject line; include the wildcard character *
at the beginning.

Custom rules
If you find you cannot express the selection criteria you need using any of the simple rule types, you 
will need to construct one or more Custom     rules   instead. These are more powerful, but also more 
difficult to construct. The best advice is to use them only as a last resort.

The bottom section contains the list of rules to be applied and three buttons to Add, Remove or 
Alter rules in the list. Use the Add button to add each rule to the list after specifying it above.

If you are making a list of several rules you should add the most important ones first, as the first 
rule which is satisfied determines whether a message is accepted (or rejected). If you get the rules in the 
wrong order you can adjust the order later by going to the File menu and taking the Alter mailbox option.
You can also select rules you have already added to the list and use the buttons to Alter or Remove 
them.



Mailbox Wizard (sender)

This page of the Mailbox Setup Wizard is in two sections:

Incoming mail
Here you specify which address(es) mail should come from in order to get routed to this new mailbox. You
can pick an address from your Address Book or type in a different address. Only mail from this exact 
email address will be accepted by the mailbox, unless you use wildcards to specify a range of addresses.

the characters ? and * are interpreted as wildcards for partial matching so they cannot be used literally.

Outgoing mail
Here you supply information to identify yourself in any email messages or replies you write from this new 
mailbox.

The Email name and Name entries are used to construct the reply-to address shown in the dialog.

Using the Browse button you can select a different signature file if required.



Mailbox Wizard (subject)

This page of the Mailbox Setup Wizard is in two sections.

Incoming mail
Here you specify what the subject line of incoming email must include in order for the message to get 
routed to this new maibox:

Text which you specify here without any wildcards will match any subject line beginning with that 
text.
To match a particular word or phrase anywhere in a subject line; include the wildcard character * at 
the beginning.

 the characters ? and * are interpreted as wildcards for partial matching so they cannot be used literally.

Outgoing mail
Here you supply information to identify yourself in any email messages or replies you write from this new 
mailbox.

The Email name and Name entries are used to construct the reply-to address shown in the dialog.

Using the Browse button you can select a different signature file if required.



Mailbox Wizard (tags)

On this page of the Mailbox Setup Wizard.you must select one or more tags to be automatically applied to
all mail messages handled by this mailbox.

If you do not wish to use automatic tagging in this mailbox go Back to the previous page and select No to 
the question about tags.

In the top section there is a list of the tags available and you can select any tags to be added one at a 
time. Use the Add button to add each one to the list of Tags applied below.

Where the tag you want hasn't been set up yet, you first need to click the New tag button and set up the 
new tag you want in the Make New Tag dialog that is then displayed. The new tag will then be included in 
tags available.

You can also Remove one or more selected tags from the Tags applied list if you make a mistake or 
change your mind.



Mailbox Wizard (type)

On the first page of the Mailbox Setup Wizard you need to decide what will trigger the routeing of 
messages to this new mailbox. The choices are:

Who the mail is addressed to

Who the mail is from

The subject of the mail

Other criteria or a combination of the above

Whichever choice you make, you will be asked further details on the next page of the wizard in order to 
focus the routeing rules more narrowly.



Mailbox flashing

By default, minimised mailboxes flash when they contain something to read. If the Turnpike
program is minimised when new mail arrives the Turnpike icon will flash.

For each mailbox you are able to set 
· The mailbox to flash whenever there is any mail in the in-tray.
· to flash only when there is unread mail in the in-tray.
· or never to flash.

When you close a mailbox, it won't start flashing again until something new arrives - 
even if you have left some of the messages unread. It will start flashing again the next time 
you load Turnpike.

· To set mailbox flashing
1. Select the mailbox
2. Click File menu
3. Select Alter mailbox 
4. Select the Name tab
5. Select the flash option you want.

.
Related Topics 
Alter Mailbox dialog.
Mailboxes



Mailbox toolbar

When a mailbox is selected a number of buttons are displayed on the toolbar. The function 
of each button is given below. 

    If a button text is greyed out, that function is not available.

Address book. Calls up your Address book. 
Move to In-tray. Moves the currently selected mail message(s) to the in-tray of the 

current mailbox(s). You are also able to select and drag mail to the in-
tray 

Move to Pending. Moves the currently selected item(s) to the Pending tray of the current
mailbox(s) - You are also able to select and drag mail to the Pending 
tray (the lower part of the active window). Pending mail is highlighted 
in the lower tray of the mailbox icon.

Forward message. The currently selected mail message is copied into a new message. Fill 
in the email address of the person or persons whom you want to 
forward the message to, add a suitable covering note at the start of the
message - then click the Post button to forward the message on. 

File message. Removes the currently selected item(s) from your mailbox and saves 
them in your mailbase. You are able to recall any message as required. 

Reply A new message is set up for you to send in reply to the current 
message. This new message contains a copy of the original message, 
the subject, the email address of your correspondent, your email 
address etc. and your current signature. You edit the old message to 
include only the relevant text, add your reply - then click the Post 
button. 

Delete message. The currently selected item(s) are moved into your Waste basket. You 
are also able to select and drag mail to the Waste basket

Start new email Sets up a new message containing your email address and your current
signature. Enter an email address in the To box and a Subject in the 
subject box. If you want to send copies to someone click the Edit Mail 
Header button. Type your message- then click the Post button

Related Topics
Address book.
Forwarding mail. 
Mail lists.
Replying to Mail 
Sending Mail.
Email address 



Mailboxes

Any mail you send or receive is handled through one or more mailboxes. 

Each mailbox has:
· An In tray for the mail you receive - highlighted in the upper tray of the mailbox icon.
· A Pending tray for mail you've read but haven't yet processed...highlighted in the lower

tray of the mailbox icon.
If you have any unread mail the associated mailbox icon flashes If the mailbox is open you 
will see the new mail listed.
· Alternative Mailboxes
Unless you arrange otherwise, all your mail is put into the same 'default' mailbox. Turnpike 
enables you set up other mailboxes for any number of mail types or categories you require.

Examples are,
· Personal mail 
· Business mail
· Mail from a particular person.
· Where a certain word is included in the subject line of the message.

Any mail you receive that doesn't meet one of your categories is put into your original 
'default' mailbox. Any mail that meets more than one category will initially be shown in the 
in-tray of each applicable mailbox. When this mail is opened, in any one of the mailboxes, it 
will automatically disappear from the other mailboxes.

For each mailbox the Alter mailbox dialog enables you to specify,
· The way forwarded messages are introduced, the signature and the email name used. 
· The tags that you want applied to mail put into this mailbox.
· The colours and fonts used to display the contents of the mailbox.
· The font used when you print a message from this mailbox.

Related Topics
Setting up mailboxes. 
Mailbox setup wizard

User information 
Distributing mail to mailboxes

Alter Mailbox
Removing a mailbox

Mailbox Flashing
Mailbox Toolbar

Tagging messages through the mailbox
Setting colours and fonts
The font used to print

'The default' mailbox 





Mailing lists - Overview

Mailing lists enable anyone with a special interest to send and receive messages to and from others who 
share that interest. Mailing lists do a similar job to Newsgroups, Some Mailing lists double as newsgroups
and when they do, everything that's sent to the Newsgroup it is also sent to the Mailing list and vice versa.

Newsgroups contact people via the News feed. You may not have access to 
newsgroups particularly if you access the Internet indirectly by logging on to a network that 
has a gateway to the Internet. Turnpike enables you to convert an existing Mailing List to a 
Newsgroup.

Mailing lists contact people over the Internet Mail system. Mailing lists work by 
setting up particular email addresses as 'mail reflectors'. Any message that is sent to one of 
these addresses is then automatically copied to everyone who has 'subscribed' to the 
corresponding mailing list. When you subscribe to a Mailing list, Turnpike will filter out 
mailing list messages from your other mail and treat it as a special newsgroup.

Mailing lists newsgroups are identified by an exclamation mark before their name in the 
subscribed newsgroups list.

· Subscribing to a Mailing list has the following advantages:
· Mailing list messages don't clutter up your mailboxes.
· Messages are threaded showing you how they follow on from each other.
· On a shared system messages from a mailing list are available to everyone. This means 

that there is no need for multiple subscriptions and there is no need to circulate 
message between colleagues.

· Messages are automatically expired after a certain number of days. 

Related Topics 
Running a mailing list
Subscribing to a Mailing list
Email routeing to seats & news dialog

Envelope Rejection
Mail Rejection
Mailing Lists
Seat Routeing
Dead Letter mail

Converting a mailing list into a newsgroup
Adding newsgroups to a newsstand
Newsgroups Subscriptions dialog 



Mail Lists - Mailroom view

The Mailroom view of a mail list, is a list of all the email messages that have been sent or received by 
your system plus any articles that have been contributed to in the newsgroups.

· To open the list 
1. double-click on the filing cabinet icon 

or select Mailroom view from the Window menu.

2. Click on the buttons at the bottom of the display to see the messages in All, 
Incoming or Outgoing, and by Sent order or Arrival order.    
· The legends on these buttons always show the current selection, clicking on 

them cycles through the possible states
· To change the width of columns click and drag the vertical bars between each of 

the column headings.

Related Topics 
Mail Lists
New Mail List
Mail Symbols



Margins and tabs

Messages and articles you prepare are laid out following the markers set on the Ruler line above the 
message.

If no Ruler line is shown, select Display Ruler from the Options menu.

The main left and right margin markers are initially set to give you an average of 72 characters per line 
whatever font and typesize you are currently using to display your message on the screen.

If you use a proportionally-spaced (PS) font, some lines may have considerably more than 72 characters 
per line while others have considerably less. If any lines contain more than 80 characters, you will be 
warned of this when you post your message because such lines are difficult to display on some people's 
systems.

Between these margins are a number of default tab positions, set at every 8th character along the line. 
The scale on the Ruler line converts these character positions in the screen font into distances in inches.

In common with other Windows applications, clicking on the Ruler line places a simple tab at that point 
and clears the default tabs to the left of this position. This tab can then be dragged to a new position or 
dragged off the Ruler line if it's not required.

Dragging the right margin marker to a new position changes the number of characters your message will 
have on each line, while dragging the two parts of the left margin marker apart lets you indent your 
paragraphs. The upper part of this marker marks the start of the first line of the paragraph; the lower part 
marks the start of subsequent lines in the usual way.

Pressing Shift Tab inserts an Indent tab which indents the text that follows to the next tab position - up to 
the end of the paragraph.

When you post the message, Turnpike automatically inserts a carriage return at the end of every line and 
converts tabs and indents into spaces so that the message will have the same line breaks when it's read, 
regardless of the type of system used by the person who receives the message.



Marking out text
To mark out text you want to copy, move or delete,

either move the pointer to the start of the section of text, hold down the mouse button and then drag
the pointer to the other end of the section

or click the mouse at the start of the section of text and then hold down the shift key as you click
at the other end of the section

The text you select is shown highlighted. If you want to select the whole of a message or an article, you 
can simply click somewhere in this text, then take the Select All option from the Edit menu.



Marking threads as interesting

To mark a thread 'Interesting':

              Either: Double-click on its 'Classification' box (the leftmost of the three shown for the thread in 

the newsgroup list) until the thread is marked 
              Or: Select the thread and click on the Mark as interesting button
              Or: Select the thread and then take the Class as interesting option from the Classify menu

To mark as 'Not interesting':

              Either: Double-click on its 'Classification' box (the leftmost of the three shown for the thread in 

the newsgroup list) until the thread is marked 
              Or: Select the thread and click on the Mark not interesting button
              Or: Select the thread and then take the Class Uninteresting option from the Classify menu

If a thread has already been marked Interesting or Not interesting, you can clear this marking either by 
taking the Declassify option from the Classify menu or by double-clicking on its Classification box until 
the thread is marked 



Mirror
If you are downloading mail by POP3 you can choose to mirror your email. This means that the state of 
your mailbox on your Access provider's server will match that of your Turnpike mailbox. If you leave email 
in a Turnpike mailbox, a copy will also remain on the server. If you file or delete the email in Turnpike, it 
will be deleted from the server next time you connect.

This option is useful if you want to dial in and read your mail from more than one place. Remember, 
though, that the email will be deleted from the server next time you log in if you delete or file it in 
Turnpike. You can choose whether or not to mirror POP3 email by going to the Connect program, 
selecting the Configure menu and then choosing the Email Transfer option.



Missing articles

The Connect program shows the number of news items downloaded. These may be headers, bodies or 
complete articles. Because of this, and other reasons outlined below, the number reported by Connect 
won't necessarily match the number of new articles that appear in your newsgroups, so any discrepancy 
in these figures is unlikely to indicate a problem of missing articles.

Firstly, the totals in the newsgroups don't include articles in threads that have been marked Uninteresting. 
They also don't include articles killed by kill rules, even though the headers of these articles will have 
been downloaded (and counted by Connect) in order to check them. Moreover, articles that pass the kill 
criteria are counted twice because the headers and the bodies are downloaded separately - so even if 
your rule fails to kill anything at all, Connect's item count will be twice the number of articles received.

On the other hand, articles which have been cross-posted to several newsgroups are only fetched (and 
counted) once by Connect, but they will feature in the count of each of the newsgroups to which they 
have been posted.

Another reason for a discrepancy in the numbers is that you may be collecting news for newsgroups 
which no longer appear in a newsstand - although Turnpike does check that all subscribed newsgroups 
appear in someone's newsstand whenever someone with permission for news administration signs on 



Moderated groups
A moderated newsgroup is one in which contributions aren't posted directly to the newsgroup but instead 
are initially sent by email to a 'moderator' who decides whether the articles are appropriate for inclusion in
the newsgroup. This procedure improves the quality of the contributions to the newsgroup and keeps the 
discussions on target, but at the cost of a slower response rate.



Moving Turnpike to another machine/system

If you want to move Turnpike to another PC or you upgrade your PC to a different operating 
system,

 Don’t try just copying all the old files from your old system to the new one. 

· You should complete the following procedure, 
1. Use the Turnpike Setup program to re-install an appropriate version of Turnpike on 

the new system.

2. Copy the TURNPIKE.USR and CALLS.TPK files, the NEWS directory, the MAIL 
directory and the USERxxx directories (together with any special .ACC, .CST 
or .MDM files you use) from the old Turnpike directory to the new one (replacing any
that might already be there).

3. Run both the main Turnpike program and the Connect program and check that each
of these are set up as you require (as described in the System Administration 
section of the Turnpike Setup book).

If you are asked for your Site ID and your Site Secret, be sure to give the same ones 
as were given when Turnpike was originally installed.

If you use a different Site ID or Site Secret you will be unable to read any of
the mail you transfer from the old Set-up.

Related Topics. 
Rebuilding data files 
Backing up your Turnpike files.



Moving and Upgrading Turnpike

Click on a topic:

Backing up your Turnpike files

Moving the Mail and News Directories

Moving Turnpike to another machine

Upgrading to the latest version of Turnpike

The Multiple-Access version of Turnpike



Multiple Access
The standard Turnpike software can be used by up to 99 people, but it is a 'single user' version, which 
means that you can only have one copy of Connect and one copy of Turnpike running at the same time 
(although they do not necessarily have to be on the same machine).

If you wish to install Turnpike on a LAN (Local Area Network), with a copy of the offline software on each 
workstation, run the Turnpike Setup program on your central server, choose 'custom install' and then 
select Turnpike Workstation Setup. This will place a special setup program on your central server from 
which Turnpike can be installed onto each workstation.

LAN Administrators should note that mail that has been collected by Turnpike can be accessed across the
network by other mailreading software if you enable the POP3 Server option, although again only one 
person at a time can use the standard version of Turnpike.

If you require more than one person to be able to use Turnpike simultaneously, you will need a Multiple 
Access version of the program. This still uses just one copy of Connect, but allows you to have multiple 
copies of the Turnpike program running, up to the number of seats purchased. Email info@turnpike.com
for further details.

See also System administrator.



New Mail List

On a shared system, the default Mailroom view of your mail will show all messages to and from all users 
of you system in one list. You are able to create New Mail lists which contain only that mail you want to 
see.

· To Create a New Mail List
1. Click File in the menu
2. Select New mail list the Mail     List     Setup     Wizard   will start. 

This wizard will enable you to create a New Mail list based on mail tags, a particular 
person or a further copy of the mailroom.

You will only be able to see a list of mail on a particular topic if that mail has been 
tagged.

· Using the Address Book to Create a New Mail List
1. Open a mail list containing the mail you want to filter
2. Click on the Address book button in the toolbar
3. Select a name from the address book. Any name listed can be selected
4. If you are not sure you have selected the correct name, click the View/Alter button 

on the toolbar to display the address book entry dialog. If the details are those you 
want click the Messages button in the dialog
Otherwise just click the Messages button on the toolbar. A new mail list will appear 
or advice that there are no messages.

· The address book entry dialog will also appear if you double-click on a name in the address 
book

· The messages listed in a New Mail list created using the Address book will be those sent to or 
received from the email address(es) listed in the 'File as' section of the Address book entry. 
Ensure the file as entry is incomplete to see a complete list of messages. 

· Each New Mail list is shown as a folder on your Turnpike desktop. You are advised to 
shut any New Mail lists that you no longer require 

· To shut an New Mail List 
1. Click on the folder icon 
2. Click on the shut button 
Or with the list window open click the shut button. 

The list window will close and the folder icon will disappear. The shut button is disabled in
the default mailbox to ensure that you always have access to at least one copy of the 
mailroom. 

    Mail will continue to be added to your mailbase even when the mail list and New Mail 
lists have been closed



Related Topics 
Mail Lists
Mail Lists - Mail Room View



News

Depending on the sort of information you are looking for, either pick from the following list of topics:
Advice to new users
Newsstands
Newsgroups
Discussion threads
Subscribing to newsgroups
Download options
Reading news
Numbers of articles
Picking out interesting articles
Killing unwanted articles
Restricting access to newsgroups
News article headers
Posting news
Binaries
FAQs
The symbols used to mark news articles/groups
Buttons and menus

Or select from pop-up lists of 'How-to' instructions on the following actions:
Setting up a newsstand
Reading newsgroups
Contributing to newsgroups
Sorting out interesting articles
Saving articles
Saving/Recovering the newsbase



News article - Kill Rules dialog

This dialog enables you to set up or modify the details of a Kill rule.

This dialog is displayed both when you,
· Selecting the Custom rule option from the main Kill article dialog
· Select the Review option from the Kill Article dialog and then select the Add or Alter 

button.

You set up one rule each time you call up this dialog.

The Accept option enables you to retain articles that would otherwise be killed by one or 
other of the 'Reject' rules. In a Browse group, an Accept rule will allow articles meeting 
the conditions of the rule to be downloaded in full automatically.

· To set a rule
Select the option to Accept or Reject articles with the following properties.

Written by enter their email address 

Subject line matching    - enter text you want to match.

Longer than - How size of the article as given by the Lines entry in its header. Enter 
the number of lines for which you want to accept or reject the article.

Custom Rule This allow you to enter a rule not covered by the above properties

Related Topics 
Killing articles
News article kill rule dialog
Custom Kill rules
Custom Kill rules -examples

Defining Custom Rules.
Custom rules: Formal syntax.



News Header

Every news article starts with a Header which specifies such things as the subject of the article, which 
newsgroup(s) it is being contributed to and who wrote it. This Header has a number of component lines, 
some of which are always included while others are optional. The principal lines are as follows:

Path: recording the systems through which the article has been passed
From: giving the email address of the sender
Newsgroups: listing the newsgroups to which the article is being contributed
Subject: giving the subject of the article
Date: recording when the article was posted
Organization: giving the author's affiliation
Message ID: giving the article's ID number (guaranteed to be unique)
Followup-to (optional): giving the group to which an Follow-up articles should be posted
References: listing the IDs of the articles to which the article is a Follow-up (if applicable)
Keywords (optional): listing one or more keywords for the article (not used directly within Turnpike)
Summary (optional): giving a brief summary of the article - useful for readers who just 'browse' the 
newsgroup

In addition, News Headers may include non-standard lines with names starting X-. For example, many 
news articles start with an X-ref line which records cross referencing information used by the News server
from which you get your News.

In general, all you want to know about an article you read is its subject, who wrote it, the date when it was
posted - plus details of any additional newsgroups to which it has been posted and any special Follow-up 
instructions that have been set. So this is the Header information that Turnpike normally displays about 
the message you read. To see the full Header, select Display Header from the Options menu.

Similarly, when you are preparing an article for posting, you generally only need to think about the subject
and which newsgroup you wish to post it to - so this is what is normally displayed. The other parts of the 
Header are automatically set for the standard case in which any Follow-ups should be posted to the same
group. If you want to specify a different newsgroup for the reply or you want any replies by mail to be sent
to a different address, click the Edit News Header button shown at the top of the article you are preparing
and set the details you require in the News Header dialog that appears.

Related Topics
News Header dialog.



News Header dialog

This dialog lets you set or change lines in the Header of the news article you are preparing (although not 
the name of the Sender of the message - this is automatically defined by which system is being used and
who is the current user of that system).

It is displayed by clicking the Edit news header button shown at the top of the article. The main aspects 
you can set are:

Subject: A brief description of what the article is about.

Newsgroups: The name(s) of the newsgroup(s) to which the article is to be posted (separated by 
commas).

Followup-to: The name of the newsgroup to which any Follow-up articles are to be posted (if this is not 
simply the group in which the article appears).

From: Your email address.

Reply-To: The email address to be used for any reply by email.

Keywords: Any keywords under which you would like the article to be picked out by any automatic 
selection process that uses these keyword entries to select articles for reading. (Optional)

Summary: A brief summary of the article - useful for readers who just 'browse' the newsgroup. 
(Optional)

In addition, you can add any further Header lines you require in the Other box in the lower part of the 
dialog.



News buttons and menus
When you are working in a newsstand, you are offered a toolbar plus the following menus:

File
Edit
Search
Article
Classify
Options
Window
Help

For details, click on the appropriate entry.



News symbols

In the list of newsgroups:
First column (Number of Interesting articles to be read)

Newsgroup that hasn't yet been threaded (processed to identify how the articles interlink) - or 
which needs to be re-threaded

Newsgroup that has been threaded

Second column (Number of unread articles)
Newsgroup that hasn't yet been threaded
Newsgroup that has been threaded

In the list of discussion threads:

Thread you've picked out as Interesting

Thread that hasn't been marked either as Interesting or as Not interesting

Thread that you've marked as Not interesting

Unexpanded thread (Double-click on this symbol to see full details of the thread)
Expanded thread

Unexpanded user-defined thread

Expanded user-defined thread

Thread containing unread articles
Thread that has been read

Thread of articles that are being kept beyond their normal expiry time

The tick means the thread you have opted to download in full (Browse groups only) The adjacent 
symbol is typical and can be anything valid

In expanded threads:

Unread article

Article that has been read
Article of which only the header has been downloaded (If you don't know why this might be, click 

here)
Article of which only the header has been downloaded but this includes a summary
Article which isn't immediately available

Article which you have requested to be downloaded the next time you go on-line

Article within a thread that you have opted to download in full (Browse groups only)
Article that was requested but is no longer available from your news server



Article which you have asked to keep past its normal expiry time
Article that you have 'killed'

In articles:

 or 

 (on a horizontal bar) Text 'signed' using author's PGP signature

A spoiler. Pressing the button usually reveals an answer.



'Newsgroup Addition' dialog

The 'Newsgroup Addition' dialog appears when you click the Add button at the bottom of a newsstand.

The top part of the dialog helps you select the newsgroups you want. As you pick each newsgroup out, 
this is added to a list in the lower part of the dialog, so that you can see what you have picked out so far. 
(This lower part of the dialog also includes a Remove button to use if you decide you don't want a 
particular group after all.)

The Ratings button lets you call up a display of the way in which the currently selected newsgroup is 
rated under the various ratings services you are using.

You pick out the newsgroups you want, one by one from the list in the top part of the dialog. This list is 
initially set to show the groups which are currently subscribed to (ie. downloaded to your site) - but if you 
have News Admin permission, you can switch it to show all the newsgroups available from your Access 
provider's news server by selecting the option you require to the right of the list.

If you know which hierarchy the newsgroup you require belongs to, start typing this in the Find slot at 
the top of the screen. The newsgroup display will then automatically move to the appropriate part of 
the list, from where you can scroll until you spot the group you require.

If you just know the topic you are interested, type *topic in the Find slot, then use the Find first and 
Find next buttons to work through all the newsgroups that have this topic in their title until you find 
the one you want. (Click here for further information on this.)

When you've found the entry for the newsgroup you want, either double-click on it or click the Add button 
to add it to the list in the lower part of the dialog.

Simply go on selecting newsgroups in this way until you have pick out all the ones you want. Then click 
the OK button to return to the newsstand.

If you add any groups to which you have not yet subscribed, you will be asked if you want to add them to 
your subscription list. (Click here for further information on this).



Newsgroup Rating Services dialog

This dialog is displayed by clicking the Ratings button within the Edit Sign-on Details dialog (or by clicking
the corresponding button within the Edit Workgroup Details dialog when the ALL workgroup is being 
edited).

The top part of the dialog shows the names of the newsgroup ratings services that are currently in use, 
together with details of the maximum levels currently in force for each of the different categories covered 
by each ratings service. Note: If you don't have Ratings permission, these details are shown for 
information only: you won't be able to change anything.

While the cursor is on the name of a service (or this part of the display is blank), you are offered the 
option to: Add a new service; Remove the selected service; and to set whether unrated newsgroups 
should be Shown (treated as innocuous) or Hidden (treated as potentially offensive) - assuming you 
have suitable permission. Details of the selected service are shown at the bottom of the dialog.

While the cursor is on a category, you'll see instead the range of levels that are available in this category, 
together with a description of what the current maximum level represents and of the type of newsgroup 
that might have this rating. Assuming you have suitable permission, you can change the maximum level 
for this category simply by picking from the set offered - but note that any settings you make that select 
levels regarded by the ratings service as unsuitable or potentially illegal will be rejected when you come to
leave the dialog. You will need to pick a lower level instead.



'Newsgroup Subscriptions' dialog

This dialog allows someone with News Admin permission to pick out newsgroups to subscribe to and to 
set such information as:

How long the articles should remain on your disk (ie. their Expiry time)
Whether the articles should be copied to your disk in full or, for example, just 'browsed'

It is also the dialog to call up when you want to cancel your subscription to a newsgroup or to limit who 
can read a particular newsgroup.

It is called up by taking the Configure option from the File menu, then selecting Newsgroups from the 
submenu that appears.

Clicking the Subscribe button calls up the News Subscription dialog, through which you can pick out 
additional newsgroups to subscribe to.
Clicking the Unsubscribe button cancels your subscription to the currently selected newsgroup.
Clicking the Access button calls up an Alter Usage dialog though which you can specify which users 
can have access to the currently selected newsgroup.
Clicking the Ratings button calls up a display of the way in which the currently selected newsgroup is 
rated under the various ratings services you are using.

To view or change the subscription information set for any of the newsgroups you subscribe to, select the 
newsgroup in the upper part of the dialog (you can use the standard Windows techniques of shift-click to 
highlight a contiguous selection or control-click to highlight a non-contiguous selection). The lower part of 
the dialog then changes to show the details currently set for this group. (The name of the group for which 
the details are being shown is also included in this area of the dialog.) These details cover:

Type:          Set to either: Full     ie. all the articles contributed the newsgroup copied to your disk in full
Browse      ie. just the headers of the articles copied to your disk

Moderated: This check box needs to be selected if the group is known to be moderated. Leave this 
setting as it is unless you know for certain that the current setting is incorrect.

Expire after: Set to the number of days any article in the newsgroup should remain on your disk, after 
which it will be automatically deleted when Turnpike 'expires the news' (usually done automatically 
whenever the Turnpike Connect program is run).

Auto Keep: Select this check box if the articles in the newsgroup are to be automatically marked to be 
kept past their normal expiry time. Note: The Keep markers this places on the articles can be removed 
using the standard Cancel Keep option if it turns out that you don't want to keep these articles after all - 
see Keeping news articles. Clearing this Auto Keep option just stops future articles being marked as to 
be kept.

Last NewNews: Sets the date from which Turnpike will take new articles in this group the next time news 
is collected from your News server. This is normally simply the date articles were last collected but you 
can set a different date using the last/now plus/minus and time options. The date shown automatically 
changes to the date you've selected so that you can check that you have made the correct settings.

IMPORTANT: If you change any of these subscription details, be sure to click the Apply button before 
either leaving the dialog or going on to set or view the details of another newsgroup. Otherwise the 
settings you've made will be lost.



About Newsgroups

A huge number of articles are posted to the Usenet network each day and on a vast range of topics. So to
help you pick out the ones you want, the articles are organised into a system of 'newsgroups', each 
covering a separate area of interest.

In Turnpike, you pick out the newsgroups you are interested in following by allocating them to a 
'Newsstand'. You can then see the different discussions that are going on in these newsgroups and the 
articles that have been contributed by going into your newsstand and opening the different newsgroups 
you've selected in turn. For further information, see Reading News.

New newsgroups appear and old newsgroups disappear almost daily so whenever Turnpike picks up 
articles it also picks up a list of amendments to make to the list of newsgroups it offers. Alternatively, you 
can ask Turnpike to pick up a complete new list through the Configure Usenet News dialog in Turnpike 
Connect. This is particularly useful if you change the News server you use (eg. because you change 
Access provider) because not all News servers carry the same range of newsgroups.

If you can't find a newsgroup that covers your particular topic of interest, keep looking because the 
chances are that there will be one. If there really isn't one, it is possible to set up a new newsgroup 
but there's a formal procedure to follow through which you find out whether anyone else agrees that a
new newsgroup is needed:

Related Topics
Setting up a new newsgroup.



Newsstand Setup Wizard
You start the Newsstand Setup Wizard by going to the File menu and clicking New newsstand. The 
wizard will guide you through the process of setting up a new newsstand. On the wizard pages you can 
specify:

which newsgroups will be displayed in this newsstand
information to identify yourself when you reply to or followup news articles
the name of the newsstand

You can move backwards or forwards through the wizard pages to check or change the details using the 
Back and Next buttons. Or you can abandon creating the newsstand by pressing Cancel on any page. 
When you press Finish on the last page the new newsstand will be created.

You can change the contents of the newsstand later, using the Alter, Add and Remove buttons at the 
bottom of the window. You can also change the other properties by right-clicking the newsstand and 
selecting Properties.

Related Topics 
Newstands



Newsstand Wizard (name)
This is the last page of the Newsstand Setup Wizard. Here you can keep the suggested name for the new
newsstand or type in another unique name.

You can move backwards and forwards through the wizard pages to check or change the details you 
have entered using the Back and Next buttons.

When you press Finish here the new newsstand will be created.

You can further customize or change the contents of the newsstand later if required, using the Alter, Add 
and Remove buttons at the bottom of the window or by taking the Alter newsstand option in the File 
menu.

Related Topics 
Newstands



Newsstand Wizard (newsgroups)
On the first page of the Newsstand Setup Wizard you can add one or more newsgroups to the new 
newsstand. If you prefer, you can just leave the newsstand empty for the moment and add the 
newsgroups you require later.

The top part of the page initially shows the newsgroups to which your site is currently subscribed (i.e. 
downloaded to your site). You can switch it to display all groups available from your Access provider's 
news server, providing you have News Administrator permission.

Pick out the newsgroups you want, one by one, from the list in the top part of the page. As you do so, they
are added to a list in the lower part of the page, so that you can see what you have picked out so far. This
lower part of the page also includes a Remove button to use if you decide you don't want a particular 
group after all.

The Ratings button lets you call up a display of the way in which the currently selected newsgroup is 
rated under the various ratings services you are using.

If you know which hierarchy the newsgroup you require belongs to, the best way to pick this out is to 
start typing this in the Find slot at the top of the screen. The section shown in the box will 
automatically move to the appropriate part of the list, from where you can scroll until you spot the 
group you require.

If you just know the topic you are interested in, type *topic in the Find slot, then use the Find first and
Find next buttons to work through all the newsgroups that have this topic in their title until you find 
the one you want. (Click here for further information on this.)

When you've found a group you want to add, click the Add button. The newsgroup is then added to the 
list of Additional newsgroups at the bottom of the screen.

Simply go on selecting newsgroups in this way until you have picked out all the ones you want.

Related Topics 
Newstands



Newsstand Wizard (profile)
On this page of the Newsstand Setup Wizard you supply the information to identify yourself when you 
reply to or followup news articles. The details you can set are as follows:

Email name: Which of your email names should be used where your email address is quoted

Name: The full name to be quoted

Signature: Which of the various signatures you've got saved on disk should be used. (Use the 
Browse button to select a different signature file if required.)

Related Topics 
Newstands



Newsstand toolbar

Open newsgroup
Opens the currently selected newsgroup.

Close newsgroup
Closes the current newsgroup and returns you to the list of newsgroups in the newsstand.

Redisplay newsgroup
Calls up the list of threads and articles in the current newsgroup.

Next
(Not to be confused with the 'Next unread' button) Clicking this button displays the next article in the 
current group, working through the group thread by thread - regardless of whether this article is marked 
Read or Unread.

Previous
Clicking this button displays the previous article in the current group, working back through the group 
thread by thread - regardless of whether this article is marked Read or Unread.

Next unread
Clicking this button displays either the next unread article in the current discussion thread, working 
through the group thread by thread, or the next discussion in which there is an unread article.

Mark as interesting
Causes the currently selected discussion to be marked as Interesting, which means that this discussion 
thread will be moved to the top of the list of discussions the next time the newsgroup is re-threaded. For 
more information, see Picking out interesting articles.

Mark not interesting
Causes the currently selected discussion to be marked Uninteresting, which means that this discussion 
thread will moved to the bottom of the list of discussions the next time the newsgroup is re-threaded.

Request article
Specifies that you want the currently selected article to be downloaded in full the next time you connect to
the Internet. (Only active when you have selected either a missing article or one for which only the header
has been downloaded.)

Reply/Follow-up
Starts the process of responding to the currently selected article - either through a Follow-up article sent 
to the newsgroup or through an email message sent to the author of the article. When you click this 
button, Turnpike asks which method you wish to use.

Mark all as read
Clicking this button marks every article listed in the current newsgroup as 'Read' regardless of whether 
you've actually opened it or not. Turnpike won't bring any of these articles to your attention again - nor will
they be picked out when you ask to see the 'Next unread' article (unless you switch the marking back to 
Unread).

Related Topics 
Newstands



Newsstands

The news articles you download from your News server are accessed through one or more 'Newsstands'. 
Each Newsstand has a selection of newsgroups associated with it and the articles that have been 
contributed to those newsgroups are effectively placed in the corresponding Newsstand.

There are a number of different levels at which you can view a Newsstand.

The 'highest' level is a list of all the newsgroups (and mailing lists) that are downloaded to that newsstand.

 and 

 boxes beside a newsgroup in this list means that it hasn't yet been processed to identify how the 
articles interlink. When the newsgroup has been threaded, the boxes are filled in with the number of 
unread Interesting articles and the total number of unread articles respectively. (Totals covering all the 
newsgroups in the newsstand are shown on the status bar at the bottom of the newsstand, together with 
buttons that allow you to change the range of newsgroups and other aspects of the newsstand in various 
ways.)

To see the articles that have been contributed to a particular newsgroup, you simply need to 'open' this 
newsgroup eg. by double-clicking on its name in the list of newsgroups in the newsstand. The newsstand 
then changes to show you a list of the current discussion threads in this newsgroup, in the following order:

1. Threads containing unread articles, with any you've picked out as interesting (marked  ) 
shifted to the top.

2. Threads in which all of the articles have been read (again with interesting threads coming first).

However, if you have picked out any threads as uninteresting (marked  ), these will all appear at 
the bottom of the list, with any threads containing unread articles appearing first in this group.

Within these various categories, threads are presented in date order, with the oldest first.

These are just a few of the symbols with which newsgroups and articles may be marked: click here to see
a full list of the symbols.

In the simplest case, you might add every newsgroup you follow to the same Newsstand, but you can if 
you want, sort the newsgroups into different categories by setting up further newsstands.

For information on how you view the articles themselves, see Reading News.



How many articles

Before calling up a particular newsgroup, it is useful to know how many articles there are available to read
in that newsgroup and in particular, how many have been contributed to the threads that you are finding 
interesting.

So when you go into a newsstand, Turnpike shows you how many unread articles there are in each 
newsgroup (in the green box) and (in the yellow box) how many of these articles are in threads that 
you've marked as interesting - with overall totals at the bottom of the newsstand. Then when you go a 
newsgroup, it shows for each thread the total number of articles in the thread (in the blue box) and the 
number of these that are unread (in the green box) - with totals for the numbers of unread and interesting 
articles at the bottom.

The Connect program also shows a total for the number of articles fetched when news is being collected. 
But this won't necessarily be the number of new articles you are offered to read in your newsstands.

For a start, the figure given in the Connect program is the total number of items fetched, whether these 
are full articles, headers or bodies. For newsgroups downloaded in full and 'browse' groups, the number 
of items downloaded will match the number of new articles shown in your newsstands. But if any Kill rules
have been set for a newsgroup, Connect will fetch the headers first, apply your rules then fetch any 
bodies that are required. As a result, each article that isn't killed is counted twice. Indeed, if you've set up 
rules for every newsgroup but no articles are actually killed, you will appear to fetch twice the number of 
articles you get to read.

Furthermore, the articles that are killed by the rules are included in the number of items that were fetched 
but not in the totals shown in the newsstand because you are not expected to want to read these.

Another thing that will make a difference is if you have marked any threads as uninteresting. Articles 
contributed to these threads are also included in the count of items fetched but not in the totals of unread 
articles - again because you are not expected to want to read these.

Cross-posted articles also affect the arithmetic as these can be counted twice (or more) in the 
newsstands but are only fetched once.



Offline Browsing

URLs in mail or news messages are shown as a button. Buttons are labeled as appropriate 
eg http,.ftp mailto,    etc 

When you click a button the Save URL dialog usually appears. This dialog gives the full URL 
address for the selected item and a prompt describing from where the URL was obtained. 

If you click on a mailto button, a Mail Message form will appear for you to complete as you 
wish

The Save URL dialog will also appear when you click Extract URL from the Edit menu. If 
nothing in the message is highlighted when you click Extract URL the dialog will containing a
list of all the URL’s in the message and a prompt describing from where the URL was 
obtained.

If a URL is selected when you you click Extract URL, the dialog will containing just the URL 
selected.

If you recognise a section in your message as a URL (and no button is presented), highlight 
the item then select Extract URL to display the dialog. If no URL is present in a message 
when you select Extract URL a message will advise you of this fact.

If you recognise a section in your message as a URL (and no button is presented), select 
Extract URL, highlight the item and then save, launch or copy the item. 

· Accessing hyperlinks saved while reading mail and news

When you Save an item, it will be saved typically to C:\tp305\USER001\LINKFILE.HTM.

If you are already browsing, a new window will be created in most Win95 browsers. This may
fail to succeed for Win3.x browsers 

To access the link file. 
1. Start your Internet Browser
2. From the Favorites select Turnpike Stored Link.

A page will be displayed listing the hyperlinks that you have extracted whilst reading mail 
and news within Turnpike. Click on a link to open it in the usual way. 

One Delete link button is associated with the each group of URLs you save.

Configuring your browser to remove stored links.

If you are using IE3, Netscape 4 or later your browser will be set up for you. When you click 
Save the link is saved typically to C:\tp305\USER001\LINKFILE.HTM. As you save links these
will be added to you link file each with a Delete Link button. When you click the Delete Link 
button the link will be removed. Refresh the link page and the references    will disappear. 



If you use an earlier or different browser you may not be able to remove the links. 

Users of other browsers:

1. Add \turnpike\user001\linkfile.htm to the favorites menu.

User001 is added by the SETUP program you are able to add user002 etc as you want.

 2. Add a viewer for a new MIME type where;

The MIME type is for Turnpike Link Files
The Content type is application/x-turnpike-link-file
The File type is    .tlf.    The open action for this type of file should be 

c:\turnpike\turnkick.exe REMOVELINK %s

where you will need an appropriate path for your machine, and %s is your browser's 
convention for parameter passing.

Related Topics 
File/ Configure/ Browsing
Edit / Extract URL
Save URL dialog 



Offline Browsing Options Dialog

This dialog is displayed when you select Offline Browsing from the File/Configure menu. 
This dialog is used to set up the default program that you want to use to fetch URLs from 
Turnpike when offline. 

Normally Turnpike uses the registry to find an appropriate program to fetch URLs. You only 
need to enter a Program and possibly any associated parameters if some of the URLs you 
have are not recognised and if you want to stop Turnpike using the registry.

When you enter a program name check the Always use this program to fetch URLs option, 
otherwise this option should be clear. 

The Fetch URLs only if connected option is checked by default. 

If you deselect this option, and if you are online when you click a Launch button for a 
selected URL your browser will open and you will go to the URL selected 

Related Topics 
Offline Browsing
File/ Configure/ Browsing
Edit / Extract URL
Save URL dialog 



Opening/Closing newsgroups

To see what discussions are going on in a particular newsgroup and what articles have been 
contributed,    'Open' that newsgroup. 'Close' it again when you want to move onto another 
newsgroup.

To open a newsgroup
· Double-click on its icon, 
· Or select it and click the Open newsgroup button (or select the corresponding option 

from the Article menu).

To close a newsgroup
· Double-click on the control box of the newsgroup display, or
· Or click the Close newsgroup button (or select the corresponding option from the 

Article menu)

Related Topics 
Article Menu



Options menu

Font
Colour
Display Header
Display 'raw' text
Display Ruler

In Mail only:
Date format



    
Options menu: Colour
Displays a Colour Selection dialog from which you
can select the colours used to display certain 
types of text. This is a temporary setting which 
will be lost when you close the current window. 
Permanent settings are made through the Colour 
pages of the Mailbox dialog and the Newsstand 
dialog.



    
Options menu: Date format
This option enables you to set how the dates of 
messages are displayed either in a mailbox or in 
other mail lists.    For more information, see 
'Setting the way dates are shown'.



    
Options menu: Display 'raw' text
Displays any files in the current message that 
Turnpike has parcelled up into horizontal bars in 
their raw 'uuencoded' form.



    
Options menu: Display Header
Controls the display of full information about a message/article (as distinct 
from the brief information that Turnpike automatically displays).

When this option is checked, the message/article's header is shown in full at
the start of the message / article. De-selecting the option removes both the 
header from the display.

The different components of these headers are explained in the sections on 
'Mail Headers' and 'News Headers' respectively.



    
Options menu: Display Ruler
Controls the display of a ruler line (complete with 
margin and tab markers) above the 
message/article text. When this option is checked,
the ruler line is displayed. De-selecting the option 
removes the ruler from the display.



Options menu: Font
Displays a Font dialog through which you can select 
typeface, typestyle and typesize used to display the 
current message / article on the screen. This is a 
temporary setting which will be lost when you close the
current window. Permanent settings are made through 
the Font page of the Mailbox / Newsstand dialog.



The Out tray

Each mail message or news article that you 'post' is initially placed in your Out tray. The Out tray icon 
changes to show that it contains something waiting to be sent. To see what's currently in the Out tray, 
double-click on its icon or select it through the Window menu. A message normally stays in the Out tray 
for at least one minute (in case you want to change your mind). After that it is either

sent on its way if you are already connected to the Internet or if it is destined for a local address (e.g. 
on your own machine or local network), or
held in the Out tray until you next connect to your Access provider.

If you want to clear the Out tray immediately. In the Connect main screen, click the Connect button to go 
on-line, then click the Start button to Send mail. 

If you need to make a change to a message that's waiting in the Out tray, either open it within the Out tray
and say you want to edit it or drag it to a clear area of the Turnpike desktop. Make whatever changes you 
require then re-post it. If you are on-line a message will only stay in the out tray for one minute.

Click here for an explanation of symbols seen against messages / articles in the Out tray. 



POP3 server options

The POP3 Server options included in Turnpike allow users to access the mail in their Turnpike mailbox 
from outside their Turnpike system - either from a copy of Turnpike running on a machine that doesn't 
have direct access to your mailbase or from another mailreader.

This is a specialist facility intended for use in an office where mail for everyone in the company is 
collected using Turnpike but people don't necessarily always want to use Turnpike to read their mail.

It is not intended for use on a single-machine dial-up system. To use this facility the Connect program 
must be running. Also there must be a live TCP/IP connection between the machine on which Connect is 
running and the machine from which the mailbox is accessed.

 This facility will open a route whereby people from outside the company could potentially access 
users' mail. For this reason, this facility has to be specifically enabled,

· either through the Services menu POP3 Server option or through the 'Enable POP3 Server' 
option in the Configure Email dialog. 

· for each individual user who is allowed to access their mailbox in this way (by giving them 
Serve POP3 permission within the main Turnpike program's Configure Users dialog).

· and in addition, the system requires any user wishing to access their mail in this way to give 
their Turnpike sign-on password.

    Ensure that any users for whom this facility is turned on don't have a blank password, If the 
password is blank it will be just too easy for someone outside the company to impersonate them.

Calling up a Turnpike mailbox from outside counts as an access to the Turnpike system. With the 
standard 'Single access' version of Turnpike, you can't call up your mailbox while anyone is using the 
main Turnpike program and vice versa. With the 'Multiple access' version, users are able to call up their 
mailboxes at the same time as others use the main Turnpike program but only up to the number of seats 
on the system.

 For further details refer to the Configure email send and receive dialog in the Connect program



    
Password
Turnpike includes the option of making access to the system - and in 
particular to someone's personal mail files - dependent on giving the correct
password. Whenever a password is typed or displayed, the screen shows * 
characters representing the actual characters of the password.

You may have had a password set for you by your system administrator. 
You are able to set a password for yourself in the Edit Sign-on details dialog 
If you forget your password someone with Alter Users permission can set a 
new password for them in the Edit Sign-on details dialog.



    
Permission
Turnpike has sixteen administrative functions. Permission to use these 
functions applies generally to a multi-user system where family members 
share the same computer, or where a number of users share Turnpike on a 
network. Individual permissions may be set by anyone with Alter Users 
permission through the Edit sign-on dialog; Permissions associated with 
membership of a workgroup may be set by anyone with Alter Workgroup 
permission through the Edit workgroup dialog.

Click here for details of all permissions and the actions that they control.



Picking out interesting articles

Within any newsgroup there are bound to be some discussion threads that interest you and others that 
don't (and others that you are neutral about). To save you wasting time calling up articles that don't 
interest you, Turnpike lets you mark different threads as Interesting or Not interesting.

Where only a part of a discussion interests you, Turnpike lets you break off part of the discussion and 
mark it Interesting or Not interesting as you require: see Breaking threads.

The level of interest that's been expressed in a thread is shown in the left-hand column of the list of tiles. 

Threads that have been picked out    as Interesting are marked ; ones that have been picked out 
as Not interesting are marked 

 - while ones that haven't been classified (or which you are neutral about) are marked 

.

When you go into a newsgroup or re-thread it, Turnpike automatically arranges that Interesting threads 
with articles waiting to be read are placed at the top of the newsgroup, while Not interesting ones are 
placed at the bottom and are ignored when you ask to read the 'Next unread' article. (Interesting threads 
that don't contain anything new to read are placed after any 'Neutral' threads containing unread articles.)

See also marking threads as interesting or not interesting.

When you come to the end of the articles that you want to read in a newsgroup, you can avoid calling up 
any others from this newsgroup by clicking the Mark all as read button. Then clicking the Next unread 
button will skip the remaining articles in the group and take you to the Interesting discussions at the top of
next newsgroup.



Posting & Re-posting Messages

· Posting a message
When you are ready to send the mail message or article you've prepared, simply click the Post button
on the toolbar above the message. 

After a confirmatory message, the message is placed in your Out-tray. The message will be sent on 
over the Internet the next time you connect to your Access provider. If the message is large it will be 
divided into two or more parts labelled [1/2], [2/2] etc.

· Re-posting a message
Call up a mail list which contains this message, or the Mailroom view of everything sent and received.
Drag the message either to your Out box or onto the Turnpike desktop. 
The message then opens ready for you to make any changes you want to or to simply re-post the 
message

Dragging a messsage will not change the range of tags on the message.

If a divided file fails only re post that part. It will then be re-amalgamated with those parts of the message 
that were successfully transferred the first time.

Related Topics
Preparing News / Mail messages.



Posting News

The process of contributing an article to a newsgroup is known as 'Posting News'.

The article you post will either be a response to an article that you read (in which case it is referred to as a
'Follow-up article') or it will start a new discussion (referred to as 'Starting a new thread').

After posting, the article is added to your mailbase, stored under the name of the newsgroup to which you
contributed to the article. So if you need to re-post an article or to copy and paste it to another message, 
you should be able to find it easily enough by calling up the Mailroom view of everything you've sent or 
received.

Click here if you want to know more about Responding to the articles you read.
Or here if you want to know about Starting a new thread.
Or here if you want to know about Cancelling articles that you post by mistake.

(By the way, you don't have to finish each article you start before going on to something else: just leave it 
open on the screen or minimised as an icon. Turnpike will automatically save it on disk for you, and it will 
still be there when you come back to it, even if you've left Turnpike in the meantime.)

You are strongly recommended not to post any articles to a newsgroup until you have studied the 
articles that are contributed to that group over some weeks and studied any FAQs that are posted to that 
group.

Furthermore, new users are advised to start by posting a few trial articles to one of the test newsgroups, 
such as demon.test. These test groups are sometimes read by people who are prepared to give friendly 
advice when you don't follow the correct conventions - rather than the rude comments you will receive if 
you break the rules in an article you post to a 'real' newsgroup.



Posting a picture

If you have a picture that you want to post to one of the binaries groups, you need:

Either to start preparing a new article in the usual way, then click the Insert File button (or take the 
equivalent option from the File menu) and use the File Selector that is displayed to pick out the file 
containing the picture you want to post.

Or, if you can arrange to see both Windows File Manager and your Newsstand on your screen at the 
same time, you can simply drag the file to the appropriate newsgroup.

Just fill in the Subject slot, check that it is being sent to the correct newsgroup then click the Post button.

If the file is large enough that the article needs to be divided up into a sequence of articles, Turnpike will 
automatically do this for you.



"A serious problem has occurred in the Turnpike program"

The Turnpike program has encountered a situation where it was about to terminate with a General 
Protection Fault.

But instead of doing that it writes a report file in your Turnpike directory which contains diagnostic 
information. You are also encouraged to type in a description of the events leading up to the problem (the 
description box will scroll if you fill it up) - this is added to the report and may help us to pinpoint the 
problem.

The file: PROBLEMT.TXT should later be sent by email (if possible) to problems@turnpike.com so that 
we can investigate.

In some circumstances you can choose to Continue the program. If this does not cause the problem 
dialog to reappear then it will be best to close down and restart anyway at the first convenient opportunity.
This will give you the best chance of not losing any work or needing to rebuild your mail or news 
databases.

If it was not possible to continue, or the problem occurs again then you have to press Terminate. You 
may in this case need to rebuild the databases next time you run Connect, if prompted to do so.



Preparing News & Mail

The steps you take to prepare either a mail message or a news article in Turnpike are similar.

If you want to reply to a message or an article that you've received, you first need to select that item in 
your mailbox / newsstand or to open it up. If you don't want to reply to a specific item, you just need to 
display the appropriate mailbox / newsgroup for your message.

Then you just click the appropriate button / select the appropriate option as follows:

· To send a new email message: click the Start new email     button
· To send a reply by email: click the Reply     button
· To follow-up a news article: click the Followup button
· To post a news article on a new topic: take the Start news thread option

Only the options appropriate to what you are doing are shown.

Turnpike responds by displaying a message outline set up ready for the type of message you want to 
prepare and with your standard signature already in place. Where you are replying to a message or an 
article you've received, Turnpike automatically includes a copy of that message in the new message - 
marked up as a quote according to the standard Internet conventions.

For further information see Sending new email and other related topics below. New users should click 
here before posting any news articles.

If you are interupted or want to go on to do something else in the middle of preparing a message, just 
leave the message open on the screen or minimised as an icon. Turnpike will automatically save it on disk
for you. It will still be there when you come back to it, even if you've left Turnpike in the meantime, you 
can finish the message and post it whenever you like.    .

Related Topics
Sending mail
Sending New email



Preparing the message text

Preparing the text of a mail message or a news article in Turnpike is similar to preparing text using your 
standard word processor.
Turnpike offers many of the same facilities.

· Enter and delete characters using the keyboard keys.
· Use the Edit menu options to 
       Undo and Redo   the changes you make 

Delete, copy or move blocks of text by highlighting the appropriate section of text and 
then select the 'Copy', 'Cut' and 'Paste' options 
Find and Replace text, by taking the appropriate options in the Edit menu.

· Set and/or move margins and tabs by dragging and clicking on the Ruler line at the top 
of the message area. If no ruler is shown, select Display ruler in the Options menu.

· You can include ASCII text and other types of file in your message - using the Insert file 
button

The Font and Colour options in the Options menu simply set the font and colours used to display your 
message on your screen.)
Styling is not appropriate in mail messages or news articles. There is no guarantee that the system 
receiving these messages will be able to interpret the styling instructions that are used. 

If you want to want to emphasise pieces of text follow the 'Standard conventions'.

Related Topics
Preparing News / Mail messages.



Previewing before you print

Before printing either the message you're preparing or a message / article you have received, you can 
see how it will look when printed by taking the Print Preview option from the File menu.

Turnpike then shows you as accurately as possible on the screen how the message / article will look if it 
is printed in its current state using the printer and paper that your system is currently set up to use. (If you 
intend to use a different printer or type of paper, leave the Preview temporarily and use the Print Setup 
option in the File menu to set these.)

Moreover you can see how the message looks at different Zoom levels (whole page, double that size 
(area), and double that again), with a choice of either single-page or double-page views at the lowest 
Zoom level. These options can be selected by clicking buttons on the toolbar at the top of the display (this
toolbar also includes buttons for turning from page to page) - or you can cycle through the different Zoom 
levels by clicking the mouse on the Preview display.



Print Preview toolbar

Print Prints the message or article that you are currently previewing.

Next Page / Prev Page Allow you to step page-by-page through the message or article you are 
previewing.

One Page / Two Page Switches between a Single-page and a Two-page view of the message or article
you are currently previewing. (Note: Only available at the lowest zoom level.)

Zoom In / Zoom Out Allow you to display the message / article you are previewing at different zoom 
levels.

Close Closes the Preview display.



'Print Setup' dialog

Going to the the File menu and taking the Print Setup option displays a standard Windows Print Setup 
dialog through which you can set the printer and paper you use. The main features of the dialog are:

Printer: Select either your Default printer or a specific printer as you require.

Paper: Selected from a drop-down list.

Orientation: Select either Portrait (paper used lengthways) or Landscape (paper used widthways) as
required.

Options button: Click this button to call up a further dialog in which you can set more advanced features
such as printing to a file and duplex printing (if your printer supports this).



'Print' dialog

Going to the the File menu and taking the Print option displays a standard Windows Print dialog through 
which you can set such things as the number of copies you want. The main features of the dialog are:

Printer: This entry shows your current printer. (If you want to use a different printer, click the Setup
button.)

Print Range: Through which you can specify that you want to print either the whole message/article or a
range of pages. (You can find out how a message or article divides into pages by 
previewing it.)

Setup button: Click this button to check or change the printer or paper you will use.

Copies: Set the number of copies you want here.



Printing

To produce a printed copy of either the message you are preparing or a message / article you've 
received, either select the message or open it on the screen and then go to the File menu and take the 
Print option.

A standard Windows Print dialog then appears, primed to print one copy of the whole message/article 
using your current printer set-up. (Click the Setup button included in the dialog if you want to check or 
change the printer / paper you are about to use.)

Make any changes you require either to the number of copies, the range of pages or to the printer set-up 
through this dialog, then click on the Print button.

The printed copies are automatically given both page numbers and a standard heading which gives the 
basic details about the item being printed. Turnpike also puts your name right at the top so that you can 
readily pick out the items you've printed from among other people's on a shared printer.

If you want to see what the message / article will look like when printed or to find out how it divides into 
pages before you print it, preview it by taking the Print Preview option.

The typeface, typesize and typestyle used to print messages / articles prepared or read in a mailbox or 
newsstand is set on the Fonts   page   of the corresponding Mailbox or Newsstand dialog. So if you'd like 
the messages in a particular mailbox or newsstand to be printed a different typeface, typesize or 
typestyle, you need to take the appropriate Alter option from the File menu and then set the font you want
on the Fonts page of the dialog that is displayed.



'Properties' dialog

This dialog is called up by clicking the 'Properties' button shown next to a file that has been inserted in a 
MIME message.

The dialog allows you to specify the type of file that is being inserted. This enables the appropriate 
application to be chosen to view the file where it is received. The information to be given about any file is:

· Type of File     Typically - Image, Audio, Video, Application data (sent in binary). You can also specify 
'Other' in the slot alongside the main Type option.

· Sub-Type  eg. JPEG, GIF, TIFF etc..

· Description - normally set to the name the file has on your disk.

· Transfer Encoding. In general, the option to choose here is Base64 which treats everything as 
binary. 
If the file you are sending is mainly plain text and it's possible that the person receiving the message 
isn't able to interpret MIME, it's better to choose Quoted Printable. This will give them a good chance
of being able to read the file, as standard characters will then be transmitted in clear. Opting for 
Quoted Printable for a text file also has the advantage that it will usually cut down the size of the 
encoded file (which in turn will cut down the time taken to transmit it).

Generally, Turnpike will make the correct settings for you. You should only change these 
selections if you are sure that the file should be identified in a different way. In particular, don't identify a 
file as Other unless you know that it is of a MIME type that Turnpike doesn't cover.

Related Topics 
Attachments- An overview



This message is just warning you that when you go into any newsgroups, the interesting/not interesting 
markers will have gone and the threads will no longer show which articles you've read because that 
information was recorded in the file that's being replaced.



The action you are trying to take is contrary to the access that's allowed to the object you are trying to 
process. You may, for example, be trying to write to a read-only file or to open a directory as a file.

You probably need to select a different filename.



Click Yes to send copies to these additional people, or No if you don't want to send them copies - or 
Cancel to abandon the operation.



The message you are reposting was originally addressed to several recipients.

If you want to repost the message to everybody, click the All recipients button - but if you only want to 
repost it to the people who weren't sent their copies before, click the Unsent recipients button.



Turnpike no longer has any record of the details of this article eg. because it has been removed from your
disk. This unfortunately means that it is not even possible to request the article.



Either you've tried to combine files from different versions or from different users, or this file has become 
corrupted.

Make a back-up of the important files in your system - separate from any previous back-up you've taken - 
then try to sort the problem out, for example by restoring files from a previous back-up or, if a datafile has 
been corrupted, by rebuilding the affected file.



The Mailbox or Newsstand must be given a name, and this must be different from any other Mailbox or 
Newsstand.



This topic applies only to multi-user systems

Filing this message would remove it from a mailbox or out tray belonging to somebody else. This is not 
allowed.



Only the owner of a message can drag that message between one tag list and another because the effect
of dragging is to change the tags on the message and only the owner of a message can change its tags.

Or, to put it another way, you can only drag your own messages between tag lists.



Outgoing messages can only be moved into the Out tray (for reposting) or out of the Out tray (to prevent it
being sent) or between mail lists (for tagging).

When moving messages between mail lists, you must move the whole of a message - you can't move 
individual parts. You can, however, move individual parts of a message to the Out tray for reposting.

Also you cannot move an outgoing message at all while it is in transit, i.e. being sent out onto the 
Internet. If you were trying to prevent it being sent it is too late. Otherwise try the move operation again 
after it has been sent.



You may be able to get more from the message by using the Display 'raw' text option in the Options 
menu to display the message in its raw encoded form.



You will be able to remove the attachment once the message has been sent.



Click the Yes button to cancel or the No button to continue without cancelling.



The Request system only works for articles which are available from your news server ie ones in 
'standard' newsgroups. Articles in local newsgroups and mailing lists don't come from your news server, 
so can't be requested - because they are actually mail messages.



The change you have picked out to make will significantly change either the text or the layout of quoted 
text. If you proceed with this change, this text will have to lose its quoted status.

The only changes you can make to quoted text without affecting its status are to insert/delete whole lines; 
and to delete text at the beginning or the end of lines.



Click OK, then return to Turnpike and close it - either by taking the Exit option from the File menu or by 
clicking on its window's Close box.



If you are sure you have not mistyped any details, either email info@turnpike.com or phone Turnpike 
Support on 0181-371 1010* with details of your Site ID (which you can find out by editing the 
CONNECT.INI file in your Turnpike directory).

* Calls to 0181-371 1010 may be monitored for training purposes. This information may be used for marketing purposes.



The datafile(s) need to be rebuilt. To rebuild the files, either the System administrator or another user with 
Rebuild files permission needs to run Connect and take the Rebuild database option from the File menu.

Note: Rebuilding these files may take some time.



In the first instance, ask your correspondent to send the message again - but if you continue to have 
problems, ask them to pick a different message format.



Moderators of moderated groups may reject cross-posted articles on the grounds that the follow-up path 
can become very confused - so you should check first whether cross-posting is acceptable in the 
moderated group(s) to which you wish to post your article.



This is a system-level problem.

For a detailed explanation, look up the error message in the information on 'DOS errors' or 'System errors'
in the documentation supplied with your machine or with the operating system you are using.



The chances are your mail/news files have been moved but this move hasn't been recorded in the File 
Paths dialog. To sort this out, click OK: then back in the Sign-on dialog, click the Paths button to display 
the File Paths dialog and check that the correct directories are selected.

If necessary, use the Windows File Manager / Explorer to check the location of:

Your TURNPIKE.USR file (the Server path - probably a TURNPIKE directory)
Your MAILBASE, MSPOOL and ADDRBOOK files (the Email path - probably a MAIL directory)
Your NEWSBASE and NSPOOL files (the News path - probably a NEWS directory)



Q: Delete mirrored messages?
When a message in Turnpike is a 'mirror' of a message in a POP mailbox, this isn't normally deleted until 
the next time mail is collected from this mailbox so that the range of messages in Turnpike properly reflect
the contents of your POP mailbox.

But you have been offered the option of deleting these messages in case any are mirrored from a POP 
mailbox that you no longer use and so won't ever connect to again.

Before taking the option to delete the messages associated with a particular POP mailbox, however, it's 
important to understand that if you do ever re-connect to this mailbox any messages that are still in the 
POP mailbox will appear as new messages in your Turnpike mailboxes because all record of these 
messages has been erased.



Reposting a message creates a second copy which is automatically filed in your mailbase. This message 
lets you choose whether to keep the original message as well as the new copy.



You are strongly recommended to switch to the Windows File Manager / Explorer and make some space 
available on the drive named in the message. Having made space, you should then return to the 
message and click the Retry button. Doing anything else is not recommended.



This is a disk/drive problem.

If it's obvious to you what you need to do to correct the problem, look up the error message in the 
information on 'DOS errors' or 'System errors' (or just 'Errors') in the documentation supplied with your 
machine or with the operating system you are using.



If in doubt, take the Edit option - just in case you find you want to change anything.



Q: Error in rule
The rule you are trying to set up hasn't been formulated correctly. Return to the dialog in which you set 
this rule, press F1 and study the page of on-screen Help that is displayed. Note in particular what it says 
about what should be put in the different slots in the dialog.

Custom rules should only ever be put in the Custom slot of the dialog - even where they are picking out 
messages/articles by subject.



The Evaluation version gives access to the Internet for 30 days, with an optional 15-day extension for 
anyone ordering a full copy of Turnpike before the Connect program 'expires'. (To order your full copy of 
Turnpike, ring Demon Sales on 0181-371 1234*)

If the program expires before your full Turnpike package arrives, either email info@turnpike.com (if you 
can) or phone Turnpike Support on 0181-371 1010* with details of your Site ID (which you can find by 
editing the CONNECT.INI file in your TURNPIKE directory). They should then be able to provide you with 
a 'Site Key' to unlock your copy of Turnpike.

* Calls to 0181-371 1010 and 0181-371 1234 may be monitored for training purposes. This information may be used for marketing 
purposes.



Since you opened this newsgroup, the newsbase has been 'expired' - deleting articles that have been on 
the disk for longer than their allotted time. The article you've just picked out was one of the ones deleted. 
(Clicking the Refresh button at the bottom of the newsstand will clear the newsgroup of any other articles 
that have been expired.)

If you particularly want to read this article and it comes from a Usenet newsgroup (rather than a local 
newsgroup or a mailing list), you can use the Request article button on the toolbar to ask for it to be 
downloaded the next time News is collected from the news server.



The message has already been removed from here - eg. by another user, or it has been posted (in the 
case of messages in the Out tray).



Check the file details you are giving. They are probably out of date.



The filename associated with the enclosed file is either not a valid name on a PC or is wrong for the type 
of file it represents.

If the suggested name is acceptable, click Yes. Otherwise click No and set your preferred name in the 
selection dialog that appears.



If you are doing this deliberately, fair enough - but you are missing out on a couple of features quite 
unnecessarily.

You can pick up a full version by FTP from:
       //ftp.demon.co.uk/pub/mirrors/turnpike/

The files are quite big, so different versions are offered, covering the choice of Windows 3.x version (for 
16-bit systems) or Windows 95 version (for 32-bit systems), with or without Microsoft Internet Explorer. 
Study the Readme file in the directory for information on which file you need to copy.



You must enter a name here.



The options are either to 'Ignore enclosure' and just reply to the main author of the message sent to you,
or to 'Reply to all' and thus also send copies to everyone involved in the enclosed message (or to Cancel
the operation).

Just pick the option you require.



The options are either to make a 'Simple reply' to the main author of the message sent to you, or to 
make a 'Group reply' and send copies to everyone involved in the original message (or to Cancel the 
operation).

Just pick the option you require.



One or more of the header lines appear incorrect. You may have forgotten to fill-in the To: or Subject: 
boxes.

If not, our advice is to go back to your message, click the Edit header button to go back into the Edit 
Header dialog and check the header lines you've set up - particularly the ones you've set up in the slot for
'Other' header lines. But you can if you want take the option to Post anyway if this is offered.



The Evaluation version doesn't allow you to import mail that's been exported from Turnpike. This 
restriction doesn't apply to full versions of Turnpike.



Q: Inspected text
If you scroll back through the inspected text, you'll find a horizontal bar which includes a Merge into text 
button which you can use to merge this text into your message.



You probably need to close some of the other applications you are currently running. It may even be a 
good idea to restart Windows.



Turnpike is simply checking that you meant to do this - in case you've accidentally selected a whole 
thread when you meant to just select one article from this thread.



The ratings service you are using considers the level you wish to select unsuitable for anyone to access. 
For further information, you should refer to the documentation provided by this ratings service.



Turnpike is unable to handle this file. Are you sure you picked the file you meant? Are you sure it is a text 
file?



With Turnpike, you normally get an average of 72 characters per line, but if you have changed the 
margins or you are using a proportionally-spaced font, you may be getting many more characters than 
this on some lines. (With a proportionally-spaced font, there's the additional problem that the text won't lay
out in the same way for the recipient unless they use exactly the same font.)

Lines over 80 characters in length aren't generally recommended because not everyone can view long 
lines of text. So this message gives you a chance to change either the margins or the font you've used to 
make it more likely to lay out well for the recipient.



Not all the transport systems on the Internet can handle messages as large as this.so we would 
recommend letting Turnpike split it into multiple sections for you.

However, it is possible that your recipient runs software that may not cope with re-assembling a multi-part 
messages, or you may know from experience that a large single message will in fact arrive safely at this 
particular email address, so you can opt to post it as a single section if you want.



Mailing Lists must be added to a newsstand before you can use them.



Simply pick the option you prefer.



If you are happy to go ahead, click OK - but if you would rather abandon the task, click Cancel.



The item you typed has not been found - possibly you mistyped it or there are no more matching entries 
in the list.



Check that you are using the files you intend, then rebuild the relevant datafile.

Important: If you replace any files from backup copies, be sure to replace the NEWSBASE and NSPOOL
files together and the MAILBASE, MSPOOL and ADDRBOOK files together. Don't try to combine files 
from different back-up sets.



Consult your system administrator.



A newsgroup you've specified doesn't appear in the list of newsgroups available from the news server. 
Are you sure you have the correct name ?

Turnpike won't actually stop you from posting to a newsgroup that isn't on this list but you won't be able to
download any articles from this newsgroup.



Return to the Alert box and follow the instructions it gives.



The article is probably no longer still available on the news server from which you collect news.



The Address book entry you've selected doesn't give any email address to which to send messages. 
Either amend this record or pick again.



You must enter at least one name in the Index by slot for this address book entry to appear in the list on 
the main Address book display.



Q: No more sign-on names
You've filled all the seats available on your system (99 in the standard version of Turnpike).

The chances are that you've still got some people listed as users who no longer use the system and you 
will be able to make space for your new users by removing some of these. Click here for the steps to use.
(Note: Removing a user is not simply a matter of clicking the Remove button because you also need to 
tidy up any mail files etc. that remain for them.)

If you need more seats, contact Turnpike Sales on 0181-371-1234*.

* This number is monitored for training purposes. This information may be used for marketing purposes.



Q: No reject
Turnpike is unable to send a Delivery Status Notification if the email you are trying to reject lacks 
information on where the rejection message should be sent.

This can happen with email that has been sent through certain POP3 servers, email sent to you from 
someone else at your local domain and email that has a null return path (which Delivery Status 
Notifications themselves have).



This looks like a mistake. Click Yes if you really want to post the message like this - or click No to return 
to the message.



This attachment was prepared on a system that doesn't use CRLF line endings. If you save it with its 
current line endings, the program in which you open the file may not be able to interpret it correctly. It 
might therefore be better to let Turnpike save a version with the current line endings replaced by CRLF 
line endings.



The specified file type isn't an appropriate type for a MIME attachment, eg. because it describes a 
composite type that can't be sent by MIME.

Depending on what you're trying to send, you need either to simply change how this file is described or to 
change what you trying to send.



It's only worth sending a MIME message if the recipient can handle MIME messages.

To help you avoid sending MIME messages to people who can't handle them, Turnpike notes whether 
someone has sent you a MIME message in the Address book so that it can warn you before you post a 
MIME message to someone not known to be able to handle MIME messages, and if a distribution list you 
set to send MIME messages includes anybody that is not known to be able to handle MIME messages.

However, Turnpike's knowledge is limited to the messages you've received. If you know that they can 
handle MIME, it's OK to continue - but if you aren't sure, it's better to switch to sending a standard 
message instead.



This message has been displayed for your advice. There isn't necessarily any problem for you to sort out.



The only email name you can specify here is one that you personally own or one that belongs to a 
workgroup of which you are a member.



Turnpike doesn't support the Ratings system being used in the .RAT file you have selected, so this 
Ratings service can't be used.



The problem with using a proportionally-spaced font is that your message won't lay out the same way for 
the recipient unless they display it using exactly the same font. You may also produce messages with 
lines that have more than 80 characters on them, which will be awkward to read on some people's 
systems.

Using a fixed pitch font is advised but stay with the font you've picked if you want.



Opening all the parts of a message together is generally best but you can open individual parts if needs 
must.

But beware! If what you open contains a section of an encoded file, you will be unlikely to be able to make
any sense of it.



Click OK, then pick again.



Choose to Post or Abandon as required - or click the No! button to return to the message. Abandoned 
articles are placed in the Waste basket and will be lost when you exit Turnpike.



If you think you should have been able to access this message, talk to the user whose message it is.



Click the Yes button to continue or the No button to cancel.



Selecting Normal quote will quote the whole of the message in your reply. Selecting Quote selected will 
just quote the section that is currently highlighted.



To resolve this, you need to re-install Turnpike.



The database files need to be rebuilt to incorporate the new information, and wherever possible, Turnpike 
offers the chance of doing this now. But as this will take some time, Turnpike also offers the option of 
leaving the database files as they are by clicking the No button. However you won't then get the changes.

Database files can also be rebuilt by running the Connect program and taking the Rebuild database 
option from the File menu - assuming you have Rebuild files permission.



One or more of the entries in the dialog has 'overflowed' the space available to it.

Return to the dialog and check that you have the correct information in the various slots.



Replies sent to the newsgroup / mailing list will be seen by everyone who subscribes to this newsgroup / 
mailing list.

Replies sent by email will only be seen by the author of the original posting but can make sense if for 
example they are planning to post a summary of the replies received.

Be aware that many people may not appreciate responses being sent both to a newsgroup and by email,
as this may make them feel obliged to go to the trouble of responding twice.



Where a message has been forwarded to you, your reply can be sent either to the originator(s) of the 
message (a 'Normal reply'); or to the person (or persons) who forwarded the message to you - or to both.

Just pick the option you require.



Q: Reposting large message
Where the original message was split into separate parts for posting, it makes sense to just repost the 
sections that the intended recipient needs.

But if you want to change any part of the message, you should really repost the whole message - 
because any changed section represents a new message which can't be merged with sections of the 
earlier message.



You have the choice at this point of requesting either just the particular article you've selected or all the 
articles fom this thread.

Simply pick the option you require.

(If the article is missing because it is in a thread that has been killed at some stage, then you can opt to 
'unkill' the thread.)



We recommend shutting down all applications and restarting Windows.



The file you've asked to view contains an application.

Turnpike is simply checking before running this application in case you hadn't realised that this is what the
file contained.

Unless you are sure that the attachment comes from a reliable source, it may be wiser to save it to disk, 
and then check it for viruses, before you run it.



Shame though it is, it is probably best to abandon your changes then call up this entry again so that you 
can see what changes the other user made - then make the further changes that are still required. You 
would extremely unlucky to lose your changes a second time.



To sort this problem out, the System Administrator or some other user with Configure Users permission 
needs to call up the Configure Users dialog.



The information provided about this external body doesn't include a server address, so Turnpike is unable
to fetch it.



The file you are trying to access is being used by another application - possibly on another machine if 
your computer is on a network.



An error has occurred in the program.

Please email helpdesk@demon.net with details of the message seen and the circumstances under 
which this message appeared.



The text you have entered here is too long.



If the search hasn't brought up the particular item you were searching for, think of something else you 
might use to search for this item, then try again.



You should supply some text here for subject line matching.    If you leave this blank then only messages 
with a blank subject line will be accepted (probably not very useful).

Text which you specify here without any wildcards will match any subject line beginning with that text.

Often you would want to match a particular word or phrase anywhere in a subject line; to do that include 
the wildcard character '*' at the beginning.



If you click Yes, the newsgroup(s) will be added to the list of newsgroups subscribed at your site and set 
to be downloaded in full, visible to all users and expired after three days. If required, you can change 
these subscription details through the Newsgroup Subscriptions dialog.

If you click No, you will not be able to download any new articles from the newsgroup(s) and Turnpike will 
repeat this reminder each time it is launched.



Exit from the program as 'gracefully' as you can, then restart. It may also be a good idea to restart 
Windows.



Q: Too many users
With the standard 'single-access' version of Turnpike, you can only have one copy of the Connect 
program and one copy of the Turnpike program running at any time - though not necessarily always from 
the same machine. With the 'multi-access' version, you still can only run one copy of Connect but you can
have multiple copies of the Turnpike program running, up to the number of seats purchased.



Q: Too much rule data
You've given Turnpike an excessive number of rules to process. Please review the rules you've set, 
decide which ones you don't need and delete them.



The characters of the 7bit US ASCII character set are the only ones guaranteed to be able to pass 
through all the different transport systems on the Internet. Other characters may be replaced by another 
character or a blank.

If you are sending an email message, sending a MIME message instead of a standard email message will
allow almost all the characters of the Windows character set to be sent correctly (curly quotes are the 
notable exception) - though this is only any good if you know that the intended recipient can handle MIME
messages.

But if you are posting an article to a newsgroup or forwarding a message, you just get the option to post 
anyway or to go back and change the message to get rid of the problem characters - replacing £ by GBP 
for example.



This message is currently waiting to be read in several different mailboxes either on one user's system or 
spanning several users' systems.

Once it has been opened in any of these mailboxes, it will then be assigned to that user and mailbox - but
until that has happened, it can't be opened through any mail list (for technical reasons).



You've addressed your message to someone in your local domain but the email name you've given isn't 
on the list of local email names.

Probably the best way to get a correct email name for this person is to return to your message and use 
the Look up address button on the toolbar. They are almost certainly in the Address book.



Click OK to return to the Sign-on dialog and enter the correct information.

If you don't know or can't remember either your sign-on name or your password, consult your System 
Administrator or some other user who has Configure Users permission. They should be able to tell you 
what your sign-on name is and to set a new password for you. Once you've signed on using this 
password, you'll be able to set a new password for yourself by going to the File menu, selecting 
Configure... Users and using the Edit sign-on details dialog that is displayed.



The file you are trying to use was created on an incompatible Turnpike system. At the time of writing, no 
such system existed but it is always possible that one could have subsequently been created.

If you have access to a newer version of Turnpike, try using that.



Ratings display

This dialog is displayed by clicking the Ratings button within the Newsgroup Subscriptions dialog (or the 
associated Newsgroup Subscription dialog) or by clicking the corresponding button within the Newsgroup 
Addition dialog when newsgroups are being picked out for inclusion in a newsstand.

The top part of the dialog shows the names of the newsgroup ratings services that are currently in use (or
blank if none have been selected), together with details of the rating that has been given to the currently 
selected newsgroup under each of the different categories covered by each ratings service.

While the cursor is on the name of a service (or this part of the display is blank), you are offered the 
option to Add a new service or to Remove the selected service. Details of the selected service are shown
at the bottom of the dialog.

While the cursor is on a category, you'll see instead the range of levels that are available in this category, 
together with a description of what the rating that has been given to the newsgroup means.



Switching between Read and Unread

The articles and messages you open on the screen are automatically marked as 'Read' on the 
assumption that (a) you will read them while they are on the screen and (b) that you won't want to read 
them again. (Articles that have been read aren't drawn to your attention again.)

In general, this is precisely what you need but there may be times when you will want a message that 
you've read marked 'Unread' so that it is drawn to your attention again or an article to be marked read so 
that this isn't picked out by the 'Next unread' option.

The options you need to switch between Read and Unread are in the Classify menu.

You can mark all the remaining articles in a newsgroup as read (so that they aren't drawn to your attention
again) by clicking the Mark all as read button.



Reading mail

When you have any unread mail the mailbox will flash. If you have Turnpike minimised, its 
program icon will flash.
· To read new mail,

1. Double-click the mailbox icon 
Or click Window in the menu bar and then select the mailbox you want
A window opens with a list of messages in arrival or sent order. 

2. Double-click a message to open it
· To read a number of messages in turn    

Press the Space bar 
Or Click Search on the menu bar, then select Next unread.
You can also search for messages on particular topics 

· Messages may contain
· Encoded    text
· A horizontal bar containing an icon, one or more buttons and some brief details. 

The description in the horizontal bar will tell you whether the additional item is 
· An enclosed message, for example a forwarded message.
· A particular type of file 
· A digest message
· Reference to an an external body

Very occasionally, an item within a message may be offered in a number of alternative forms. For 
example, the text of a MIME message may be offered in both plain and enriched forms, or you may be
offered a choice of ways of picking up an external body. 
Where possible, this is shown as a horizontal bar with the different forms of the enclosure offered as 
buttons. Otherwise, you are offered a Select button with the number of a alternatives shown 
alongside. Clicking a button will call up a dialog listing the alternatives, from which you can select the 
version you require.

· When you have read a message, 
· Reply to it
· Move it to the Pending tray for replying to later. Use the Move to Pending button
· File it
· Delete it

      If you just leave mail you have read in the In tray it may be difficult to see if there 
are new messages waiting to be read.
· When a message has been opened.

It is automatically marked as 'Read'. You can, if you wish, change its marking back to 
'Unread' 
1. Click Classify on the menu
2. Select Mark as unread.

.
Related Topics 
Sending Mail.



Searching
Decoding Encoded Text
Forwarded messages
Extracting files from messages 
A digest message
An external body



Reading News articles

To read the articles that have been posted to a particular newsgroup, you first need to add this newsgroup
to one of your newsstands, then you need to go into that newsstand, open the newsgroup and scan the 
list of topics currently under discussion. Against each of these topics will be a number telling you the 
number of articles which are waiting to be read on that topic (assuming that it's a topic that interests you).

To see more about the articles that have been contributed on a particular topic, double-click on the

 icon in the second column of the display to 'expand' the thread. Alternatively you can use the 
Expand options in the Article menu to display the articles in detail - together with the corresponding 
Collapse options to close up the display again.

The topic then opens up to show both the author of each article that's available to read in the thread and 

how the different articles thread together. (Any  s included in the display mark articles that are part 
of the thread but which aren't currently available for you to read, while 

 or 

 marks an article of which only the header has been downloaded If you want, you can ask for 
these to be downloaded in full when you next go on-line: see Requesting missing articles.)

The easiest way of reading new articles is simply to press the space bar to work through each one in
turn (or you can use the Next unread button). Alternatively:

Or you can work systematically through every article using the Next and Previous buttons. These 
buttons allow you to track through the entire thread of a discussion; whether an article has been read 
before or not.

Or you can double-click the name (or the icon alongside) of an article that interests you, or select it 
and take the Open article option from the Article menu. When you've read that one, close it by 
clicking on its window control box and then pick out another article in the same way.

Or you can select Search article from the Search menu to look for articles containing something that 
particularly interests you (see Searching).

Most news articles just contain plain text, but some contain pictures or other binary information, which 
requires special handling, while others - especially FAQs - may be split up into a number of sections, each
with its own mini-toolbar. Such articles are known as MIME digests.

There's also the possibility of articles being set up with a 'hidden' section at the end - typically to stop you 
being shown the answer to a riddle or some other problem before you want to see it. In Turnpike, such 
hidden sections are initially represented by a horizontal bar containing a Reveal button for you to click 
when you want to see the solution.

Once an article has been opened, it is automatically marked as 'Read'. You can, if you wish, change its 
marking back to 'Unread' by going to the Classify menu and taking the Mark as unread option. 
Alternatively, if you don't want to bother with particular articles or with the remainder of the articles in a 
particular newsgroup, you can avoid having these picked out when you go 'Next unread' by using the 
'Mark as read' and the 'Mark all as read' buttons to mark these as Read.





'Reading' binaries

The articles in 'binaries' groups often include files containing pictures or other binary information - maybe, 
spread across a number of articles. Where this data is in a form that Turnpike recognises it will be 
represented by a horizontal bar containing a brief description of the file, and one or more buttons. 
Typically, these will include options to save the binary data to disk and to remove the binary data from the 
article (to save disk space if it is not wanted). You may also be able to call up the file directly by clicking a 
View button.

The file will be opened using whichever application is associated by Windows with files of this filetype 
extension on your system.

If Turnpike does not automatically offer a View option, you will need to extract the original file from the 
news article. To do this, select the article (or sequence of articles) and then take the Decode option in the 
File menu. This stores a copy of the file contained in the article(s) on disk for you in its original format. 
(You are asked where you would like the file to be stored.)

You can then use the appropriate application for the type of file that's been produced to see what the file 
contains.

You can extract the files contained within a number of articles at once by selecting all the articles you are 
interested in as a group, then taking the Decode option. Any uuencoded and Base64 encoded files within 
the files you select will be saved to disk as separate files, which you can then open using the appropriate 
applications.



Re-building Datafiles - Recovering disk space and 
corrupted files. mailbase etc.

When earlier entries have been erased, unused disk space may be left in your newsbase, 
mailbase or address book. This space can be recovered by rebuilding the relevant datafile. 
Rebuilding may be also be used to recover a corrupted datafile.

If you have Rebuild Files  permission you will be able to, 

1. Run the Connect program
2. Click on File in the menu
3. Select Re-build database 
4. Follow the instructions displayed. 

Turnpike will build a new version containing just the current information from the old version.
Wasted disk space will be recovered and as much as possible of the information from the old
files.

Although rebuilding a database will usually recover all your email messages or news articles,
this may not always be possible. You are advised to keep up-to-date backups of all these 
databases: see Backing up your Turnpike files.    

Related Topics. 
Backing up your Turnpike files.
Moving the Mail and News Directories
Moving Turnpike to another machine or System.
Upgrading to the latest version of Turnpike



Re-direct the Mail of an Ex-User to A Current User

Re-direct the Mail of an Ex-User to A Current User

1. Click File on the Turnpike menu.
2. Select Configure
3. Select Email names.
4. Make a note of the email names they were using
5. Arrange that any mail that arrives addressed to any of these names be directed to 

another user to deal with.    



Regular expressions

Regular expressions are used to express 
· custom rules for selecting the mail that is put into your different mailboxes
· special rules about how mail from mailing lists is to be identified.
· custom criteria for killing articles.

The syntax used is as follows (expressed in BSI syntactic metalanguage):

regular expression  = anchor, {"|", anchor}.

anchor =      ["^"], {closure}, ["$"].

closure =    primary, ["*" | "+" | "?"].

primary = "." |
    "\", digit |
    ["\"], (ASCII char - digit) |
    "[", ["^"], {char, ["-", char]}, "]" |
    "(", regular expression, ")".

meta-character = "|" | "^" | "$" | "*" | "+" | "?" | "." | "\" | "-" | "(" | ")" | "[" | "]".

char = ASCII char - meta-character.

ASCII char = ASCII character

If you want a meta-character to stand for itself, precede it by \.

Semantics
\d a digit, equivalent to [0-9]
\D not a digit, equivalent to [^0-9]
\f form feed
\n line feed
\r carriage return
\s a space or a tab, equivalent to [ \t]
\S not a space or a tab, equivalent to [^ \t]
\t a tab
\w a word character, equivalent to [a-zA-Z0-9_]
\W not a word character, equivalent to [^a-zA-Z0-9_]

\ escape meta-character
[ ] matches any one of enclosed characters
[^] matches any one character except those enclosed
- specifies range for use within [ ]
( ) grouping
| or
^ start of string
$ end of string
* 0 or more of the previous character



+ 1 or more of the previous character
? 0 or 1 of the previous character
. match any character

Related Topics 
Defining Custom Rules. 
Custom rules: Formal syntax.



Reject mail

This option in the Messages menu will cause Turnpike to create, and attempt to send, a rejection 
message called a Delivery Status Notification (DSN) for each of the selected messages. The DSN, which 
is in the form of an automatically generated message, informs the sender that delivery of their message to
you appears to have failed.

This feature is intended for the rejection of unwanted "junk" mail. Be aware that such mail often has a 
deliberately flawed return path, so rejecting it may be wasted effort.

Reject mail should not be used in cases where someone is trying to contact you for genuine reasons. It 
could cause considerable investigation as to why their mail to you appears to be failing. 

In particular, it should never be used to unsubscribe from a mailing list you have joined. This could cause 
considerable inconvenience to the list owner. Always cancel subscriptions to mailing lists in the proper 
way, usually by sending an unsubscribe message to the list control address (not to the list itself).



Removing Ex- users from a system

When someone who has been using your Turnpike system leaves, there are three things 
the System Administrator can do:

· Leave: them as a user on the system - there's room for 99 different users      
· Allocate , another user to their seat.
· Remove them from the system.

Which your administrator does depends on your local policy. Click on the appropriate heading above.

Related Topics
Removing users 
Adding new users
Edit details of a current user
Enable the Edit sign-on details dialog
The Edit sign-on details dialog



Removing a Newsstand

When you no longer require a particular News stand you can remove it.

You will only be able to remove empty newsstands. You can    either to move any articles it 
contains to another newstand file them or delete them. 

· To remove a newsstand
1. Select the newstand you no longer want
2. Check that it is empty
3. Click File in the menu
4. Select Alter Newstand 
5. Click the Destroy button.

Related Topics 
Newstands



Removing a mailbox 

When you no longer require a particular mailbox you can remove it.

You will only be able to remove empty mailboxes. You can either to move any mail it 
contains to another mailbox, file it or delete it. 

· To remove a mailbox
1. Select the mailbox you no longer want
2. Check that it is empty
3. Click File in the menu
4. Select Alter Mailbox 
5. Click the Destroy button.

Related Topics 
The alter Mailbox dialog 



Removing newsgroups

You can remove a newsgroup from your newsstand by selecting it in the list of newsgroups shown at the 
top level of the newsstand and clicking the Remove button displayed on the bottom edge of the 
newsstand.

However, it is important to understand that while this removes the newsgroup from your newsstand, it 
doesn't stop articles from that newsgroup being downloaded to your disk. To stop any more articles being 
downloaded, someone with News Admin permission needs to remove the newsgroup from the overall list 
of newsgroup subscriptions.

This overall list of newsgroups is shown in the Newsgroup Subscriptions dialog, but in practice there's no 
need to call up this dialog because Turnpike automatically alerts any user with News Admin permission 
when they log on if there are newsgroups listed in the newsgroup subscription list that don't appear in 
anyone's newsstand. That person then gets to choose whether to continue subscribing to that newsgroup 
or to remove the newsgroup from the list of newsgroup subscriptions and cancel the subscription.

Before removing the newsgroup, check whether there are any articles from the newsgroup that you want 
to keep and export these immediately, because all the articles - including ones that you have marked 'to 
be kept' - will be deleted from the disk the next time News is expired (probably the next time Connect is 
run).



'Replace' dialog

Taking the Replace option from the Edit menu displays a standard Windows Replace dialog through 
which to set the details of the word or phrase you want to replace and the word or phrase that you want to
replace this by.

Simply enter the word or phrase you want to replace in the Find What slot, the word or phrase you want 
to replace it by in the Replace With slot; set the Match options, then click Replace All if you want 
Turnpike to go ahead and replace this text - or Find next if you want to check each replacement before it 
is made.



Replying to Mail

1. Open the maillist
2. Select the message 
3. Click the Reply button on the mailbox toolbar 

or select the Reply to message option from the Message menu

A new message outline is displayed. A copy of the message is included, with markers in 
place of large enclosures such as GIF files. Where possible Turnpike also removes the 
signature out of the copy.

If you want to reply to just one point in a message, highlight that part of the original 
message before clicking Reply. The new message will then just contain the selected 
text, marked up ready for your reply.

4. Delete the parts of the original message you don't want included in your reply
5. Enter your reply to the message
6. Click the Post button. 

The message is then placed in your Out tray. Mail in the Out-tray can be opened and edited 
(or thrown away) any time up to the point that you are connected to your Access provider. If 
you are connected to your Access provider when you post the message, it will stay in the 
Out tray for one minute. This gives you a chance to change your mind or edit it before it is 
sent.

The introductory line at the top and the signature at the bottom of a message are just text. 
You are able to edit this as you wish. See formatting introductory text and signatures.

Related Topics 
Preparing News / Mail messages.



Requesting missing articles

When discussion threads are expanded, they frequently include entries shown only as . These 
represent articles that form part of the discussion thread but aren't included in the current newsbase. 
Similarly, where you've opted just to 'browse' a particular newsgroup, you will find the entries in the 
discussion threads marked 

 or 

 to show that just the header of the article has been downloaded.

If you want to read either a missing article or one you currently only have the header of, you can ask for it 
to be downloaded the next time you go on-line. To arrange this, simply select the entry for this article and 
then either click the Request article button or take the Request article option from the Classify menu. 

The article will then be marked  to indicate that it will become available at a later time, while the 
thread itself is automatically marked Interesting (

) so that it will be drawn to your attention the next time you log in to read your news.

If you change your mind about requesting an article, go to the Article menu and take the Cancel request
option.



Responding to News articles

There are two possible ways in which you can respond to an article you read. You can either:

Post a 'Follow-up' article, or
Send an email message to the author of the article.

The general method is to post a 'Follow-up' article but article authors may specifically ask for replies by 
email, eg. because they are intending to post a compilation of the responses they get. Be aware that 
many people dislike receiving both types of reply as they may then feel obligated to go to the trouble of 
responding to both your communications. If you really do need to send an email copy of your follow-up - 
prepare your follow-up article, copy the text to the clipboard using Ctrl C, then set up a 'reply by email' 
and paste the text into that. Mention that the email is a copy of a News article.

Whichever method you wish to use, the steps you take are much the same.

To post a follow-up message, select the article (if it's not open on the screen), click on the Reply / 
Follow-up button, then when the message appears, select the option to reply by News. (Alternatively, call
up the Article menu and select Followup article.)

To send an email message to the author, select the article (if it's not open on the screen), click on the 
Reply / Follow-up button, then when the message appears, select the option to reply by Mail. 
(Alternatively, call up the Article menu and select Reply by email.)

In either case, Turnpike then displays its Message Editor, with a new message set up ready for your reply 
- complete with a copy of the article you were reading (suitably marked up for inclusion in your reply). 
Your standard signature is also automatically added to the bottom of the message.

You also have the option in either case to follow-up on just one section of the article by highlighting the 
section you want to quote before taking the Reply/Follow-up option.

Make the changes you want, then click on the Post button. The article is then placed in your Out tray, 
from where it can be opened and edited (or thrown away) any time up to the point that it is actually sent. 
Even if you are already connected to your Access provider, the article will stay in the Out tray for at least a
minute to give you a chance to change your mind or edit it before it is sent.

For information about using Turnpike's Message Editor, see Preparing News / Mail messages.



Restricting access to newsgroups

There is a vast range of newsgroups covering a vast range of topics, not all of which you might want 
children to read about. Some even carry material that it may be illegal to possess. So Turnpike lets you 
restrict access to newsgroups:

Firstly, on the basis of the ratings given to different newsgroups.
Secondly, by specifying precisely which users can access particular subscribed groups

Follow the above links to find out more about these schemes.

Both these schemes filter articles on the basis of which newsgroup they have been contributed to, rather 
than the content of the articles themselves. This works well in the vast majority of cases because most 
contributions to newsgroups keep to the topic of the newsgroup. But it is not foolproof because it is in the 
nature of Usenet that anyone can post an article on any subject to any newsgroup - even moderated ones
(though unauthorised articles in moderated groups are normally quickly cancelled). It's very unlikely but 
possible - even with these filtering schemes in place - that one day you'll be reading a newsgroup about 
pet cats and suddenly find an encoded picture of a naked lady.



    
Return/Reverse path
The address that replies to the message are
to be sent to, as stated in the message 
header.



Running a mailing list

Turnpike doesn't offer specific support for running a mailing list by taking incoming mail 
messages and 'exploding' them to a given list of addresses.

You are however able to set up distribution lists of addressees and select them en masse 
from the address book. This is a good technique for outgoing email that has to be regularly 
sent to the same group of people. 

You can even import this list from a CSV datafile of the appropriate format - see Importing & 
Exporting addresses.

There is a limit of 256 addresses on any such list.

Related Topics 
Mailing Lists - Overview
Subscribing to a Mailing list
distribution list 



Running under Windows NT

Turnpike works fine under Windows NT but the NTS stack provided with Turnpike cannot be used with 
Windows NT because it is implemented using VxDs. This means you will need some other Winsock and 
some other way of dialling up the Internet.

Instructions for setting up Windows NT's RAS can be found in
ftp://ftp.demon.co.uk/pub/nt/general/nt-demon.txt



Save URL Dialog

This dialog appears 

· When you click on an URL button in a mail message or news article

The dialog gives the full URL address for the selected item and a prompt describing from 
where the URL was obtained. 

· When you click Extract URL from the Edit menu.,

This time the dialog will contain a list of all the URL’s in the message or article and a 
prompt describing from where the URL was obtained. If you highlight a URL or any other 
part of the message or article, just that part will be listed in the dialog. 

Click Save, Copy  or Launch or click the Cancel to take no further action.

Control buttons

Save click to save the URL to a link file in you browser
Copy to copy the link to the clipboard, from here you are able to paste the link into 

any HTML document or browser.
Launch open the link.

Buttons are greyed out when the function is not available. For example; 
The Launch button will be greyed out if you have selected to only fetch URLs if connected
and you are offline.
The Save button will be greyed out if the link is a mailto URL

Related Topics 
Offline Browsing
File/ Configure/ Browsing
Edit / Extract URL



Search dialog

This dialog is used to specify the search you want Turnpike to carry out of the items in the mailbox, mail 
list, newsstand or newsgroup you currently have displayed on the screen. It is called up by taking the 
Search option from the Search menu.

The search can be on a specific subject, or by a specific author or for a word or phrase in the message 
itself or perhaps in its header. The details you need to give through this dialog are:

The subject, name or string to search for. Type this in the Search for slot at the top of the dialog. You 
don't have to give this in full - just as much of this as you want Turnpike to search for.
The range of items be searched - either All; or items from here on or just the item that have been 
Selected;
What Turnpike is to search - the Subject line; the Author line or the Message text (including the 
header if you wish); and
Whether Turnpike is to match Whole words only (e.g. if you enter cat, then catalogue and catch 
would not be found if this option is checked)
Whether the Case matters (i.e. if upper and lower case letters are to match exactly what you have 
typed)

The search is started by clicking the Search first button. When this dialog is re-displayed after you have 
looked at the first item that Turnpike finds, you will be able to continue looking for further items by clicking 
the Search next button.

You can, if you want, change the details of the search before continuing - even what you are searching for
- but note, if you change the range of the search (between All, From here on and Selected), you will 
have to Search first again.

For further information, see Searching.



Search menu

In both Mail & News:
Next unread
Search message/article

In News only:
Next in group
Previous in group



Search menu / Newsstand button: Next in group
Opens up the next article in the current discussion thread / in the next discussion thread, regardless of 
whether this has already been read.

Related Topics 
Search menu
Reading news articles.
Next unread
Previous in group



Search menu / Mailbox/Newsstand button: Next unread
Takes you to the next 'Unread' message / article and opens it up for you to read.

Related Topics 
Search menu
Reading your mail 
Reading news articles 



Search menu / Newsstand button: Previous in group
Opens up the previous article in the current discussion thread / in the previous discussion thread, 
regardless of whether this has already been read.

Related Topics 
Search menu
Reading news articles.



Search menu: Search option
Calls up a dialog through which you can set Turnpike to search for messages / articles by subject, by 
author or by content.

Related Topics 
Search menu
Search diaolog 



Searching

One of the options Turnpike offers is to search for messages or articles by subject, by author or according
to the content of the message. This search can be carried out either across a single mailbox, in a mail list,
a newsgroup, or across a number of newsgroups in the same newsstand.

The first step is therefore to display the mailbox / mail list / newsstand / newsgroup in which you want the 
search to be carried out. If you want to search more than one newsgroup, you will need to return to the 
top level of the newsstand where you can see all the different newsgroups it contains.

If you are only interested in searching a selection of items, pick these out eg. by using Shift-click or Ctrl-
click.

When you have the appropriate items displayed and selected, take the Search option from the Search 
menu and set the details of the search you want Turnpike to make. Then start the search by clicking the 
Search first button included in the dialog.

What happens when a match is found depends on whether you are searching by author, subject or for a 
particular word or phrase within the text of each item:

In the first two cases, Turnpike opens the relevant item for you to read. If it isn't the one you want, 
take the Search option again and either start a new search or to continue the current one by clicking 
the Search next button.

But in the case of searching for a word or phrase, Turnpike not only opens the item but also shows 
you precisely where the given word or phrase was found - even arranging that the header is displayed
if needed. It also displays a Find dialog so that you can go ahead and find further instances of this 
word or phrase within this message. If no further instances are found, the Search dialog will be 
displayed again so that you can continue the search through further messages.

In this case if the message that's been found isn't the one you want, you can re-display the Search 
dialog to continue the search either by closing the message or by closing the Find dialog (or by calling
up the Search option again).

If you want to 'read next' or 'read previous' etc. from a message / article that Turnpike finds for you, you 
can simply use the standard options to do this: you don't have to cancel the search first. But you will then 
have to start a new search (ie. by taking the Search option from the Search menu) if you then want to 
continue searching from this point.

When you cancel a search, Turnpike automatically moves the cursor to the last item it found so that you 
can continue working from there.



Seeing the messages you've posted

Every message you send is automatically filed in your mailbase and can be accessed by calling-up the 
Mailroom view (eg. by double-clicking on the 'filing cabinet' icon on the Turnpike desktop) or by going to 
File... New Mail list and running the Mail list wizard.

To inspect a message, open it by double-clicking on it or by taking the Open message option from 
the Message menu.

To re-post a message, drag the it from the mail list either to the Out tray or to part of the background 
display. Turnpike then opens a copy of the message ready for you to change (if you want), and then 
post. You can even send it to a different person if you require.



Seeing the news articles you've posted

One way of seeing an article you post to newsgroups is, of course, to go into the relevant newsgroup. 

Your article will be among the threads marked  at the top of newsgroup, because Turnpike 
automatically marks as Interesting any thread you contribute to.

However, each article you post is added to your mailbase so you can also see these articles by calling up 
a list of everything you've sent or received such as that provided by the Mailroom view. News articles are 

shown in this list marked  and with the name of the newsgroup to which they were contributed (or 
the first of the list) as the Author.

These articles are also automatically tagged with the name(s) of the newsgroup(s) to which they were 
posted. So you can also see them in the same way as you can call up a list of all the mail sent and 
received on a particular topic - by calling up a tag list of all the items tagged with the newsgroup's name.

If you are not sure which group you posted the article to, call up separate tag lists for each possible 
group. Don't ask for a tag list covering all the possible groups because that will just give you a list of the 
articles you have cross-posted to all these groups (if any!).



Select Newsgroup Subscription dialog

This dialog lets someone with News Admin permission pick out additional newsgroups to subscribe to. It 
appears when you click the Subscribe button within the Newsgroup Subscriptions dialog.

The box in the upper part of the dialog contains a list of all the newsgroups that are available from your 
Access provider's news server. Simply select the additional newsgroups you require one by one and add 
them to the list in the bottom part of the dialog.

The Ratings button lets you call up a display of the way in which the currently selected newsgroup is 
rated under the various ratings services you are using.

If you know which hierarchy the newsgroup you require belongs to, start typing this in the Find slot at 
the top of the screen. The newsgroup display will then automatically move to the appropriate part of 
the list, from where you can scroll until you spot the group you require.

If you just know the topic you are interested, type *topic in the Find slot, then use the Find first and 
Find next buttons to work through all the newsgroups that have this topic in their title until you find 
the one you want. (Click here for further information on this.)

When you've found the entry for the newsgroup you want, either double-click on it or click the Add button 
to add it to the list in the lower part of the dialog.

When you've picked out the newsgroups you require, click OK to return to the Newsgroup Subscriptions 
dialog.

If you add any groups to which you have not yet subscribed, you will be asked if you want to add them to 
your subscription list. Click here for further information on this.



Selecting a newsstand

To select a particular newsstand, either double-click on its icon (if this is visible on the Turnpike screen) or
select it from the list of windows given in the Window menu.

Related Topics 
Newstands



    
Selecting an entry in the Address Book.

The Selection box lists the most recent Address book entries you've 
selected. Click the down arrow and select then address you want.

If the name isn't listed.
Start typing a the name the entry is indexed under in the Selection box. 
The main list will then automatically scroll to the appropriate part of your 
Address book.

Alternatively Click on the appropriate letter in the Goto box. This will 
take you to the required part of your Address book. then scroll down the 
list until you can select the entry you want.



The standard Windows techniques of Shift-click (ie. holding 
down the Shift key as you click the left-hand mouse button) 
and Ctrl-click (holding down the Ctrl key as you click the left-
hand mouse button) may be used to select a number of 
messages/articles eg. to drag them all into a Mail list or mark 
them all as read.

Clicking on one message then Shift-clicking on another selects 
all the messages between the two you've clicked on. Ctrl-
clicking on a message adds it to the range of messages 
already selected or clears it if it has already been selected.



Sending Mail

There are three types of mail message you may want to send:

· New messages  (ie. ones that don't follow on from a previous message)
· Replies to messages that you've received
· Forwarded  messages

For each of the above you are presented with an outline message. This has a Signature and other User 
Information you have specified for the mailbox you are working in. 

For example, when you reply to a message, your new message will automatically have your 
correspondent's email address and the subject of the message in place, plus a copy of their message 
(properly marked) so that you can easily quote parts of this message in your reply. 

In all three cases, the new message will have your name, reply-to address etc. set in its Header and the 
signature that's been set up for your mailbox at the bottom.

You can readily send both 'carbon'copies and 'blind carbon'copies of your messages to other people as 
you require 

All you have to do is prepare your message, check the address and the subject are filled in correctly, and 
then click the Post button.

If you are interupted or want to go on to do something else in the middle of preparing a message, just 
leave the message open on the screen or minimised as an icon. Turnpike will automatically save it on disk
for you. It will still be there when you come back to it, even if you've left Turnpike in the meantime.

Each message you post is placed in your Out tray. Mail in the Out-tray can be opened and edited (or 
thrown away) any time up to the point that you are connected to your Access provider. If you are 
connected to your Access provider when you post the message, it will stay in the Out tray for one minute. 
This gives you a chance to change your mind or edit it before it is sent.

Messages are automatically filed in your mailbase. You are able to call up your mail at any time by 
opening the appropriate mail list

Related Topics 
Mail Message menu
Preparing News / Mail messages.
Sending New email



Sending a pre-prepared message

If you have a file, such as a word-processor document, that you want to include in an email, either use the
Insert file button to load it, or drag it from the Windows File Manager into either the message or your 
mailbox.

It will appear as an icon within a horizontal bar - just like any other item you insert. If you have stored the 
message as an ASCII text file, the horizontal bar will include a Merge into text button which you can use 
to insert it as text in the new message. 

This has two advantages. Firstly the person you are writing to won't have to do anything special in order 
to read it. Secondly, you will be able both to read the message and to make any changes you want before
you send it. So do save your message as ASCII if you can.

Related Topics 
Inserting files into mail messages.



Sending mail to someone in the Address book

· Method 1 - Start the email first
1. Click the Start new email button in the toolbar., 
2. Click the Look up address button now in the toolbar above this message,
3. Select the appropriate entry in the Address book 
4. Click the Select button.

The name you have selected will now appear in the To field of the message header.
Repeat the above steps to enter addresses in the cc and bcc fields Enter the subject, complete your

message, and then click the Post button.

 This method will set up the message with header and signature as set for the mailbox selected.

· Method 2 - Look up the address first
1. Click the Address book button in the toolbar
2. Select the appropriate entry on the main Address book display, 
3. Click the Start new email to: button on the toolbar. 

If you are not sure you have the correct name at step 2 above, click the View Alter button on the 
toolbar to display the details of the selected entry. When you are satisfied you have the correct 
address click the Mail to button.

Turnpike creates a new message ready with the selected name in the To field of the message 
header.

Repeat the above steps to enter addresses in the cc and bcc fields Enter the subject, complete your
message, and then click the Post button.

This method will set a new message with the header and signature as set for your    default mailbox. 

For either method. If you want to use a special email name or to give a special reply-to address, for this 
message you willl need to edit the message header. If you want to use a different style of signature, you 
can either edit the one you're given or pick out a different one to use.

Related Topics
Address book - Overview 



Sending multiple mail messages

When you prepare a new message, you are presented with an outline form with a To box and a Subject 
box. 

If you want to sent your message to more than one person or you want to send    'carbon copies' or 'blind 
carbon copies' to people, click the the adjacent Edit mail header button    

The mail header dialog is displayed with addition slots for the main Header lines that you may want to set.

Enter the email addresses of the additional recipients in the To, cc and bcc sections of this dialog. Use 
the adjacent [+] button to add extra addresses to add additional addresses.

If you are going to use the same entries on furture messages complete set of details as a 'Distribution 
List' within your Address book. You will then be able to insert the name of the Distribution list from your 
Address book - in the same way that you Select an address    for an individual

Related Topics 
Preparing News / Mail messages. 
Sending new email
Mail Header dialog.



Sending new email

You can start a New email message (as distinct from a reply to a message that's been sent 
to you), from almost anywhere in the main Turnpike program - even from the Waste basket. 

The way you appear to the recipient of one of your messages is set typically by the, 
· signature you use, 
· email name you quote in your address, 
· email address to which replies should be sent 
· the organization you are seen to represent.

If you want to present yourself differently for different types of message, you will have set 
up a number of alternative mailboxes each with different  User information,    

To start a New email message

1. If you want the mail to use particular Signature or User informatio.
Right-click the relevant mailbox or just use the default mailbox

2. Select Start new email from the popup menu
Or select the mailbox, then click the Start new email button on the toolbar.

Messages sent from a list of correspondence with a particular person are 
automatically addressed to that person. Similarly, messages sent from a tag list are 
automatically tagged with that tag.

If you are selected anywhere other than an alternative mailbox, when you click the 
Start new email button, the user information specified for the default mailbox will 
be used.

When you click Start new email a new mail message outline is presented. The 
appropriate sender and reply details are automatically set in the message header and
your signature is at the bottom. 

3 Enter the email address of the person you're writing To or select an address from the address 
book
4 Inter a Subject in the message header.
5 Set up the text you want in your message
6. Make any changes you require to the message's header
7. Insert any files or attachments, where applicable
8. Confirm the signature
9 Click the Post button.to 'Post' the finished message

The message is then placed in your Out tray. Mail in the Out-tray can be opened and 
edited (or thrown away) any time up to the point that you are connected to your Access 
provider. If you are connected to your Access provider when you post the message, it will 
stay in the Out tray for one minute. This gives you a chance to change your mind or edit 
it before it is sent.

If you are interupted or want to go on to do something else in the middle of preparing a message, just 



leave the message open on the screen or minimised as an icon. Turnpike will automatically save it on disk
for you. It will still be there when you come back to it, even if you've left Turnpike in the meantime, you 
can finish the message and post it whenever you like.    .

Related Topics 
Mail Message menu
Preparing News / Mail messages.
Default mailbox

User information, 
Signature 
Change the signature if you want

Mail Header dialog 
Changing the message header

Select an address 
Preparing the message text

'Post' the finished message 



Setting access through the mailbox

This topic applies only to multi-user systems

The access details initially set for any message is based on the Tags information set for the mailbox in 
which it is opened.

This information is recorded on the Tags page of the Mailbox dialog, which includes settings for the 
'Default owner of the mail' and the 'Default access when filed'.

What you need to set here are the access details that you will want to apply to the majority of messages 
in this mailbox - so that you will generally get the right result even if you forget to check the access 
settings before filing the message. (It also means that you will only have to set these details in the 
messages that don't fit the general rule.) So if most messages will be private, for instance, you should set 
the 'Default access' on the Tags page to 'Private'.

In the 'Default owner' part of the dialog, you can either select a specific owner for the mail - either yourself
or a workgroup you belong to - or opt for the ownership to depend on how the message was addressed 
(ie. 'you' if the message was sent specifically to you but if the message was sent to a workgroup, it should
be owned by the workgroup).



Setting colours and fonts

Turnpike has a standard font and a standard range of colours that it uses to display the different types of 
text within mail messages and news articles, but you can use other colours and fonts if you wish.

To make temporary changes, which will be lost when you close the current window:

Go to the Options menu and select Font. This menu calls up a Font dialog through which you can 
select the Font, Font style and Font Size. Similarly the Colour option in this menu calls up a Colour 
Selection dialog through which you can select the colours for the main text and background.

To make permanent changes to a mailbox or newsstand:

Right-click the mailbox or newsstand you want to change and select Properties from the menu 
displayed. Then make your choices on the Colours and/or Fonts pages.

If you want a particular colour or font used across all your mailboxes / newsstands, record this as part
of the definition of your Default mailbox - because any colour or font you set for your Default mailbox 
is used (if nothing else is set) in all your other mailboxes and newsstands.

The fonts used for printing can only be set by the second of the methods above.



Setting the general ratings levels

This procedure can only be carried out by someone who has both Alter Workgroups   and   Ratings Admin   
permission (or who can give themselves these permissions through having either Administrator or 
Configure Users permission). You should note that, to start with, it may be that either no-one has Ratings 
Admin permission or just the Administrator has this permission.

To set the ratings levels that are to be generally applied, go to the File menu and select Configure... 
Workgroups. Select the ALL workgroup and then click the Edit button. (ALL is a special workgroup 
which is automatically set up specifically to give you an easy way of giving the same permissions etc. to 
every one who uses your copy of Turnpike.). Click the Ratings button to display the Newsgroup Rating 
Services dialog. The top part displays the rating services that are in use and the maximum levels of each 
category covered by each service that are to be applied.

To add a new service, click the Add service button shown in the lower part of the dialog and pick out 
the .RAT file corresponding to the service required. (These .RAT files are to be found in your 
Windows/System directory.) Note: The Add service button (and the corresponding Remove service 
button) are only displayed when the service details are blank or the cursor is on the name of a currently 
selected service, so if you can't see this button, move the cursor!

When you return to the Newsgroup Rating Services dialog, you will see the name of the service you've 
selected followed by a list of the categories identified by this service, together with the suggested 
maximum level for each of these categories.

To see what each selection means (and set a different level if required), select each category in turn and 
study the information given in the lower part of the dialog, then select a different level if required.

Finally, move the cursor back to a service name and choose whether unrated newsgroups should be 
hidden (treated as potentially offensive) or shown (treated as totally innocuous).

The settings you make won't be accepted if they select levels regarded as unsuitable or potentially illegal 
by the ratings service. You will need to set a lower level instead.



Setting passwords

· Set (or change) your password, 
1. Click on File in the Turnpike menu
2. Select Configure
3. Select Users.

· If you're a user of the system, 
The Edit sign-on details dialog appears - you can set a new password for yourself.

· If you have administrative permission 
1. The Configure user sign on names dialog appears 
2. Select the appropriate entry
3. Click the Edit button, the Edit Sign-on dialog details appears - this time with 

permission set options
When you set a new password, you automatically enable Turnpike's sign-on dialog. In future 
when you load either this main Turnpike program or the associated Connect program, the 
sign-on dialog will appear. You will need to fill in with your sign-on name and your password 
before you will be allowed into the program.

See also 
The Edit Sign-on dialog 



Setting personal ratings levels

This procedure can only be carried out by someone who has both Configure Users   and   Ratings Admin   
permission (or who can give themselves these permissions). Moreover, it only needs to be carried out 
where special ratings levels are required for a particular user. The ratings levels that are to be applied 
generally are set by configuring the ALL workgroup. You should note that, to start with, it may be that 
either no-one has Ratings Admin permission or just the Administrator has this permission.

To set special ratings levels for a particular user, go to the File menu and select Configure... Users. 
Select the entry for the person concerned then click the Edit button. When the Edit sign-on dialog 
appears, click the Ratings button to display the Newsgroup Rating Services dialog. The top part of this 
displays the rating services that are in use and the maximum levels of each category covered by each 
service that are currently applied.

To set this person's ratings levels, select each category for which a special level is required in turn, and 
select a required level from the options that are displayed. You may also wish to make a special setting 
with regard to how unrated newsgroups are to be treated.

The settings you make won't be accepted if they select levels regarded as unsuitable or potentially illegal 
by the ratings service. You will need to set a lower level instead.



Setting up Group mail

This topic applies only to multi-user systems

Group mail is mail that can be opened and processed by any one of a group of users. The way to arrange
for mail to be delivered to such a group is to set up one or more email names with the people or 
workgroups concerned as its users.

Assuming you have Alter Names permission, you can set up such an email name using the same steps 
that you use to set up alternative email names for yourself. The only difference is that as well as setting 
the email name itself in the Usage dialog that's displayed, you also need to set up a list of the users or 
workgroups that can use this name.

Click here for more information about Group mail



Setting up a mailing list as a newsgroup

You are only able to set up a new mailing list when you have List Subscribe permission. You are able to 
have the mail you receive from a mailing list treated as a special 'newsgroup'. This will enable you and 
other users of Turnpike at your site to use this email newsgroup. 
This will keep messages from the mailing list separate from your other mail, but will arrange to thread 
messages that follow on from each other. Each message will expire after a set time.

To set this up, first select Configure from the File menu, then select the Email routeing option from the 
sub-menu that appears. This displays Turnpike's Email routeing to seats & news dialog, There are pages 
to this dialog, with List subscribe permission you will only have access to the Mailing Lists page. This 
page shows what mailing lists are currently subscribed to through Turnpike. 

To subscribe to another list, click the Add button and then fill in the name, address etc. of the list in the 
Mailing list details dialog that is then displayed. (Note: If you later decide to cancel your subscription to 
this mailing list, you will need to remove it from the list of newsgroup subscriptions.)

If you don't already subscribe to this mailing list, you should click the 'Send email' button in the dialog so 
that Turnpike generates the appropriate subscription message for you. This message will appear for you 
to check then post when you click OK to finish with the Email routeing dialog.

When you return to the Email routeing dialog, the new mailing list will have been added to the list on the 
Mailing lists page. To read the messages that arrive from this mailing list, just add it to one of your 
newsstands in the same way that you add a newsgroup to a newsstand.

Mail from the mailing list should then start to be added to the mailing list newsgroup from the next time 
you collect mail. If it is put into one of your mailboxes instead, check the details set in the Mailing list 
details dialog, then if necessary study the page of this Help on Custom Mailing List Rules.)

If the mailing list sends a duplicate of a message already in your mailing list newsgroup, the duplicate will 
be sent to the wastepaper basket.

If you have already received any mail from this mailing list, then to add it to the mailing list newsgroup you
will need to export it, then re-import it as mail - as described in the section on Converting a mailing list to a
newsgroup.

The mailing list will have a ! at the start of its name to identify it as a mailing list but otherwise it is treated 
just like any newsgroup. In particular, the messages will initially be set to be expired after the standard 3 
days, but also just as with an newsgroup, you can set a different expiry time if you want in the Newsgroup
Subscriptions dialog - assuming you have News Admin permission.



Setting up Aternative Mailboxes

Turnpike automatically gives you one default mailbox for your mail. 

You are also able to set up Alternative Mailboxes. In each mailbox you are able to sort 
messages by
· Which of your email names the message uses
· The source of the message.
· The subject of the message

or any combination of the above

You are also able to sort messages by custom rules'

· To set up a new (alternative) mailbox
1. In the Turnpike menu click File 
2. Select the New mailbox option. This will start the    Mailbox Setup Wizard. If you want 

the new mailbox to be assigned to a new email name, add the new email name first.

Related Topics
Alter Mailbox dialog



Setting up a newsgroup

From time to time, you may feel the urge to set up a newsgroup to cover some topic that doesn't appear 
to be covered by any of the existing range of newsgroups.

This is not something that you do by calling up particular options within Turnpike. What is needed here is 
agreement from other users of the Usenet news service that there is indeed a need for the newsgroup 
you propose - and that is quite a long administrative procedure involving posting articles inviting 
responses to your proposal and counting up the votes in favour.

The place to look for information on this is in the news.groups newsgroup.



Setting up newsstands

The way you follow the discussions going on within Usenet news is by setting up newsstands containing 
the newsgroups you want to read.

You could just set up one newsstand covering all the newsgroups you want to follow, but you may find it 
useful to have different newsstands for different interests - for example, one covering newsgroups that 
you take for business purposes, another covering your recreational interests and a third covering 
humorous or other alternative newsgroups.

To set up a new newsstand, go to the File menu and take the New newsstand option. This will start the 
Newsstand Setup Wizard.

To change the details of an existing newsstand, you can either use the buttons shown at the bottom of the
newsstand to Add and Remove newsgroups etc. or take the Alter newsstand option from the File menu 
to make other changes to the newsstand.

Related Topics 
Alter Newsstands
Adding newsgroups to a newsstand
Newstands



Setting up workgroups

 You are only able to set up workgroups if you have Alter Workgroup 'permission' 

1. Click on File in the Turnpike menu
2. Select Configure
3. Select Workgroups. The  Administer Workgroups dialog appears listing any 

current workgroups.
4. Workgroups are listed by name and total number of members in each group
5. Buttons enable you to Create, Edit and Remove Workgroups

Related Topics. 
Workgroups 
Administer workgroups dialog. 



Setting where news and mail is stored

When Turnpike is installed, it automatically creates NEWS and MAIL directories alongside 
the Turnpike Connect program and sets up both Turnpike Connect and the main 
Turnpike program to use these directories.If you run out of space on the current disk, you 
will need to move either the NEWS directory or the MAIL directory (or perhaps both) to a 
different disk. 

If you need to move the whole of Turnpike to another machine or another system, 
click here.

Close the Turnpike programs both on the host machine and on any other machine on your 
system. 

Use standard File Manager actions to move the directories to their new location.

Record the new File Path information within both Turnpike and Connect.
If these files are accessed from other machines across a network, inform your colleagues of 
the new location of these files. Ensure that they record the new details in the copies of 
Turnpike they use.

There are two ways of recording these details. 

· If the Sign-on dialog is displayed when the program is run,
1. Click the Paths button in the Sign-on dialog. The File Paths dialog appears
2. Set the new path information. 

· Sign-on dialog isn’t displayed 
1. Edit the TURNPIKE.INI and the CONNECT.INI files in your Turnpike directory 
2. Record the new Newspath and Mailpath in the [PATHS] section of these files.

Related Topics. 
Email distribution
Moving Turnpike to another machine or System.
File Paths dialog
Backing up your Turnpike files.
Moving the Mail and News Directories
Upgrading to the latest version of Turnpike
Re-building the Newsbase.



Signing on

If you are the sole user of your copy of Turnpike when you run either the main Turnpike program or the 
associated Connect program, that program will simply open.

If you share your system with other users or you have chosen to protect your mail files against 
unauthorised access with a password, Turnpike's Sign-on dialog box will appear.

Enter your Sign-on name; or select it from the drop-down list. 
Enter your password (if any) 
Click the OK button and Turnpike will open.
 

Turnpike remembers the last sign-on name and file paths to be used. If you were the last user, just enter 
the password and then click OK, or just click OK.

  You are able to set a    different password. after you've signed-on.



Sign-on names
Sign-on names are the names by which the different users of your 
system are known to Turnpike. If you are the person who installed 
this copy of Turnpike your sign-on name will be the email name you 
gave at that time. Otherwise ask your system administrator for the 
sign-on name. Generally the same rules apply to sign-on names as 
email name. Typically a user's sign-on name will also be their 
principal email name, though this does not have to be so.



Signature menu
Change signature
Save signature as



    
Signature menu / Editor button: Change 

signature
Enables    you to replace the signature currently on the bottom 
of the message or article you are preparing by one of the other 
signatures that you have stored on disc. 



    
Signature menu: Save signature as
Enables you save the signature at the bottom of 
the message or article you are working on as a file
on disk for later use.



Signatures

It is Internet convention that email messages and news articles end with a signature. For 
email, the signature should give your name. A contact address or phone number should also 
be given where it may not be possible to contact you via the Internet. 

Convention suggests that the signature should be divided from the main part of the 
message by ‘- - ‘ on a line of its own, followed by a line space and then the signature. 
Typically a different colour is used for the signature and the message. Initially Turnpike 
inserts this standard form of signature for you, where the name is the full name you gave 
when you installed Turnpike.

The "- - " before the signature will help other users of Turnpike you correspond with, by 
allowing your signature to be automatically stripped from their replies (note the single space
after the second -). 

· Changing the current signature
The signature that Turnpike inserts into a message is just text. Therefore you are able to 
change a signature in a current message simply by editing it and then posting the 
message. The form of signature you edit this way will be for the current message only.

· The Standard Signature
1. For the current message/article, edit the signature to the form you require.
2. Click on Signatures in the menu.
3. Click Save signatures as ..

Turnpike will display a File Selector for you to specify where you want this signature to 
be stored. Initially Turnpike suggests you save your new signature as standard.sig in 
your user directory. Use this option for the signature you want to use for most of your 
messages. This form of signature will be used for mail and articles in you default 
mailboxes and newsstands.

· Using different signatures
Turnpike enables you to set up whatever signatures you like. In particular, you can set 
up a range of signatures for use in different mailboxes and newsstands. Turnpike will 
then insert the signature recorded for the selected mailbox.

Proceed as for a standard signature above but save the signature for each 
mailbox/newsstand as a different filename.sig name.
Select the files used in the Signature slot on the User info page of the appropriate 
Mailbox or Newsstand dialog: 

If you only want to use a particular form of signature occasionally, save it as a file as above 
but leave the mailbox/newsstand set up to give you the signature you will normally use. 
When you want to use the special signature. Click the Change signature button on the 
toolbar, or select the change signature option from the Signatures menu. Select the 
name you want to use from the signature file and then click the Open button. The selected 
name will then appear as the signature of your current message/article. 

Related Topics 
Alter Mailbox dialog - User Info page



Alter Newstand dialog - User info page



Site ID
The Site ID is the 'serial number' of your copy of Turnpike.

The Site ID of any Evaluation copy of Turnpike is generated 
automatically. You will find the Site ID for a full copy of Turnpike on 
the CD pack. You will have been asked to enter the Site ID the first 
time this full copy is run.

The Site ID can be inspected, and if necessary changed, from the 
Connect program - either by selecting    the Site Key option from the 
Configure menu or by clicking the Site Key button on this program's 
sign-on dialog.



Site Key
If you add extra features to your copy of Turnpike, for example extra 'seats' 
on a shared system, the change is recorded by entering a 'Site Key'.

The Site Key you need to use and other information about this feature of 
Turnpike are supplied when you purchase the appropriate upgrade.

When entering this key, you can use any combination of upper and lower 
case characters. Any lower case characters will be automatically switched 
to upper case for you. Also don't worry whether 0 is a zero or the letter O, or
1 is the number one, a little l or a capital I: they're actually numbers but the 
letters will also be accepted.



Site Secret
The Site Secret is a code word that is used (together with the Site ID) to encrypt mail 
messages so that they can't be read by simply opening the mail files.

The Site Secret may be blank (ie. no characters) if you want, but then your mail messages are 
only encrypted with the Site ID which someone else could find out. With a specific string as 
your Site Secret, someone trying to read your mail files would need to know both your Site ID 
and your Site Secret.

You will probably only need to enter your Site Secret once - but you should keep a record of it 
(and your Site ID) in case you ever have to re-install your Turnpike system from scratch. 

If you don't use the same Site Secret again, you won't be able to read any of the mail 
messages that were received using the previous installation.

If you didn't keep a record of the original Site Secret, someone with administrator permission 
can set a new Site Secret from the Connect program - either by taking the Site Key option 
from the Configure menu or by clicking the Site Key button on that program's sign-on dialog.



Site Specific Details

The basic registration details about your site are the Site ID and any Site Key that has been set. You don't
need to know these details for everyday use of Turnpike but you may occasionally be asked to quote 
them and occasionally new details may need to be set eg. to record the addition of extra seats. If so, they 
may be displayed by taking the Site Key option from the Connect program Configure menu (or by 
clicking the Site Key button in the Connect program Sign-on dialog).

The details can only be changed by someone with administrator permission - or by someone who can 
demonstrate that they know the Site Secret.



Smileys
Smileys are combinations of characters which when viewed with your head turned to the left (and with 
quite a lot of imagination) resemble faces.

The original smiley was simply :-) but as people were quick to realise, it is possible to represent a wide 
range of expressions by substituting different characters - particularly for the eyes and the mouth - while 
adding further characters allows you to represent headgear, bow ties etc. etc.

:-( sad :-o surprised

:-/ confused ;-) wink

Such a range of smileys have been developed that it is impossible to list them all. In any case, it is usually
fairly easy to work out what they are trying to represent.

See also Abbreviations.



Software Error nnn

"Software Error" followed by a number means that one of Turnpike's internal consistency checks has 
failed. This can happen if a file has been damaged due to the power being cut, or some other program 
crashing, while Connect is saving data. However, if the error occurs frequently it could suggest the 
machine has a problem with the reliable storage of data, either related to hardware (faults with RAM or 
the hard disk; an over-clocked processor) or to software (malfunctioning disk or memory utilities; perhaps 
a virus).

These errors are usually associated with either the news database or the address book. Special 
precautions are taken to minimise the risk of problems affecting the mail database.

The cure is to rebuild the affected database. (unless the error is reported to be in USERNEWS, in which 
case see the Notes below). Rebuilding a database recreates all the indexes and other secondary 
information, and discards any damaged data.

But before rebuilding the database, it is a good idea to run the Windows utility SCANDISK.
This will ensure your file and directory structure is valid.

After you have shut the Turnpike program and run Scandisk, start the Connect program and either rebuild
when you are prompted, or select Rebuild from the File menu.

Sometimes it is clear that you have a problem with your mail or news databases, but Turnpike reports an 
error before it has run long enough to give you a chance to do a database rebuild. To correct this, rename
the \turnpike\news\newsbase (or \turnpike\mail\mailbase) file to something else and then start Turnpike. 
The program will spot the missing file and offer to rebuild. Before accepting the offer, switch task (e.g. 
to File Manager or Windows Explorer) and rename the file back to its original name. Turnpike will then 
rebuild. If you don't rename the file back again, more information will be lost than necessary.

If the error is reported to be in the file USERNEWS then rebuilding the news database will not help. 
Instead, you need to delete the USERNEWS file. Note that this will lose information about which threads 
you have read and marked as interesting or uninteresting. Once again, use SCANDISK before running 
Turnpike again.



Sorting your Mail

Mail messages, whether delivered by the postman or by the Internet, are very much easier to handle once
they have been sorted into different categories - both when first delivered and when saved on disk. 
Turnpike enables you to sort your mail by.

· Setting up separate mailboxes for different types of mail.

· Categorising mail messages on who they were written by, written to, or what they are about. You will 
then be able to view just the mail messages that you have exchanged with a particular person or just 
the ones on particular topics.

Related Topics
Custom mail rules
Setting up mailboxes
Tagging messages.
Alternative Email Names



Spam
A "spam" e-mail is generally defined as an unsolicited mailing, usually to 
many people. A message written for, and mailed to, one individual is not 
spam A reply to an e-mail is not spam, unless the "reply" repeats endlessly. 
The term originated in a Monty Python song which consisted of just the 
word spam repeated again and again.

Similar terms are UCE that refers to Unsolicited Commercial Mail and UBE 
that refers to Unsolicited Business Mail. 

Use of Custom Mailing Rules can help you to avoid receiving unwanted mail



Spamming
Posting a news article to a large number of newsgroups. Generally frowned upon.



Spoiler
A spoiler is a convention used in News articles to hide something that the 
author does not want people to see immediately, such as the answer to a 
riddle. Some people just add lots of blank lines, so the text concerned is not 
immediately visible in the first screenful of text. 

However, if the convention of Control-L (formfeed) is used, newsreaders 
such as Turnpike can hide the text behind a button, thus:

When you use this technique, only a black line (without a button) appears in
the outgoing article.

Note. This is a Usenet convention, and cannot be used in Email.



Standard conventions

A basic feature of messages and articles transmitted over the Internet is that these are written without 
exotic styling like Bold, Italic etc. - because there's no guarantee that the system receiving these 
messages will be able to interpret the styling instructions that are used.

However, the trouble with using plain text for messages is that it then isn't easy to get over to the reader 
where you are trying to emphasise something or where you are making a wry comment. So a number of 
conventions have grown up, of which the main ones are:

Where you are giving the _title_of_something_, you start it with an Underline, finish it with an 
Underline and link all the words between by Underlines

Where you simply want to *emphasise* something, you surround it with *s

Where (and only where) you want to SHOUT something, you write it in CAPITAL LETTERS

Where you have made a wry comment, you follow this with an appropriate smiley.

See also Abbreviations.



Starting a news thread

New Users click here

The way to start a new discussion within a newsgroup is to 'post' an article which starts a new news 
thread. To do this, open the newsgroup on your screen (if it is not already open) then go to the Article 
menu and take the Start news thread option.

Turnpike then displays its Message Editor set up ready for you to post a new article. The new article is 
automatically set up to have your standard signature at the bottom. It is also set up to be posted to the 
current newsgroup. So you simply need to:

Type in the article you want to post
Set the subject in the Subject slot at the top of the display
Then click on the Post button.

The article is then placed in your Out tray, from where it can be opened and edited (or thrown away) any 
time up to the point that it is actually sent. Note: Even if you are already connected to your Access 
provider, the article will stay in the Out tray for at least a minute to give you a chance to change your mind
or edit it before it is sent.

The article is set up to tell readers to post any follow-up articles to the same newsgroup and to give your 
email address as the Reply address. If you need to set different details or you want to include either a list 
of keywords or a summary of the article in the header, click the Edit news header button and set the 
details you require before you post the article.

Related Topics 
Article Menu
For information about using Turnpike's Message Editor, see Preparing News / Mail messages.



Status bar
There is a Status bar displaying brief information at the bottom of several displays within Turnpike.

The Status bar at the bottom of the main Turnpike screen is used both to remind you how to call up 
this on-screen Help and to give a brief explanation of menu options as you select these.

The Status bar at the bottom of a newsstand is used to summarise the number of unread articles in 
the newsstand / newsgroup you are currently looking at, and the number of these which have been 
marked 'Interesting'.

The Status bar at the bottom of a mailbox is used to show how many messages there are in this 
mailbox. (Similar information is shown by the Status bar at the bottom of Mail lists and at the bottom 
of the Out box and the Waste basket when these are opened on the screen.)

A Status bar is also shown when you open a mail message on the screen. In this case, it is used to 
show who owns the message, what overall access rights have been set and what tags have been set.
Click here for more information on this Status bar.



Stopping messages being sent

If you decide against sending a message or posting an article while you are preparing it, then you can 
send it to the Waste basket by clicking the Abandon button above the message.

If however you decide against sending a message after posting it or you want to make a change to it, the 
first thing to do is to try to pull it out of your Out tray before it is sent. If it has already gone, you will just 
have to follow your message up with a correction or an apology as appropriate - though with a news 
article, you also have the option of Cancelling the article.



Subscribing to mailing lists

To join (or to leave) a mailing list, you will have to send an email message to the list's control
address. The message will state what you want to subscribe to or 'unsubscribe' from, in their
list.    You send the message to the mailing list's control address. Generally the address will 
be similar to the mailing list's address but with a suffix like -request. 

The control address is deliberately different from the mailing list's to avoid your request 
being sent to everyone on the mailing list.

Ensure you use the right address. Sending your request to everyone on the list will just 
annoy them.

A number of mailing lists use automated systems referred to as 'robots' where a 'listserv', or 
a 'Majordomo' robot is used to handle their subscription requests. These robots require the 
subscription request to be given in a standard form. 

· The listserv robot requires you to send a message to listserv@mailing-list-site, 
containing the single line: subscribe list-name your-name. 

· When you want to stop receiving mail from this mailing list, you will need to send the 
message unsubscribe list-name your-name to this listserv address.

 If you have List Subscribe permission, Turnpike will prepare and send these messages
for you. Turnpike will also arrange that the mail you receive from the mailing lists you 
subscribe to is handled within a special 'newsgroup'..

Related Topics 
Mailing Lists - Overview
Email Routeing Mailing Lists



Subscribing to newsgroups

To follow the discussions in a particular newsgroup, you firstly need to 'subscribe' to it - ie. have the 
articles that are contributed to this newsgroup downloaded to your disk. You also need to include the 
newsgroup in one of your newsstands.

To subscribe to a newsgroup, it has to be added to the list of newsgroup subscriptions displayed in the 
Newsgroup Subscriptions dialog. But assuming you have News Admin permission, all you actually need 
to do is add this newsgroup to one of your newsstands (see Adding newsgroups to a newsstand). If you 
add a newsgroup that isn't currently subscribed to a newsstand, this is automatically added to the overall 
list of newsgroup subscriptions which ultimately controls which newsgroups are subscribed to. (Indeed, if 
you want to abandon your subscription to a particular newsgroup, the way to do this is by removing it from
this overall list - see Cancelling your subscription to a newsgroup.)

On a shared (multi-user) system, however, the System Administrator may have decided not to allow 
individual users to pick out the newsgroups they want but instead to use the Newsgroup Subscriptions 
dialog to set up a list of subscribed newsgroups from which the users can pick.

The newsgroup Subscriptions dialog may also be used to set:
How long the articles should remain on your system before being expired
Whether the articles should be copied to your system in full or just browsed (see Download options 
for news)
And who can follow the discussions in a particular newsgroup if you decide to restrict access to this 
newsgroup.

New newsgroups appear and old newsgroups disappear almost daily so whenever Turnpike picks up 
articles it also picks up a list of amendments to make to the list of newsgroups it offers. Alternatively, you 
can ask Turnpike to pick up a complete new list through the Configure Usenet News dialog in Turnpike 
Connect. This is particularly useful if you change the News server you use (eg. because you change 
Access provider) because not all News servers carry the same range of newsgroups.



System administrator

This topic applies only to multi-user systems

If you are running a shared system, it is a good idea if one person takes responsibility as system 
administrator for

adding new users to seats on the system
setting up workgroups of people who can receive certain categories of email
authorising permissions for users to access various different functions in Turnpike and Connect
backing-up important Turnpike files
removing users from the system and reallocating their seats

See also Special features for multiple users in the Mail & News book.



Tag Selection Dialog

This dialog appears and is used to choose a selection of one or more tags for one of three 
different purposes:

· To add tags to a particular message.  When you click the Tags button at the bottom 
of the message window. 
See Tagging messages with their topic.

· To add tags to all the messages which arrive in a mailbox. When you click Edit on
the tags page of the Mailbox Dialog or the Mailbox Setup Wizard..

· To specify the tags required for messages to be included in a mail list. From the 
tags page of the Mail List Setup Wizard..

The tags available are listed in the upper window of the Tag selection dialog

The tags currently set for this message/mailbox/maillist are listed in the Tags Applied 
window of the dialog.

· To set the tags applied.    
1. Click the Edit button to call up the Tag Selection dialog, 
2. Select the tag in the upper window and click the Add button.
3. Repeat this for each tag you want applied.

If the tag you want isn't listed, click the New button on the Tag selection dialog.

· To set up New tag.    
To set up a new tag, click the New tag button and set up the new tag in the Make New 
Tag dialog.

Related Topics
Tagging messages with their topic
Mailbox Setup Wizard.
Mail List Setup Wizard.
Access to mail



Tagging messages

Initially any mail you file is put in your default mailbox, in the order the message was sent or received. 

As the number of messages filed grows, you will soon find it difficult to find a message. Turnpike enables 
you to identify all the email messages you send and receive with a topic tag. You will then be able to 
access just the mail for a particular tag.

As well as setting tags on the current message, Turnpike also arranges that any message sent in reply to 
this message will have the same tags.

There are several ways you are able to add tags to messages:-
· In the message window

When in the message window you will see a Tags button on the Status bar. To add a tag click the 
tag button and add the tag you require. For details see Tagging messages with their topic

· Tagging messages through the mailbox
To save yourself the effort of applying the same tag to each email message, you can set 
the topic in the mailbox definition. Incoming and outgoing mail with selected tags will be 
automatically added to the associated mailbox.

The required tags are set on Tags page of the Alter Mailbox   dialog  . These tags will also 
be applied automatically to any mail that is imported through the mailbox, see Importing 
mail and news.

· Using Mail lists
Tags can be added to mailing lists by dragging messages (either individually or as a 
selection) to mail lists that already have the required tags. Similarly you can remove tags
by dragging messages out of the corresponding mail list. This is useful when you are 
tidying up a mailbox. This technique enables you to both tag and file one or more 
messages in one action.

You are also able to drag messages from one mail list to another. This removes the tag(s)
of the first list and adds the tag(s) of the second list. 

For example, where Exhibition is one of your tags, add this tag to one or more 
messages by:-

1. Calling up a mail list of messages with Exhibition as one of its tags 
2. Drag the messages to this mail list either 

· From a mailbox
· From a list of correspondence called up via the Address book
· To or from a mail list of messages marked with a different tag. This would remove 

the existing tag and add the new tag. This enables you to re-categorise messages,
simply by dragging them from one mail list to another.

Dragging a message from a mailbox to a mail list also files the message, thus allowing 
you to both categorise messages and file them in one easy movement. For example, to
categorise messages as either Project X, Project Y or Project Z. 
1. Set up the tags. 
2. Call up a mail list for each project.
3. Minimise the maillists 
4. Drag the messages to the appropriate icon for filing.



Related Topics
Access to mail 
Edit Email Tags dialog
Tag Selection dialog
Tagging messages with their topic
Alter Mailbox dialog    Tags page    
Importing mail and news.



Tagging messages with their topic

Tags are generally added to messages you receive as you read them and to messages that you send as 
you prepare them

· To tag a message
1. Click the Tags button on the Status bar at the bottom of the message window. 

The Tag Selection dialog will appear. Tags already set up are listed in the top part of the dialog.

2. If the tags you want to use are listed click a tag then click the Add button. Repeat this for each tag
you want.The tags selected are shown in the bottom part of this dialog.

If there are many tags listed, click the Show check box(es) to see just the tag types you require. 
Type a tag name in the Find box to jump to the tag.

· To add new tags
a) Click the New tags button, the Make New tag dialog will appear
b) Enter a name for the new tag
c) Select the Private, Group or Public option

· To alter usage    - see Access to mail  
1) Click the Access button to display the Alter usage dialog
2) Select either the Individual or Workgroups option. Available names are listed in 

the left hand box of the dialog
3) To add extra users select a name and click the Add button
4) To remove an extra user select a name and click the Del button

see Access to mail  

Click OK to apply each dialog and return to the Tags Selection dialog.

3. Click Ok to clear the dialog and apply the tags.
When you return to the message, the tags you've selected will be shown alongside the Tags 
button on the status bar at the bottom of the message window.

Related Topics
Tagging Messages
Edit Email Tags dialog
Tag Selection dialog
Access to mail  



    
Tags
Tags are markers used to 
identify email messages for 
filing. Each tag is like a label on 
a folder in a filing cabinet. 



Partial Matching with Wildcards
When you want to tell Turnpike a name or a topic to look for among newsgroup names, 
subject lines, or address lines, use the 'wildcard' characters ? and * , where, ? means 
match a single character and * means 'match any number of characters'.

Ensure that the combination of characters will enable Turnpike to determine precisely the
pattern it is to match. For example, to tell Turnpike to pick out messages sent from 
anyone@anycompany.com or anyone@anycompany.co.uk match the address from 
which the message was sent against *anycompany*

Where you want Turnpike to pick out a newsgroup name or a subject line containing a 
particular word or phrase (astrology, for example), type *astrology,  you don't need to 
type the final *. 

An example of the use of multiple * characters is, *aut*ant which could be used to pick 
out a newsgroup called alt.autos.antique.



The permissions

The different permissions that a user may be given are as follows:

Administrator Able to configure Users. This includes adding new users,    setting other users 
sign-on details and permissions and    Rebuild datafiles 

Connect Admin Able to alter the Host, Timezone, Mail Transfer, News Collection and Service 
Access details recorded through the Configure menu in the Connect program. 
Also allowed to Configure the Toolbar in the Connect program and to make 
permanent changes to Call cost logging.

Dialling Admin Able to alter the New/Edit Connection dialog using the Connect program.

Email Admin Configure Email Routeing. Able to set how email is distributed to different users 
and who handles Dead Letter Mail

News Admin Able    to Configure Newsgroups - ie. to select which newsgroups are subscribed
to, to set how long articles remain on your disk before being expired and to 
restrict access to particular newsgroups.

Alter Users Able to Configure Users - ie. add new users, set other users' sign-on details and
permissions.

Alter Workgroups Able to Configure Workgroups.

Alter Names Able to set up Email names for any user.
Add Email Names Able to set up Email names for themselves.

Connect to Net Able to run the Connect program and connect to your Access provider.
Keep articles Able to mark articles to be kept beyond their normal expiry time.

Kill articles Able to kill individual news articles and to set up Kill rules.
List Subscribe Able to set up mailing lists as pseudo-newsgroups available to any user.

Rebuild Files Able to rebuild the news database, the mail database or the address book as 
required.

Ratings Admin Able to set the newsgroup ratings controlling which newsgroups can be seen by
different users.

Serve POP3 Able to access the mail in their Turnpike mailbox from outside their Turnpike 
system.



Threading
The process of working out how the different articles in a newsgroup follow on from each other is known 
as Threading.

Turnpike automatically threads each newsgroup before you go into it. You can also prompt it to re-thread 
the group that you are currently working in by clicking the Refresh button at the bottom of the newsstand.



Trouble Shooting
For advice on any of the following, click on the appropriate entry:

Missing articles

Only headers were downloaded

Browse group contains full articles

'Software' errors

Fonts/colours not saved

Downloaded email not found

Email being deleted from the POP3 server

For advice on connection problems, consult the Troubleshooting section of Turnpike Connect's help file.



Turnpike can be configured for up to 99 independent users. New users are set up by going to the File 
menu and selecting Configure... Users. Each effectively has their own desktop including a personal set 
of mailboxes their own newsstands. By using a sign-on password, each user can make some or all of 
their correspondence private.

A problem of all shared mail systems is that some of the mail received is private mail to individual users 
while other items such as sales enquiries can potentially be responded to by any of a number of people. 
Turnpike has two schemes to help here. One is the concept of Workgroups and Group Mail which initially
appears in the mailbox of every member of the group. The other is to make every item of mail private to 
the recipient to start with, but to let you mark individual items as available to some users or to all if you so 
wish.

Whether Turnpike is used in a family or business environment, it can be sensible to restrict the number of 
functions available to some users. This is done through a series of Permissions which can be granted by
an Administrator. Details of these are available by clicking Help when in the Configure... Users dialog.

Although all the users will access the same newsbase (to avoid duplication of articles), the newsstands 
through which they follow the discussions in the newsgroups will be completely independent of other 
users' newsstands. You will only see articles marked as 'Read' or 'Interesting' or 'Uninteresting' when 
you've marked them that way - not when someone else has read them. 

However, newsgroups cover a very broad range of topics. So Turnpike lets you restrict the range of 
newsgroups that can be accessed by individual users, firstly by limiting the people can see the full 
newsgroup list and subscribe to newsgroups to those with "News Administrator" permission. Users 
without this permission can see only the list of newsgroups which have been subscribed. Moreover, each 
subscribed newsgroup can be made visible to only some users. So the newsgroup 
alt.care.and.feeding.of.aardvarks can be subscribed to, but it can be hidden from pro-Ant users. This 
might be useful if there's a newsgroup you subscribe to that you don't want your children to read. 
Contributions made to newsgroups are also hidden from users who don't have access to those 
newsgroups.

The standard version of Turnpike will only allow one user to access the stored mail and news at any one 
time (though this can be across a LAN). However, "Multi-access" versions that will allow a number of 
users to access the stored mail and news at once are available on request to info@turnpike.com.
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Turnpike writes most of the header automatically, including your own email address (for replies) and the 
date and time. Normally you only need to add two things:

The email address you wish to send the message to. If this person has an entry in your Address Book
you can press the Look up address button and select a person. Turnpike will then add the address 
to the email.
A subject. It is a good idea to make this informative so that your recipient notices it amongst all their 
other email.

The Edit mail header button and Send MIME message checkbox give access to more advanced 
features which we will explore later in this tutorial.



    
This tutorial is designed to show the basics of working with Turnpike. It is written for someone with 
little or no experience of Internet software. However, even if you are already an expert, you may 
still find the tutorial helpful, as it provides tips for power users and information about the particular 
strengths of Turnpike.

In the first section of the tutorial you will learn about email addresses, how to read, write and 
reply to emails, ways to customize your mailbox and about using different signatures.

We shall then go on to look at more advanced topics, such as sending mail to a group of people 
and attaching files to messages. The section ends with a look at turnpike's facilities for tagging 
messages and producing mail lists.

Next we take a look at newsgroups: what they are, and how to use them. Turnpike's facility to 
treat mailing lists as newsgroups is covered here as well.

Finally, we will look at how a Turnpike system can expand to include extra mailboxes, additional 
email names and up to 99 independent users.

If this is your first time using the tutorial, we suggest you go through it in order, using the next    >> 
and back << buttons - and the bookmark menu if you want to save your place in order to come 
back to it later. Otherwise, you can click on any of the links (in green) to explore topics that interest
you. There are 24 main topics, many with illustrations and additional information.

Let's go!
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Domain indicators include:

.ac academic institution (UK)

.co company (usually UK)

.com commercial business

.edu educational (USA and elsewhere)

.gov government organization

.mil military (USA)

.net network provider

.org charitable or research organization

Other UK domain indicators include:

.ltd limited liability company

.nhs hospital or NHS trust

.plc public liability company

.sch school

Country codes include:

.au Australia

.ca Canada

.de Germany

.es Spain

.fi Finland

.fr France

.ie Republic of Ireland

.il Israel

.it Italy

.jp Japan

.kr Korea

.nl Netherlands

.no Norway

.nz New Zealand

.se Sweden

.tw Taiwan

.uk United Kingdom

.za South Africa



Tags
Tags are labels that you invent and attach to messages, offering a powerful method of indexing them for 
later retrieval. Tags can be applied automatically, and you can tag a single message with a number of 
different labels. For example, you might have tags for Family, Holiday, Expenses, Computer Tips - any 
subject you want. When you want to see messages on a particular subject, Turnpike can produce a list of 
them all - perhaps a list of all messages tagged Holiday and Expenses, for example.

There are three ways to tag messages:

Turnpike can apply tags automatically. You can arrange this by going to the Tags page of the Alter 
Mailbox dialogue. This is particularly useful if you use separate mailboxes for different purposes 
(business, family, etc.).
You can add tags manually by clicking the Tags button on the status bar at the lower left of the 
window in which you read and write email.
You can simply drag messages in and out of the Mail Lists described below.

The first two of these methods takes you to the Tags selection dialogue, where there is a button for 
adding new Tags.
You can set tags to govern who should have access
to different types of mail, if you run a multi-user system. Tell me more.

Next we shall take a look at how tagged mail can be retrieved using a Mail List.
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Mailing Lists
Mailing lists are like newsgroups in that there are many tens of thousands of them, each devoted to a 
specific topic. They tend to be more tightly focused and sometimes more specialist. Contributions are 
distributed to subscribers by email rather than through the news system.

So that mail you receive from mailing lists does not clog up your mailbox, Turnpike enables you to have 
the information you receive from mailing lists handled like the articles you receive from newsgroups. 
Mailing lists can be added to a newsstand. The email messages are linked together in threads whenever 
possible. Messages are automatically expired from your hard disk in the same way as news. To make 
things even easier, Turnpike also helps with administration matters such as subscription requests to 
mailing lists.

Tell me more about converting a mailing list to a newsgroup.
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News symbols

In a Mailbox:

Unread message

Message that also appears in another mailbox (see Mailboxes)

Item of Group mail

Message that has been read

Message that is mirrored from a POP mailbox

Message that's private to you

Message that only you plus a restricted list of other users can read

In a Message:

Element of message that is offered in a choice of Alternative forms. 

(on a horizontal bar) File enclosed in a message (see Extracting files from messages)

(on a horizontal bar) Forwarded message follows.

(on a horizontal bar) Forwarded article

(on a horizontal bar) Text file enclosed in a message (see Extracting files from messages)

(on a horizontal bar) Returned mail

(on a horizontal bar) Document that uses an unknown character set: may not be shown correctly

 or 

 (on a horizontal bar) Text 'signed' using author's PGP signature

(on a horizontal bar) External body

In a Mail List:

Message that has been received

Message that has been sent

An article posted to a newsgroup

Message currently in an In tray

Message currently in a Pending tray

Message currently in your Out tray

Message that is mirrored from a POP mailbox

Message that's private to you

Someone else's private message



Message that only you plus a restricted list of other users can read

In the Out tray:

Message waiting to be sent

Message with multiple recipients waiting to be sent (Number of recipients shown in the box; 
individual messages also shown as waiting to be sent)

Message that is being transmitted*

Message that has been sent*

Message that couldn't be sent*

* Seen only very rarely



Email addresses have two halves, email name and domain, separated by an 'at' symbol:

Email names conventionally use lower case letters (some systems require this). Domain names consist of
two or more parts separated by dots. Here the dot separates the company name (widgets) from the 
abbreviation com (a commercial organization).

More on abbreviations

One or more email names may be allocated to you by your Internet Service Provider. However, Demon 
customers are allocated their own host within the demon.co.uk domain, and can use whatever email 
names they want. So Demon email addresses take the form:

You could use different email names (joebloggs, joe, jbloggs, etc.) for different types of correspondence, 
such as business, social and hobbies. You could also use different email names (marybloggs, mary, bill, 
etc.) for various members of your family or company. Later in this Tutorial we will take a look at the many 
ways in which Turnpike can expand to meet your needs by adding the email names, mailboxes and 
extra users that you require.

 How do I change my email name in Turnpike?
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You can reveal the ruler by going to the Options menu and selecting Display ruler. Select it again to 
hide the ruler. Here is an explanation of the various symbols on the ruler:

Left and right margins. You can drag these markers to the positions you want, but keep to about 72 
characters per line, as others may have trouble reading messages if line lengths are too long.

You can move the two parts of the left marker independently to produce paragraphs with various 
indent effects (or press Shift-Tab for a temporary indent).

Default tab positions, set at every 8th character along the line.

Click on the ruler to add a tab and clear the default tabs to the left of it. New tabs can be dragged to a 
different position or dragged off the ruler line if not required.



Preparing a message in Turnpike is rather like using a word processor. How you write is, of course, 
entirely up to you. Many people use a brief, informal style:

When you have finished, you will be ready to post the message. We'll take a look at this next.

        To find out more about signatures, click here  .

To find out how to send carbon copies of your email to other people, click here.

        To find out how to set fonts and colours for messages, click here.  
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Preparing the text of a message in Turnpike is very much like using a word 
processor. You can

enter and delete characters using the keyboard keys
undo and redo changes by taking the appropriate options in the Edit 
menu
delete, copy or move text by highlighting it and then taking the Copy, 
Cut and Paste options from the Edit menu
include files in your message by using the Insert file button
find and replace text by taking the appropriate options in the Edit menu
move margins and tabs by dragging and clicking on the ruler (if no ruler 
is shown, select Display ruler in the Options menu).

The main difference is that fancy styling isn't appropriate in mail messages 
or news articles because there's no guarantee that the system receiving 
these messages would be able to interpret any such styling instructions.



You can set each of your mailboxes to flash whenever there is mail in the Intray, to flash only if 
there is unread mail there, or never to flash. To set your preference, 

either right-click a mailbox and choose Properties
or left-click the mailbox and then select Alter Mailbox from the File menu

Make your choice on the Name page of the Alter Mailbox option.
You also get this choice whenever you create a new mailbox.



    
Tags
Here you specify any Tags you want added automatically to 
messages in the mailbox. Later in the tutorial we shall see how 
tags can be a very useful aid to filing and sorting mail. You can 
also set whether mail should have private, public or restricted 
access if you have multiple users sharing Turnpike.



    
Rules
Here you add rules to govern what messages the mailbox will 
accept, e.g. Accept: all mail for 'jenny' and Reject: subjects 
matching '*special offer'. You can only set rules for additional 
mailboxes - this option will be greyed out for your default 
mailbox, as that has the single unalterable rule that it accepts 
everything that isn't accepted elsewhere.



    
Using fonts
While you can select any font available on your system, if you choose a proportionally-
spaced font for the screen, you won't get a consistent number of characters per line and 
some lines may contain more than 80 characters, which may cause problems for people 
reading your messages. Also text written in columns and ASCII art (diagrams made from 
keyboard characters) will probably not line up properly. So, although it may look a bit 
dull, most people tend to use a fixed pitch font.

Obviously, you want your messages to display accurately when they are received, 
whatever the type of computer that is used to view them. This can be done by limiting the
characters you use to 7-bit ASCII (upper and lower case letters, numbers, punctuation 
and most of the symbols on your keyboard, although not the £ sign). Turnpike will warn 
you if you do use a character that could be problematic.

There is no provision in a normal email message for sending fonts, colours or effects 
such as bold or italic. Because of this, any fonts and colours you set in Turnpike are 
purely for your own convenience and will not be seen by the recipients of your 
messages.



    
Signatures
Turnpike lets you set up a range of signatures and associate a 
different signature with each mailbox (and newsstand) you use.

To make a new signature, click Start new email and type what 
you want in the signature area below the long blue dividing line. 
When finished, go to the Signature menu, select Save 
signature as... and choose a name for it. Just the portion below
the dividing line will be saved - as a simple text file with a .sig 
extension.

When writing a message you can select a new signature at any 
time by clicking Change signature... in the Signature menu. If 
you want to make a one-off change for that particular message, 
just type what you want in the signature area of the email. 
Mailboxes use the standard.sig by default, but you can change 
this from the User info page of the Alter Mailbox dialogue.

     

Tips on Signatures
Signatures should start with  (two hyphens followed by a single space) on a line of its own. This 
special code enables other people's software to strip out your signature automatically if they quote your 
message in a reply.

It is a good idea to keep signatures to no more than 4 lines, especially if your message is going to be 
downloaded by a lot of people on a mailing list or newsgroup. For private email your signature might show
other ways in which people could contact you, such as your postal address and telepone/fax number, 
although consider whether it is prudent to reveal such information if you are writing to strangers or to a 
public audience.
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Sending email to a group of people
Turnpike provides several facilities for sending the same email to several addresses. The first two 
methods are accessed by clicking the Edit mail header button on the email editor screen. This reveals 
slots for carbon copies (cc) and blind carbon copies (bcc):

If you use cc, every recipient can see who else has been sent copies, but if you use bcc then none of the 
people listed here can see the other addresses. You can use the Look up address button to transfer 
addresses from your Address book, or you can paste them in from elsewhere, using Shift-Ctrl-V. To add 
more addresses to the list, click the + button, to remove addresses, click the - button. The button with the 
down arrow reveals a drop-down list of the addresses you have entered.

Distribution lists
If you regularly mail the same group of people, perhaps to send a newsletter, you may find it easier to 
make a Distribution list. This is a special address book entry, consisting of a list of the email addresses of 
people who should receive copies of particular mail messages - they can receive normal copies, carbon 
copies or blind carbon copies. You can set up a Distribution list by opening the Address book and clicking 
the New list button.

Page 12 of 25





Newsgroups
Usenet, short for Users Network, is the largest discussion forum in the world. It consists of tens of 
thousands of newsgroups, each devoted to one specific topic - hobbies, interests, jobs, jokes ... every 
imaginable subject, in fact.

Messages sent to newsgroups are called articles. They get passed around the globe from one news 
server to another and quickly become available for anyone in the world to download and read. 
Newsgroups don't exist in any one place - they are just collections of articles that are available to anyone 
with a connection to a news server.

To read messages from a newsgroup, you must first subscribe to it. This means that you must set 
Turnpike to download articles from the newsgroup you want (it doesn't mean that a fee must be paid!). 
Then, each time you connect to the Net, you will download the latest articles posted to the newsgroup.

Newsgroup names
The name of a newsgroup describes the type of information it discusses. These names consist of two or 
more parts, separated by dots and also indicate the hierarchy to which the newsgroup belongs. For 
example, rec.pets.cats is a newsgroup in a part of the recreational hierarchy that deal with various types
of pets. You will see from this that each successive word to the right narrows the focus of the 
newsgroup's business.

More about newsgroup names.

Newsgroups containing the word binaries include data which is not just text - particularly pictures. These 
can take a long time to download and can quickly fill up your disk space. Turnpike includes various 
facilities for filtering news in order to help with this problem.
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News articles are generally kept only for a week or
two by Internet access providers (in fact, binaries 
may be kept only for a few days). So, if you don't 
log on very often, you may find that some articles 
are no longer available.



You can open a newsstand by clicking on its icon. Once you have subscribed to some newsgroups and 
downloaded some news, you will see a window something like this:

The figures in the green boxes show how many unread articles you have in each newsgroup, while the 
yellow boxes show how many unread articles you have in threads that you have marked interesting (we 
shall learn more about this shortly).

The buttons at the bottom of the newsstand enable you to Alter the properties of the newsstand (fonts, 
colours, and so forth), Add and Remove newsgroups, and Move newsgroups up or down the list in order 
to get the reading order you prefer.

Double-clicking on one of the entries in the newsstand will open that newsgroup and reveal the articles it 
contains.

The easiest way to read your news is to press the spacebar.
This will take you through each unread item in turn.
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There are several reasons why the number of 
unread articles you see in a newsstand may not 
match the number of items you observe being 
downloaded by Connect. Click here to find out 
more about this.



When you view the contents of a newsgroup, you will see a window something like this (each entry is a 
thread - a set of articles all discussing the same topic):

The symbols in the left hand column are produced by using the Mark as interesting and Mark not 
interesting buttons above the window (or you can double-click on the symbols themselves to change the 
status of a thread). If you choose to mark a thread as interesting, it will be given a  marking and 
will be moved to the top of the newsgroup to attract your attention. Threads you mark as uninteresting, 

, get demoted to the bottom of the list. The Refresh button will redraw the window if you want to 
see the effect of any such changes immediately.Other symbols here include 

 (as with email, this indicates read items) and 

 to show that an article is to be kept. This is done by going to the Classify menu and choosing 
Keep.

Click here to see a complete list of the symbols associated with news.
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If you click double-click on the title of a thread, it expands to show a tree of how individual articles in the 
thread are related to each other. You can also go to the Article menu and select options to expand or 
collapse the selected tree or all trees in the newsgroup. When a tree is expanded you will see something 
like this:

Here, an article by Helen was responded to by John, Simon and Paul. Hugh followed-up the reply from 
John, and then Ray responded to Hugh's article.

Normally, reading news is best done by using the space bar to move through each new article in turn, but 
sometimes it is helpful to view the tree structure of a thread in order to be sure of who said what in the 
discussion.

Page 20 of 25



News management
Since the number of articles posted to many news groups is very large, Turnpike provides a number of 
facilities to help you keep the download and storage of news articles to manageable proportions.

News articles are only kept on your machine for a limited amount of time, after which they are 
automatically erased when the Connect program is run. The default time is three days, but you can set a 
different expiry time for any newsgroup by going to the File menu and choosing Configure... 
Newsgroups. The newsgroup subscription dialog that then appears includes an option to Auto Keep all 
articles in the newsgroup, if you want to arrange for them never to expire. If you just wish to preserve 
occasional articles of interest, go to the Classify menu and choose Keep Article (or you could use the 
option in the File menu to Export the article as a plain text file, if you prefer).

The news subscription dialog also offers the alternative for each newsgroup to browse the articles 
instead of downloading them in full. With this option, you will collect just the header of each article (name 
of subject, author, date, etc.) which should be enough for you to see whether there is anything of interest 
to you. If you spot an article you want to read, you can request it to be downloaded the next time you go
on-line to the Internet.
If you choose to browse a newsgroup, Turnpike will let you set kill rules to accept certain
types of article in full, even though only the headers of other messages get downloaded.

Turnpike also offers a wide range of Kill Rules. These enable you to avoid downloading articles that are 
unlikely to be of interest. This is done by going to the Classify menu and selecting Kill. Options include 
killing further articles in the thread or by the same author or with the same subject. A Custom rule option 
offers more advanced functions, including the facility to kill articles over a certain length, or even to write 
your own kill rules using a language that Turnpike provides for the purpose. Click Help when using this 
dialog to find out more on this topic and to see examples of custom kill rules that you could adapt.
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Posting a news article
Although using Turnpike's editor to write a news article is similar to writing an email, there are some 
important differences to bear in mind before you post a news article. Unlike email, you will be posting 
something that potentially may be downloaded and read by thousands of people around the world. Here 
are some pointers:

Make sure that you post to the right newsgroup as off-topic articles are unwelcome.

Read the newsgroup concerned for a reasonable period before posting an article. This will give you 
an idea of the style of the group and help you spot if the question is unnecessary because it has 
already been answered recently. There may well be a FAQ list of Frequently Asked Questions (with 
answers) posted at intervals.

If you are asking a new question, go to Turnpike's Article menu, choose Start News Thread and add
a meaningful subject line.

If you are responding to an existing article, use the Reply button - but only quote enough of the 
previous article to show the context of your comments, as people don't need to download complete 
copies of articles they have already seen.

Write your comments below any material that you quote.

Unless you are having problems downloading news, it is not a good idea to ask for replies by email - if
you post a question in public, others may wish to see, or comment on, the answers. 

avoid writing in capitals (it's called SHOUTING!) and use a short signature (4 lines is quite enough).

don't post the same message more than once or to multiple newsgroups

Remember that these conventions have developed for good reason - if you ignore them you may find that
people's responses are less helpful than you would like. If you haven't posted an article before, try 
sending practice articles to one of the test newsgroups, such as demon.test. You can find more on the 
subject of netiquette in the regular postings to the newsgroup news.announce.newusers and in the file 
FYI28.WRI which you will find in your Turnpike directory.
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Click this button to Abandon your message. It will be 
sent to the Waste basket and will be finally deleted when
you exit from Turnpike. Until then, you can retrieve it if 
you wish by double-clicking the Waste basket and then 
double-clicking the message.



Finds an email address from 
your Address Book.



Type the text of your message above the long blue line. The space 
available expands as you add more text. You can change the screen font 
and colours to suit your own preferences. We will look at this in the 
Customizing your mailbox section of the tutorial.

Email has to be capable of being displayed accurately by any type of 
computer that can receive it. You can use upper and lower case letters, 
numbers, punctuation and most of the symbols on your keyboard. However,
characters such as ©, á and even the £ symbol may not be received as 
you intend. If you include one of these, Turnpike will warn you when you 
post the email. You can choose to post it anyway if you know from 
experience that your recipient's machine will cope. If not, you should edit the
message to avoid any ambiguity. For instance, you could say UKP (UK 
pounds) instead of using the £ symbol. This would be preferable to quoting 
a price as £23 which your recipient could see reproduced as $23.



If you have created a range of 
signatures, you can click Change 
Signature to select a different one for
the current message. We shall take a
look at creating signatures later in 
the tutorial.



Turnpike allows you to choose different colours for normal text, 
selected text, quoted text, headers and signatures, as well as the 
colours you prefer for backgrounds. You can set different colour 
schemes for reading and writing messages, and for the appearance 
of the mailbox itself. If you use multiple mailboxes, you can have 
different colour schemes for each one.

Other aspects of the colour scheme that Turnpike uses (such as the 
colours of the Turnpike desktop and button bars) depend on the 
general settings you use for Windows.



Writing an email
Click Start new email on the button bar to launch Turnpike's editor. You will be presented with a blank 
email template, with distinct areas for the header, the body of the message and a signature. Click on any
part of the picture below to find out more about these areas, about the various buttons and about the 
ruler.
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Moves the selected item(s) to the Waste basket, 
where they stay until you close Turnpike. Until 
then, you can rescue items from the Waste 
basket if you change your mind.



Moves the selected items from 
your mailbox and files them in 
the Mailroom.



This enables you to place a copy of a file from 
your computer into your email. This could be a 
text document, a picture, a sound file, or even a 
program. We will take a look at sending files by 
email later in the tutorial.



Turnpike is an integrated suite of applications for Internet access.

It consists of two main programs, Connect and Turnpike itself.

Connect is used to go on-line to the Internet. It includes facilities to

dial-in to your Access Provider
send and receive email and news
log time and costs spent on line
launch other programs from a configurable button bar

Power users: click here for more

The main Turnpike program is for off-line use. The Turnpike desktop includes

mailboxes for reading and writing email
newsstands for reading and writing news articles
an address book for the email addresses you use
a mailroom for filed messages, an out tray and a waste basket

Power users: click here for more

Turnpike can be configured for multiple users, any of whom can be denied permission by an Administrator
to access various parts of the program. If you are using Turnpike in this way, and find that you are barred 
from using a function, consult the Administrator of your system.
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Click this button to find an email 
address from your Address Book.
Turnpike will insert the address into 
the To: slot of your email. 



The buttons at the bottom of this screen show what is currently being displayed. The left button alternates
the view between Arrival order and Sent order, while the button next to it cycles through the options of 
viewing Incoming, Outgoing or All mail.

The symbol  indicates this message is currently in the Out Tray and the symbol 

 shows that it is an outgoing message. The symbol 

 identifies one of the messages as private (i.e. it cannot be read by other users of the system). 
There is a full list of these Symbols in the Turnpike help file. Click here to view the Mail Symbols now.



Moves selected email between the In Tray and Pending Tray.



Here you can:
change the name of your mailbox
set if (and how) the mailbox should flash if it contains mail
choose if you want addresses from incoming email to be 
added automatically to your address book
remove spare mailboxes (if they are empty) by clicking the 
Destroy button





    



Communicating with a remote part of the world
Email can get delayed if machines or connections break down, or if 

you are communicating with a remote part of the world.

Although large organisations often have a permanent connection to 
the Net, others (especially home users) will only see their email after they 
have dialed-in to collect it - and this may be relatively infrequently.

Even when the email has arrived at its final destination, rather like 
sending a fax, you cannot be sure that anyone has got around to reading it.



Configuring you Address book

1. Right-click on a Mailbox.
2. Select Properties.
3. In the Address book area of the first page, choose the option you 

prefer.

If you decide that addresses should be added automatically, the entries will 
also be indexed, typically under the person's first name, surname and 
domain. You can add extra information (or remove entries) later by going to 
the Address Book and altering the entry.



Click Post when you are ready to send your message. The email will move to the Out Tray, where it will 
stay until you next connect to the Internet (if you are already connected, or if the message is for a mailbox
on your own system, it will be sent on about 60 seconds later).

If you change your mind, you can inspect, edit or abandon the message by double-clicking it while it is still
in the Out Tray, or you can drag it from the Out Tray onto your Turnpike desktop where it will remain until 
you are ready (it will stay there unsent, even if you close down Turnpike).



Connect reports statistics about your connection, including on-screen displays of data transfer rates and 
any over-run errors. It has a facilities for debugging and logging details of connections, and includes built-
in tools for

          Telnet           
Finger
          
Ping           
Traceroute

Connect includes a button bar for launching other programs to use on the Internet, including a browser 
for accessing the World Wide Web and and an FTP program for downloading files from remote 
computers. You can add other programs to this button bar if you wish, thus making Connect an operations
centre for all your Net activities.

Connect can be set to collect your email by either SMTP or POP3; it can adjust your computer's clock to 
UTC (Universal Co-ordinated Time) and it will automatically display any MOTD (message of the day) 
provided by your Access Provider.

Information on all of these facilities is available in the Connect help file.



Turnpike includes many advanced features for mail handling.

There is no need to cc email to yourself. Copies of all outgoing messages are filed automatically 
in the Mailroom.

Tags and mail lists allow you to organize and view your messages under whatever topics you 
choose.

Just drag and drop (or click Insert File) to attach a file to an outgoing message. A single mouse 
click will launch the appropriate application for viewing incoming mail attachments.

You can add extra mailboxes, each with its own properties, for sorting incoming mail.

Mail from mailing Lists can be routed as news, freeing your mailboxes for personal items and 
giving the advantages of automatic threading and expiry.

You can also add extra users to Turnpike, each with their own email names and customized desktops. 
Features for such multi-user systems include facilities to set up workgroups for dealing with mail and for a
system administrator to set a range of permissions to limit the access of other users to various parts of 
the system.

We shall take a closer look at these features later in the Tutorial - or you can click on any of the 
underlined links to go straight there now.



To use a new email name you must first add the name to Turnpike, as follows:

1. Go to the File menu and choose Configure... Email names.
2. Select the name to change and click Edit.

If you want to add an extra name, click Create instead.
3. Type the email name in the name slot. Click OK and then click Close.

To make a new mailbox to use with this email name, go to the File menu and select New... mailbox. A 
wizard will guide you through the rest of the process.

If you want to use your new email name in an existing mailbox:

1. Right-click the Mailbox and select Properties.
2. Choose User Info and then select your new email name from the drop-down list. Change any of the 

other details on this page that you wish.
3. Choose Rules. Unless this is your default mailbox, click the Add button and select an appropriate 

rule - often this will simply be to Accept mail addressed to the new email name you created. Click 
the OK buttons to finish.



Receiving and reading email

When someone sends you an email, Turnpike places it in your mailbox.
If the mailbox is not already open it can flash as a reminder that there is unread email.

      indicates an unread email, which changes to

      after you viewed the message. Other Symbols are explained in the main Turnpike help file.

The easiest way to read email is to press the spacebar. This takes you through each unread message, 
scrolling the screen when needed. Or you can double-click on an item to view it.

The lower part of each mailbox is a Pending Tray for messages you don't want to deal with immediately. 
You can move email between the In Tray and Pending Tray by dragging it with the mouse or clicking the 
Move buttons on the Toolbar above the mailbox.

The Mailbox Toolbar also gives a range of possibilities for what to do next.

Next we'll take a look at replying to emails you receive.
How to change the way your mailbox flashes
How to change a mailbox's fonts and colours
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Sets up a new message for you to send in reply to the selected email.
We shall look at this in more detail in the next section of the tutorial.



 
When you click Reply, Turnpike sets up a new email for you to 
send back to the author of the original message. It also ...

1. Fills in the email address of your correspondent and the 
subject:

2. Adds an attribution (a text indicating the source of the original):

3. Copies the original text (minus the signature) as a quotation, 
highlighting it in a different colour and marking it out with
the symbol > at the start of each line:

Note: The convention is to write your reply below the quotation:

4. Adds your own signature at the bottom of the reply:

You can edit the attribution text and signature on the reply, if you wish. However, you can also change the 
default settings for these (and much more) by using the Alter Mailbox option. We shall see how to do this
next in the tutorial.

If you want to cut down quoted material (something that is often appreciated) use the mouse to highlight a
section to discard and then press delete. Insert your replies to the various issues raised, then click the 
Post button.

If you just want to reply to one part of a message, highlight a block of the original message before you 
click the Reply button. Then the new message will just contain the selected text. Show me
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Click Post when you are ready to send your message. It will move to the Out Tray, where it will stay until 
you next connect to the Internet. If you are already connected, or if the message is for a mailbox on your 
own system, it will be sent on about 60 seconds later. You don't have to Save your email as everything 
you write gets automatically stored in the Mailroom.

If you are not ready to send your message, don't click Post - in fact, don't do anything! Turnpike will save 
it automatically when you close the program and it will be there ready to work on again when you next 
start the program.

You can minimize unsent emails to icons so they don't clutter your desktop.

Second thoughts!
If you have second thoughts after posting, open the Out Tray by double-clicking it. Messages waiting to 
be sent are shown by a clock symbol (click here to see a picture). If it is still there, you could:

either double-click the email - Turnpike will then let you Inspect, Edit or Abandon it.

or drag the email onto the Turnpike desktop, where it will remain unsent for as long as you want - 
even after you shut down Turnpike. You may want to minimize it to an icon so that it doesn't get in the 
way.

Where are the emails I have sent?
Copies of all the messages you write are automatically stored in the Mailroom, along with emails 
that you receive and decide to file. You can view them by double clicking the Mailroom View icon 
on the Turnpike desktop. Click here to see a picture.

We shall look at ways in which Turnpike can streamline email filing later in the tutorial.

How can I test if my email is working?
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The signature is a short message that is added automatically to the foot of your email. You can type in 
this area to make a temporary change if you wish, but it is best to keep the text to no more than four lines 
and to leave the 'sig separator' as

(hyphen, hyphen, space) on a separate line of its own. This is a special code which enables your 
signature to be removed automatically if someone quotes your message in a reply. Turnpike lets you set 
up a range of signatures and to link different signatures to particular mail boxes and newsstands. We will 
see how to do this in the Customising your mailbox section of the tutorial.



Here you set the words you would like for the introductory text that Turnpike automatically adds to 
introduce quotations you make and messages you forward.



The Status bar shows which user owns the message (useful if you configure Turnpike for more than one 
user), and the adjacent button enables access to the email to be made private, public or restricted to 
certain users.

The Tags button enables you to add your own labels to emails to assist with filing. Here, the tag Gossip 
to delete after March will make it easy to call up a list of all email with this tag for instant deletion when 
copies are no longer required. We shall explore the use of Tags later in the tutorial.



You can send yourself an email by putting your own address in the To: box. When you click Post it will go 
to the Out Tray where mail stays for about a minute (in case you change your mind) after which it will be 
delivered to your mailbox.

There is no need to be connected to the Internet to do this: Turnpike recognises from the address that it is
local email.

You could also try emailing an 'auto-responder' - a computer on the Net that looks for a particular text in 
an email and then sends an automatic reply. For example, you could send an email to

support@demon.net

Enter the word help as the subject, and don't type anything in the body of the message. When you click 
Post, Turnpike will warn you that the message appears to consist only of a signature - that's what you 
want, so click OK and then connect to the Internet to send your message. The next time you connect you 
should get an email back listing useful documents that can be automatically mailed to you in a similar 
way.





    

You can change the email name used by a mailbox on the User
info page. However, only names that have already been added 
to Turnpike can be chosen here. If you haven't yet done this, 
go to the File menu, choose Configure... Email names and then
Create a new name. This name will then be available for 
selection on the User info page above. If the mailbox is not 
your default (i.e. original) mailbox, you should also go to the 
Rules page and add a rule to accept all mail for this new name.

We will take a look at adding mailboxes, email names and 
users later in the tutorial.



If you create a new tag, the mail list you 
produce will obviously be empty at first. 
However, you can then easily drag existing 
messages into this list so that they get the 
new tag applied to them automatically.



The major newsgroup hierarchies include:

comp discussion of computer hardware and software
news groups dealing with the news network itself and news software
rec recreation, hobbies, arts and sport
sci science
soc social issues
talk debate on controversial subjects
misc miscellaneous subjects that don't fit in above

These hierarchies (together with the humanities groups) comprise Usenet proper. One other 
major hierarchy is alt (alternative - the home of the weird and wonderful).

There are also regional hierarchies, identified by a country code: uk.comp.os.win95 is, for 
example, a newsgroup in the United Kingdom hierarchy, for the purpose of discussing all 
aspects of the computer operating system, Windows 95. Discussion in foreign groups is likely 
to be in the language of the country concerned.

A number of Internet access providers also maintain hierarchies. The demon hierarchy, for 
example, encompasses some 50 newsgroups - mostly for technical discussion about 
connecting to the Internet and related matters.



When you first use Turnpike to connect to your Internet access provider, the Connect program will 
download the current list of newsgroups available from your provider. Since there may well be tens of 
thousands of names in the list, this is likely to take at least several minutes.

The Newsstand Wizard
In order to read and participate in newsgroup discussions, you must have a newsstand. To set one up, go 
to Turnpike's File menu and select New... Newsstand. The wizard will ask which newsgroups you wish to
place in the newsstand - you can choose from those you have already Subscribed to, or from the full list 
of All groups available.

To search for a particular word in a newsgroup name, use * as a wildcard. For example, to find all newsgroup 
names containing the word music enter *music in the Find slot.

The Wizard will ask for details of the email name, real name and signature you want to use if you decide 
to post articles from this newsstand, and also for a name to identify the newsstand. You can set up 
multiple newsstands, if you wish, perhaps devoting each one to a set of newsgroups that matches a 
particular hobby or interest.

You can set colours and fonts for the newsstand, and change other settings, in the same way as altering a 
mailbox - just right-click the newsstand icon and then select Properties.

After you have subscribed to a newsgroup, each time you connect to the Internet Turnpike will download 
the latest articles for that group. Initially this will be all articles posted in the last three days. After that, 
Turnpike will in future try to collect all new articles since you last logged on. You can change these default
times by going to the File menu, selecting Configure... Newsgroups, and then altering the last 
NewNews date.
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Email (electronic mail) is a means of corresponding with people over computer networks, and particularly 
with those who have a connection to the Internet.

With email you can ...
prepare any number of messages off line in Turnpike and then send them when you next Connect to 
the Internet
contact people around the world from your computer for the price of a local phone call, avoiding the 
delays of engaged numbers and of people unavailable to come to the phone
include pictures, sounds and even computer programs as attachments to your messages.
participate in email discussions (mailing lists) with people across the globe
have all your incoming and outgoing messages automatically filed and indexed ready for instant 

retrieval

Although email is usually delivered within minutes, be aware that delays can occur.

How does it work?
When you log on to the Internet, Turnpike checks to see if you have any messages ready to be sent. If so,
they will be transferred to a computer at your Internet Service Provider called a Mail Server. From there, 
the email is relayed across the Net from one mail server to another until it reaches its destination and is 
ready to be collected and read by its recipient.

The route it takes will be determined by the email address you send the message to, and the information
that machines on the Net have about how best to reach that address. Using the correct email address is 
therefore essential for the safe delivery of your message. To help you do this, Turnpike provides an 
electronic address book.

You can choose whether or not the address book should be updated automatically
each time you receive an email from a new person.                  How do I do this?
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If you click this button Turnpike will set up a new message for 
you to send, complete with your personal details (email 
address etc.) and your current signature already in place. You 
just need to type your message, fill in the Subject and the email
address of the person to whom you want to send the message 
(eg. from your Address book) - then click the Post button to 
send the message.



Sending and receiving files by email
Email is basically for simple text messages that use alphabetic characters, numbers and a few related 
symbols. If you want to send someone a file (such as a picture, word-processor document or program) it 
has to be encoded into a text-like format called an attachment in order to travel over the Net. This is done 
by clicking the Insert File button on the toolbar above the message editor, and then selecting the file you 
wish to send - or you can simply drag the file into your message. The attachment is represented by a 
horizontal bar containing details of the file. If the file is a text file the bar will include a Merge into text 
button. This is useful to avoid encoding files unnecessarily.

There are several (incompatible) schemes for encoding these attachments. The best solution is to use 
MIME. Turnpike can recognise if you are replying to someone who uses MIME-compatible software and 
will then automatically check the Send MIME message box for you. If this is not checked, the attachment 
will, when posted, be encoded by an older method known as UUencode. However, this also requires the 
recipient to be have appropriate software for decoding the file upon receipt. Such a decoder may be built 
into their mailer (as it is with Turnpike) or it may involve them saving the attachment to disk and then 
running it through a separate decoding program before being able to use the data you send.

The encoding process will increase the size of the file being sent. If the message is larger than 60K 
Turnpike will suggest that it should be split into parts. This is because some mail gateways (e.g. to a 
company's private network) will not pass large items. However, you can ignore Turnpike's suggestion on 
this matter if you know from experience that it is not necessary. Be aware that the process of splitting the 
message into parts can itself cause problems, as not all email software can smoothly handle the 
reassembly of parts into a single message in the way that Turnpike can. Before sending a large 
attachment discuss these points with your recipient. Unexpected large emails can be unwelcome and 
some Access providers limit the size of messages that can be received, so the email may not arrive at its 
destination anyway.

Finally, remember that your recipient will probably need to have the right software (e.g. a picture viewer, 
word processor, media player, etc.) in order to use the file you send.
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URL

A URL (Uniform Resource Locator) (pronounced "you-are-EL" or, in some quarters, "earl") is 
the address of a file or other resource accessible on the Internet. The type of file or resource 
depends on the Internet application protocol. Using the World Wide Web's protocol, the 
Hypertext Transfer Protocol (HTTP) , the file can be an HTML page (like the one you're 
reading), an image file, a program such as a CGI application or Java applet, or any other file 
supported by HTTP. The URL or resource address includes the name of the protocol required 
to access the file or resource, a domain name and, if it's a file, a hierarchical description of a 
file location on the server. 

On the Web (which uses the Hypertext Transfer Protocol), an example of a URL is: 

              http://www.mhrcc.org/kingston

which happens to be the URL for the community home page for Kingston, New York. 

An HTTP URL can be for any Web page, not just a home page, or any individual file. For 
example, this URL would bring you the whatis.com logo image: 
            http://whatis.com/whatisAnim2.gif

A URL for a program such as a forms-handling CGI script written in Perl might look like this: 
            http://whatis.com/cgi-bin/comments.pl

A URL for a file meant to be downloaded would require that the "ftp" protocol be specified 
like this one: 
          ftp://www.somecompany.com/whitepapers/widgets.ps

Related Topics 
Browsing URLs



Unregistered Evaluation Version dialog

This dialog automatically appears whenever an Evaluation copy of Turnpike is run to advise when this 
time-limited copy of Turnpike will 'expire'.

(Separate dates are given for the main Turnpike program and the Connect program because the main 
Turnpike program continues to run for a few more days to give someone who doesn't wish to continue 
using Turnpike the opportunity to export any mail they've sent or received using Turnpike in a format that 
can be read by other Mail readers.)

The box at the bottom of the dialog is to tick when you have ordered a full copy of Turnpike.

If the full copy hasn't arrived by the time this Evaluation version has expired, ring Technical Support on 
0181-371 1010 and ask for a 'Key' with which to extend the life of the Evaluation version.



Updating the list of newsgroups
New newsgroups appear and old newsgroups disappear almost daily so whenever Turnpike picks up 
articles it also picks up a list of amendments to make to the list of newsgroups it offers. Alternatively, you 
can ask Turnpike to pick up a complete new list through the Configure Usenet News dialog in Turnpike 
Connect. This is particularly useful if you change the News server you use (eg. because you change 
Access provider) because not all News servers carry the same range of newsgroups.

For details of the steps to use, see 'Picking up a fresh newsgroup list' in the Connect book.



Upgrading to the latest version
If you have purchased a full copy of Turnpike you can upgrade to the latest version by downloading the 
appropriate file from:

ftp://ftp.demon.co.uk/pub/mirrors/turnpike/

View the !readme in this directory to see which file you need to fetch. In general, the latest version is 
identified as

nnissuex.exe

where nn is 16 (for Win3x and NT3.51) or 32 (for Win95 and NT4.0). An x indicates that the file that does 
not include a WWW browser.

These files can only be used to upgrade a full copy of Turnpike. They cannot be used to upgrade
an Evaluation copy.

After you have downloaded the file, simply run it to install the upgrade - the installer will guide you through
the rest of the process. All your mailboxes, newsstands and other special settings that you have built up 
using the earlier version of the program will be automatically transferred to the new version.

If you want to check which version of Turnpike you are currently using, take the 'About Turnpike' option 
from the Help menu.

Related Topics. 
Backing up your Turnpike files.
Moving Turnpike to another machine or System.
Moving the Mail and News Directories



'Usage of email name' dialog

This dialog is displayed by clicking the Create or the Edit button within the Email names dialog. and is 
used to define a name you want to use as an additional email name 

On a shared (multi-user) system, it is also used to specify which other users and/or workgroups can use 
this name.

· The Name slot - enter what the Email name you are defining

· The Currently allow list - records the users and workgroups who are allowed to use this 
email name

The 'Currently allow' list is set up by using the Add and Del buttons between the two lists. This takes 
names from the left-hand list, to lists of users or and lists of workgroups.    Click the Individuals and 
Workgroups buttons to define the list you want.

Related Topics
Email Names dialog



Useful newsgroups for new users
Your copy of Turnpike may be set up to automatically subscribe to a few newsgroups which are either 
useful to users of your particular Access provider or useful for new users to study - for example, a 
newsgroup like news.announce.newusers that typically contains a number of articles answering 
frequently asked questions (FAQs).

If you don't want to follow these, simply remove them both from the newsstand and (if you have News 
Admin permission) from the overall list of newsgroup subscriptions in the Newsgroup Subscriptions 
dialog.



User Information

The way you appear to the recipient of one of your messages is set by such things as the signature you 
use, the email name you quote in your address, the email address to which replies should be sent and the
organization you are seen to represent.

As you will probably want to present yourself differently in different types of message, Turnpike enables 
you to record for each mailbox and each    newsstand the details of the signature, email name etc. that 
you want given in the messages / articles that you post.

To set this User Information, select the mailbox / newsstand, then 

select either Alter mailbox or Alter newsstand from the File menu
or click the right mouse button on the mailbox / newsstand and select Properties.

Enter the details you require on the User Info page of the Alter mailbox dialog that is displayed.

Any special email name or signature that you want to use must already be recorded for your system. 
You can't set up new names / signatures from within the Mailbox /Newsstand dialog.

Related Topics 
Alter Mailbox dialog
Attribution
Signature 



Using Turnpike Help

· There are several ways you are able to get help in Turnpike
· For help on the current display press the F1 key.
· Use a browse sequence to learn about a subject as a whole.
· To get help on part of a display for example a dialog entry press Shift F1 to display a question 

mark and then click on the part of the screen you want information on 
· Click on any item displayed green and underlined - see Jumps and Popups below..
· Click Help in the menu.to display a submenu for Index, Using Help, Show Hints & Tips and    

About Turnpike    
· Read the Tutorial

· Help Topics : Turnpike Help 
When you select Help and then Using Help the Help Topics window opens with the following three 
pages.

· Contents. A list of topics similar the Table of Contents in a book. Subjects are listed as books and
topics. Click on a book icon to show the next level of information, this may be a further book or a 
topic. Click on a question mark icon to open the help text for a topic. 

· Index. Lists key phrases in alphabetical order. Either enter an item to search for or select an item.
Double-click on the selected item or click the display button to display the help text. If a sublist is 
displayed, repeat the process by double-clicking on an item to display the required help page.     

· Find. From this tab you are able to perform a full text search of the help files for any word or 
phrase.    

· Jumps and Pop ups
You will see that some words in the help text are underlined green. When you click on a fully 
underlined word you will jump to that topic page replacing you current window. Click Back in the 
menu to return to previous help pages.    When you click on a dotted underlined word a ‘pop up’ help 
box will open over your current window. Pop ups are often used for definitions of terms. Click 
anywhere to close the pop up box.

· To return to a Help page.
· Click on a forward or back browse button on the toolbar
· Click on Options in the help menu and select History. Double-click on any item in the list 

displayed

From any help page click Contents or Index to disply the Help Topics window.

  You are able to move, resize, close a help window as for any other window. 

· Dialog Boxes
For help on the current display, click F1 to display the help text. Alternatively, if the dialog box has a 
help button, click this to display the help text.

For detailed help on options or data requirements in some dialog boxes, hold down the shift key and 



press F1; a question mark will appear adjacent to the mouse pointer.    Move the pointer to the 
position on the dialog for which you require further help and click the mouse button.      

To show what version of Turnpike you are using, select click Help and select the About Turnpike option 

Related Topics
Browse Sequences



Using the filing system

All the messages you write, along with all the incoming email you decide to file, are stored in the Mailroom 
and can be accessed by clicking the Mailroom View icon on the Turnpike desktop.

The Mailroom window has buttons to sort messages in the order they Arrived or were Sent, and to view 
Incoming, Outgoing or All messages. There is also a Search menu for finding a particular author, 
subject or text within a message.

Turnpike also includes a number of other tools to automate the handling of stored messages. For 
example, to see a list of the messages you have exchanged with someone, select the person's entry in 
your Address Book, and then click the Messages button on the toolbar. This produces a Mail List, looking 
just like the normal Mailroom view, but restricted to messages exchanged with the selected person.

When you close a Mail List of this type it minimizes to a green folder icon, ready for future use. If you don't need 
it again, right-click the icon and choose Shut (or click the Shut button at the bottom right of the Mail List itself).

The mail list wizard
Mail lists can also be produced by going to the File menu and selecting New... Mail list. The wizard will 
then offer three types of list. One is a list of correspondence with a particular person, as described above. 
Another is a mailroom view - just like your main mailroom view, but one which you could set up differently 
(e.g. to show just outgoing mail). The other possibility is a Mail list based on Tags. If you choose this 
option, you will be asked to select the tag(s) on which the list is to be based. For example, you might 
produce a list of just those messages that are tagged with both Holiday and Expenses. You can also 
create a mail list for a new tag.

Mail lists based on tags minimize to a green folder icon when closed.

You can also export messages if you wish to keep a separate archive in a plain text format.
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Waste basket

Any messages that you delete or abandon are put into the Waste basket on your Turnpike desktop. The 
icon changes to the version shown here, to indicate that there's something in it.

The messages themselves aren't actually deleted until you leave Turnpike - or until you open the Waste 
Basket and click the Empty button that's shown. 

If the mail you've deleted is mirrored from a POP3 mailbox, messages are generally only deleted the next 
time mail is collected from this mailbox. You will, get the option of deleting these messages from Turnpike 
to let you get rid of messages mirrored from POP mailboxes you aare no longer using.

Up to the point the messages are actually deleted, any message you throw away by mistake can be 
recovered by opening the Waste basket and dragging the message to either a mailbox, the Mailroom view
or some other mail list.

To empty the Waste basket right-click on it and then choose Empty.



Welcome to the main Turnpike program

· The Turnpike software is in two parts:
· The main Turnpike program which provides off-line processing of email messages and Usenet 

news.
· Turnpike Connect which is used to go on-line to the Internet to send and receive mail and news, 

and to use the World Wide Web, FTP and Telnet.

You are currently using the main Turnpike program. Its main screen provides a desktop 
on which can be displayed:
· One or more Mailboxes for mail messages you've received
· One or more Newsstands, showing Usenet newsgroups you've subscribed to
· An address book, containing the email addresses you use
· Lists of messages sent and received, including the Mailroom view of all the mail in 

your mailbase, plus an Out tray and a Waste basket.
You are able to open each item as a window or minimise it as an icon.

· Using Turnpike you are able to:
· Inspect your Mailboxes to see what mail you've received
· Prepare email messages to send
· Call up lists of email messages that have been exchanged either with a particular 

person or on a particular topic
· Follow discussions in the newsgroups you subscribe to
· Prepare your own contributions to these newsgroups
· Inspect and update your address book.

You are also able to configure your system. This includes setting up and modifying additional
mailboxes, setting up (and modifying newsstands; and extending the range of email names 

For information on any of the above topics, simply click on the topic you are interested in.

        If you are new to Turnpike read the Tutorial

· Browse Sequences    
As far as possible subjects have been arranged in topic sequences. These are shown as a book icon in 
the Help Contents tab. If you are new to a subject go to any topic in a sequence and the use the browse 
buttons to read each subsequent topic in turn. You may find it useful to print the complete sequence to 
study at your leisure

Some topics such as general definitions are in a General sequence (not shown in the Contents help 
page), these topics follow in alphabetical order.

Related Topics
Using Turnpike     Help  



When someone leaves

When a user has left you may want to retain access to that persons mail files. If this is 
required the System Administrator should either,

· Change the password so that access is only available to the Administrator OR 
· Allocate mail addressed to the user who has left to another user.

Related Topics.
Allocating another user to a seat



Window menu

Cascade
Tile horizontal
Tile vertical
Arrange icons
Line up icons

Minimize all

List of windows



    
Window menu: Arrange icons
Arranges the icons used for any minimised 
Turnpike windows neatly along the bottom 
of the display.



    
Window menu: Cascade
Arranges the open Turnpike windows in a 
cascade one on top of the other, starting 
from the top left-hand corner of the main 
Turnpike screen area.



Window menu: Line up icons
Aligns the icons used for any minimised Turnpike 
Windows to a grid defined by your Windows 
System's Icon spacing. Refer to your Windows 
documentation for information on setting this Icon 
spacing.



Window menu: List of windows
Lets you select and display the different 
Turnpike windows currently either open on 
the screen or shown minimised.



Window menu: Minimize 
All

Minimises all the windows currently 
open on your Turnpike display.



    
Window menu: Tile horizontal
Arranges the open Turnpike windows one above 
the next down the Turnpike screen area.

See also: Tile vertical and Cascade



    
Window menu: Tile 

vertical
Arranges the open Turnpike windows
side-by-side across the Turnpike 
screen area.



Windows error

Consult your Windows documentation.



Workgroups
A workgroup is a group of users on a shared system. Workgroups are the Turnpike equivalent
of an office or a department within a company. Examples of workgroups may be Sales 
enquiries or Customer Support enquiries.

By putting users together into a workgroup, you can arrange that:

· Members of the group have permission to carry out specified particular administrative 
actions - see Setting Workgroup permissions.

· Any mail addressed to a workgroup, can be read, filed and replied to by any member of 
that Workgroup. When mail arrives it appears in the In-tray of every member of the 
group. The moment any member reads it, it then becomes theirs to deal with and 
disappears from other members In-trays.

· Any member of a workgroup can see mail on particular topics - by tagging it with one of 
their group topic tags

Related Topics. 
Setting up workgroups.



Removing Users

 Before removing a user from Turnpike their mailboxes should be cleared. 

You are only able to remove users if you have Administrator permission 

· Delete or file the Ex-Users Mail
1. Click File in the Turnpike menu.
2. Select the Configure option
3. Now select Users. The   Configure user sign on names   dialog appears.
4. Select the ex-users name.
5. Click the Edit button. The Edit sign-on details     dialog appears for selected user.
6. Enter a new password.
7. Log on as the ex-user and file or delete any mail in their mailboxes.

· Remove the Ex-User
8. Log on again as Administrator
9. Click File in the Turnpike menu

10. Select the Configure option
11. Now select Users. The Configure user sign on names dialog appears.
12. Select the ex-users name
13. Click the Remove button

· Rebuild the mailbase
14. Rebuild the mailbase files. 
15. This will remove their personal tags and re-assign any personal mail to the occupier 

of Seat #1 (generally the System Administrator).
16. Go into the USERxxx directory corresponding to the ex-users seat.
17. Clear or save any files.
18. Delete the directory.

It’s not possible to remove either Seat #1 or the seat you are currently sitting at. 

Related Topics
Remove users from a shared system
Adding new users
Edit details of a current user
Enable the Edit sign-on details dialog
The Edit sign-on details dialog




